Universal Circuit Layout Editor

For Apple® Macintosh™ computers
Runs also on PC-compatible computers

User’s Manual

Release 1.8

A product of Relative Software, Inc.
and Warsaw University of Technology
1.1. What is Uncle? 9
1.2. Hardware and software necessary for running Uncle 10
1.3. Setting up Uncle 10
1.3.1. Caveats 11
2. First Session 13
3. Basic Concepts of Uncle 27
3.1. Hierarchical editing of VLSI layouts 27
3.2. Quasi-symbolic representation of IC masks in Uncle 27
3.2.1. Uncle layers and technological masks 27
3.2.2. Substrate 28
3.3. Painting paradigm for layout artwork editing 29
3.4. Modes of operation in Uncle 29
3.4.1. Help Mode 30
4. Cell Edit Mode Reference 31
4.1. Starting up Uncle in Cell Edit Mode 31
4.1.1. Manipulating technologies in Cell Edit Mode 31
4.2. Creating, opening and saving cells 33
4.2.1. Creating new cell 33
4.2.2. Opening existing cell 33
4.2.3. Saving cells 34
4.3. Windows used for editing cells 35
4.4. Pointer 36
4.5. Selector 36
4.5.1. Selector positioning with the mouse 36
4.5.2. Selector positioning with the keyboard 37
4.5.3. Selector positioning with the Set Selector... command 38
4.5.4. Finding the Selector position and dimensions 38
4.6. Artwork Palette 38
4.6.1. Paint Palette 39
4.6.1.1. Operation of the Paint Palette in the Selector Paint Mode 39
4.6.1.2. Operation of the Paint Palette in the Immediate Paint Mode 40
4.6.1.3. Operation of the Paint Palette in the Paint Visibility Mode 41
4.6.2. Subcell Operations Palette 42
4.6.2.1. Inserting and removing subcells 42
4.6.2.2. Subcell appearance in the layout window 43
4.6.2.3. Selecting a subcell 44
4.6.2.4. Applying transformations to subcells 45
4.6.2.4.1. Modal transformations 45
4.6.2.4.2. Double-click Transformations 46
4.6.2.4.3. Moving subcells by using arrow keys on the keyboard 47
4.6.2.4.4. General subcell transformation 47
4.6.2.5. Locking and unlocking subcells 47
4.6.2.6. Expanding and unexpanding subcells 48
4.6.2.7. Peeking at subcells 48
4.6.2.8. Operations on Arrays 49
4.6.2.9. Grouping and ungrouping subcells 49
4.6.2.10. Microscope mode 50
4.6.3. Device Palette 50
4.7. Labels 52
4.7.1. Entering labels 52
4.7.2. Selecting labels 53
4.7.3. Manipulating labels 54
4.7.3.1. Deleting labels 54
4.7.3.2. Moving labels 54
4.7.3.3. Editing labels 54
4.8. Types of objects and their selection revisited
6
4.8.1. Selection of artwork
55
4.8.2. Selection of subcells
56
4.8.3. Selection of labels
56
4.8.4. Selection of the entire cell contents
56
4.9. View/Mode Palette
56
4.10. View management in Uncle
57
4.10.1. Scrolling
58
4.10.2. Usage of modifier keys for accelerated scrolling
58
4.10.3. Fast switching between cell views
59
4.10.4. Other nonstandard features
59
4.11. Printing
59
4.11.1. Setting printout scale
60
60
4.12.1. Apple menu
60
  About Uncle™…
  Help…
  Technology Edit
  Cell Edit
4.12.2. File menu
61
  New… (keyboard equivalent ‘zN’)
  Open… (keyboard equivalent ‘zO’)
  Close
  Close all
  Import Magic…
  Compact Data
  Save (keyboard equivalent ‘zS’)
  Save A Copy As…
  Save All
  Save In Another Tech…
  Save As Flat Cell…
  Save DRC Report
  Page Setup…
  Page Scale…
  Print… (keyboard equivalent ‘zP’)
  Current tech
  Default tech
  Preferences
  Quit (keyboard equivalent ‘zQ’)
4.12.3. Edit menu
64
  Undo (keyboard equivalent ‘zZ’)
  Redo (keyboard equivalent ‘zR’)
  Cut (keyboard equivalent ‘zX’)
  Copy (keyboard equivalent ‘zC’)
  Paste (keyboard equivalent ‘zV’)
  Clear
  Add subcell… (keyboard equivalent ‘zU’)
  Duplicate (keyboard equivalent ‘zD’)
  Array… (keyboard equivalent ‘zY’)
  Select Node
  Select Subcells
  Select More Subcells
  Select All Subcells
  Select All (keyboard equivalent ‘zA’)
  Get Info… (keyboard equivalent ‘zI’)
4.12.4......................... View menu
Show Rulers/Hide Rulers 66
Show Grid/Hide Grid 67
Show Size/Hide Size 67
Find Selector 67
Zoom Selector–>Window 67
Zoom In 67
Zoom Out 67
Fit In Window (keyboard equivalent ‘⌘F’) 67
Set View 68
Set Selector… 68
Expand 68
Expand One Level 68
Expand All 68
Peek 68

4.12.5......................... Operations menu
Rotate Left 69
Rotate Right 69
Rotate 180° 69
Flip Horizontally 70
Flip Vertically 70
Move… 70
Align 70
Make Row 70
Group 71
Ungroup 71
Lock 71
Unlock 71

4.12.6......................... Artwork menu
Paint 71
Erase 72
Repaint… 72
Extend 72
Extend Right 72
Extend 72
Extend 72
Extend 73
Show 73
Hide 73
Show/Hide… 73
Show All Layers 73
Show Labels/Hide Labels 73
Add Label… (keyboard equivalent ‘⌘L’) 73
Delete Label 73
Edit Label… 73

4.12.7......................... DRC menu
Verify Selector 74
Verify Cell 74
Verify Recent Changes 74
Find Errors 74
Scan Errors (keyboard equivalent ‘⌘=’) 75
Show Errors/Hide Errors 75
Count Errors 76
Continuous Checking 76
Verify Hierarchically 76
Explain Error (keyboard equivalent: ‘⌘E’) 76
Verify Cell Placement
Show Cell Overlaps/Hide Cell Overlaps

4.12.8......................... Cells menu

4.13.......................... Setting Uncle preferences

4.13.1......................... Customizing cell views

4.13.2......................... Using Clipboard in Uncle

4.13.3......................... Option settings for Clipboard conversion

Picture form

A bitmap or a drawing?
Bitmap scaling
Important hint
Choosing the layout scale

4.13.4......................... Enabling operation in background

4.13.5......................... Setting the DRC options

4.13.6......................... Customizing CIF format

5................................. Technology Edit Mode

5.1............................. Starting up

5.2............................. Creating, opening and saving technologies

5.2.1........................... Creating new technologies

5.2.2........................... Opening existing technologies

5.2.3........................... Saving technologies

5.2.4........................... Manipulating technologies in Technology Edit Mode

5.3............................. Windows used for editing technologies

5.3.1........................... Technology Window

5.3.2........................... Layer Window

Solid
Stipple
Solid+stipple
Dithered

5.3.2.1................... Design rules associated with a layer

Layer equivalence
Spacing/width inheritance
Spacing
Spacing/width inheritance

5.3.3........................... Plane Window

5.3.3.1................... Painting

5.3.3.2................... Items for entering interaction tables

Layer equivalence in overhang rules

5.3.4........................... Device Window

5.3.5........................... Mask Window

5.3.5.1................... Tips on defining masks

5.3.6........................... Format Window

5.4............................. Using menus in Technology Edit Mode

5.4.1........................... Apple menu

5.4.2........................... File menu

New... (keyboard equivalent '⌘N')
Open... (keyboard equivalent '⌘O')
Close
Close all
Save (keyboard equivalent '⌘S')
Save As...
Save In ASCII...
Make Default
Page Setup...
Print... (keyboard equivalent '⌘P')
Preferences...
Quit (keyboard equivalent ‘⌘Q’) 102
5.4.3 Edit menu
Undo (keyboard equivalent ‘⌘Z’) 102
Cut (keyboard equivalent ‘⌘X’) 102
Copy (keyboard equivalent ‘⌘C’) 102
Paste (keyboard equivalent ‘⌘V’) 103
Clear 103
Info... (keyboard equivalent ‘⌘I’) 103
Debug Technology 103
5.4.4 Tech menu 103
5.4.5 Layer menu 103
5.4.6 Plane menu 103
5.4.7 Mask menu 103
5.4.8 Format menu 103
5.4.9 Device menu 104
Appendix A: Known bugs and problems 105
What happens if a bug occurs 105
What happens if Uncle runs out of memory 106
Hints 106
Appendix B: Uncle on a PC 109
Index 111
1. Preface

This manual is an introduction to the integrated circuit layout editor called Uncle. It is intended for users who are familiar with the basic operation of Macintosh computers. Before reading this manual, you should be acquainted with the following keywords, concepts, and topics related to Macintosh: pointer (also called cursor), mouse, moving the pointer on the Macintosh screen, clicking, double-clicking, dragging, selecting, pull-down menu, menu bar, startup disk, Finder, folders, files, desktop, starting up applications, windows, icons, scroll bars, dialog boxes, alerts, Clipboard, copying, cutting, pasting, Command key, Option key, and Desk Accessories, in particular Control Panels. If some of these concepts appear new to you, please consult the Macintosh manual.

In addition, this manual assumes familiarity with the basics of VLSI design, in particular with masks that are used in NMOS and CMOS technologies, and with the hierarchical methodology for VLSI circuit design. A working knowledge of technological processes used in IC manufacturing is necessary for creating new technology descriptions for Uncle.

The remainder of the manual is organized in four chapters. First Session guides you through the basics of Uncle operation while you design a three-stage CMOS oscillator. Basic Concepts of Uncle presents the basic principles of Uncle implementation as a layout editor. The remaining two chapters are reference manuals concerned with the two basic modes of Uncle: Cell Edit Mode and Technology Edit Mode.

The operation of Uncle is fairly complex. It is suggested that you proceed as follows:
- Read the rest of the Preface. It tells you how to set up Uncle.
- Start up Uncle on your Macintosh and perform the activities described in the First Session chapter. This should give you the basic grasp of Uncle operation.
- Read the Basic Concepts of Uncle chapter.
- Read the backbone part of the Cell Edit Mode Reference, consisting of the paragraphs marked with a bar in the margin. It is possible to design any layout using only the operations covered in those paragraphs.
- Try using Uncle to do some simple layouts until you feel comfortable with the basic activities.
- Read the remainder of the Cell Edit Mode Reference. It will show you elaborations and variations of the operations you already know.

At this point, you should be able to design your integrated circuits right away.

If you want to design a circuit in some technology that is not supplied with Uncle, or if you want to change the user interface of some of the supplied technologies, you will have to acquaint yourself with technology editing. In this case, it is suggested that you proceed as follows:
- Read the Technology Edit Mode Reference.
- Run Uncle in the Technology Edit Mode and inspect the technologies supplied with Uncle.
- Try to edit your own technologies.

For more hints in developing skills in technology editing, see the Technology Edit Mode Reference.

The following conventions are used throughout this manual:
- Names of files and folders are always printed in Helvetica font.
- Names of items in menus and dialogs are printed in Chicago font, just as they appear on the Macintosh screen.

1.1 What is Uncle?

Uncle is a specialized graphic editor that can be used to edit layouts of integrated circuits. Some of its features are:
- Hierarchical circuit editing in multiple windows.
- Quasi-symbolic data input.
- Operations invoked in Macintosh style from palettes and menus.
• Fast device input via user-defined macros.
• Continuous, incremental design rule checking.
• Undo and Redo operations with unlimited depth.
• Export of artwork into text-processing programs via the Macintosh Cut and Paste operations.
• User-friendly technology and design rule editing.
• On-line help facilities.
• Several output formats that can be read by many design analysis programs running on various mainframes and workstations.

These features are discussed in detail later.

Uncle version 1.8, described here, supports manual hierarchical design of integrated circuit topologies. It provides the means for editing mask features, for grouping mask features into cells, and for management of cells. Uncle can produce descriptions of IC masks in Caltech Intermediate Format (CIF) and in GDSII (Calma) format which are accepted by many software tools for design analysis and verification. Most operations in Uncle are intuitive, and the items shown on the screen should be self-explanatory; nevertheless, Uncle has on-line help facilities to aid the user in recalling the details of its operation.

Uncle 1.8 runs also on PC-compatible computers (see next Section and Appendix B for details).

1.2 Hardware and software necessary for running Uncle

Uncle 1.8 runs on almost all Macintoshes. On Power Macintoshes Uncle 1.8 runs in native PowerPC mode. It runs also on older Macintosh models such as Macintosh Plus, Macintosh SE, Classic, Classic II, Color Classic or any of the Macintosh II, LC, Quadra, Centris, Performa or PowerBook families. At least four megabytes of free memory are required, and eight or more megabytes of RAM are recommended for large designs. A hard disk is a must. Uncle 1.8 will not run on the oldest Macintosh models (i.e. Macintosh 128 or 512).

Uncle should be used with the latest release of the Macintosh System Software from Apple. At the time of writing of this manual, the most recent releases of System Software were MacOS 9.1 and Mac OS X (v. 10.0.3). Uncle 1.8 is not a native Mac OS X application, but runs correctly with Mac OS X in “Classic” environment. Uncle 1.8 runs also with earlier versions of MacOS: Mac OS 8.x, System 7.x, and System 6.0.3 or later. Uncle 1.8 will not run correctly with versions of System Software earlier than 6.0.3.

On Macintoshes equipped with color monitors, the fastest display is obtained when the monitor is set in the 256-colors mode. The 2-color black-and-white mode is the second fastest with respect to display speed. The 4-colors, 16-colors, and all gray-scale modes are slower. Uncle 1.8 will not run with more than 32768 colors (i.e. with number of colors set to millions” in the MacOS “Monitors” control panel).

Uncle 1.8 runs on Macintoshes as well as on PC-compatible computers with Executor® 2 installed. Executor® 2 is a Mac emulator for MS-DOS and MS-Windows - based computers. To run Uncle 1.8 on a PC, you will need a 486 or better CPU with at least 16MB of memory, a hard disk, a mouse and a color VGA monitor. Uncle 1.8 on a PC is functionally 100% compatible with Uncle on a Macintosh, including file formats. See Appendix B for details.

A native version of Uncle for Windows is in development. It is not distributed yet at the moment of writing this manual. However, a special file format that enables exchange of IC designs between MacOS and Windows versions of Uncle has been already implemented in Uncle 1.8.

1.3 Setting up Uncle

IMPORTANT: FIRST OF ALL, MAKE A BACKUP COPY OF THE Uncle™ DISK.

The master disk supplied with this manual should be stored safely, away from heat or magnetic field sources, so that it is possible to make another copy in case something happens to the working copy.
On the Uncle distribution disk you may find either Uncle Installer or two folders: the Uncle Folder and the Samples Folder. The Samples Folder contains several designed IC layouts. Installation procedure for Uncle is very simple. All you need to do is to copy the entire Uncle Folder to your hard disk. You can copy the Samples Folder as well, if you want to look at the ready-made layouts. If you received Uncle Installer, run the Installer application and follow the instructions on the screen. Uncle Installer will work also on a PC under Executor® 2.

The Uncle Folder contains the following files:

- the application itself.
- the file that contains all texts used by the on-line help facility.
- files with technology descriptions.

In addition to the kinds of files listed above, Uncle also uses and maintains a preference file named Uncle_prefs. This file is created automatically when you start up Uncle for the first time after installation. The preference file is placed either in the System Folder or in the special folder named Preferences in the System Folder, depending on the version of the Macintosh system software. The preference file is a place where your settings customizing operation of Uncle are stored. If you delete this file or change its name, Uncle will create another one. However, all your settings will be lost and default settings will be used instead.

If you install Uncle on a new Macintosh and you want to use the preference file from another Macintosh, look for the Preferences folder in the System Folder and copy your preference file to it. If there is no Preferences folder in the System Folder, copy your preference file to the System Folder. Do this before starting up Uncle for the first time. Uncle will recognize and use your preference file instead of making a new one.

Remark: To operate correctly, Uncle must have access to the preference file. If the preference file exists but cannot be used for any reason, e.g. if it is open by another application, Uncle will attempt to create another one named Uncle_prefs1 and will use it during the session. If the file named Uncle_prefs1 cannot be created, Uncle will try to create another one named Uncle_prefs2, etc. These files are temporary and will be removed automatically when Uncle quits.

1.3.1 Caveats

- Uncle 1.8 can be used from a file server. However, it is usually more convenient to have a copy of Uncle on a local disk and run it from this disk.
- It is advised not to use the gray-scale display mode when running Uncle. Uncle 1.8 does not work with more than 32768 (i.e. “thousands”) colors. If you start Uncle while the monitor is set to more than 32768 colors or if you change this setting to more than 32768 colors while Uncle is running, Uncle will display an alert message and you will be forced to quit and restart Uncle (your work will be saved).
- If Uncle is to be used on a Macintosh running system version earlier than System 7, e.g. system 6.0.3, and MultiFinder is not turned on, make sure that the minimum amount of free memory is not less than 4 MB. Attempts to start up Uncle under System 6 without MultiFinder may result in a system error if the amount of available memory is insufficient.
- If you run Uncle under System 7 or later and do not have enough RAM installed in your computer, you may turn the virtual memory on in the Memory control panel. Uncle runs correctly with the virtual memory turned on. However, you will notice that many operations are performed slower.
- Do not attempt to alter the Uncle program file in any way. Uncle is internally protected against viruses and will not run if its code or some resources are modified.
2. First Session

This chapter will lead you through an example design of a three-stage oscillator circuit in the CMOS technology. The variant of the n-well CMOS technology you will be using, called n-scmos, is based on a public domain MOSIS SCMOS design rules.

Remark: This manual was written assuming that you run your Macintosh in black-and-white mode. If you are using a color Macintosh, and want to have the appearance of your screen exactly correspond to the figures in this manual, use Control Panel to set up the monitor to black-and-white mode with the number of grays equal two.

- Start up Uncle by double-clicking its icon.
  A dialog box similar to the one shown here will appear:
- Click the OK button or type the RETURN or ENTER key.
  A menu bar will appear with only the and File menus active.
- Choose the New command from the File menu.
  This tells Uncle that you want to start editing a new cell. Cells are a sort of building blocks from which you will assemble layouts of integrated circuits. A dialog box will be displayed, asking you to enter the name of the new cell. You may want to open another folder or to click the Drive button in the dialog to make sure that the cell will be written to the appropriate folder on the appropriate disk.
- Type in ‘inverter’ and click the OK button.
  Uncle displays a Layout Window as shown here.  
  In the window’s title bar, Uncle displays the name of the cell, the number of bytes that is used to represent this cell in memory, and the name of the technology you are using.
  The rectangle drawn in dashed flickering lines is the Selector. It bounds the area that will be affected by layout operations.
  The set of pointer-sized symbols positioned in a row at the left of the horizontal scroll bar is the View/Mode Palette. It is used to change the way you view and interact with the layout.
  The rectangle with an icon at its top, abutting the upper left corner of the window, filled with pointer-sized symbols, is the Paint Palette. It is used to perform operations on the layout. Whenever the Paint Palette is visible, Uncle is in one of its Paint Modes. One of the Paint Modes is the Selector Paint Mode, signified by the highlighting of the item in the View/Mode Palette.
  A rectangle in the upper right corner of the window is the selector size box. It displays the coordinates of the pointer and the size and position of the Selector.
- Move the pointer about the screen. For now, do not click the mouse button.
  Observe that when the pointer moves over the white window area, its shape changes from the standard left upward arrow, , to a crosshair, . The white layout area inside the window is your drawing board, on which you will design the layout of your integrated circuit. The crosshair pointer shape indicates Uncle’s readiness to perform layout operations. Note that the movement of the crosshair pointer is jagged; the pointer
moves on a grid. This grid represents the smallest increments that you can use in drawing the layout features. One grid unit is called a lambda, or, for brevity, \( \lambda \).

Note that the position of the pointer displayed in the selector size box follows the movement of the pointer.

- **Position the pointer over the layout area.** Depress the mouse button and move the mouse while holding the button down. Release the mouse button.

  Note that when you depressed the button, the Selector has disappeared. Then, when you moved the mouse, the pointer has split into two parts. The small circle stayed at the clicked point, and the remaining cross, \( \bigoplus \), moved with the mouse. A gray rectangular outline was displayed. The gray rectangle followed the \( \bigoplus \) pointer as you moved the mouse. The size of the gray rectangle displayed in the selector size box followed the movement of the pointer. When you released the mouse button, the Selector assumed the shape and position of the gray rectangle.

  Remark: If you move the \( \bigoplus \) pointer outside the window, the window is scrolled in the opposite direction automatically. This feature is called auto-scrolling.

You have just repositioned the Selector with the mouse. This is one of the basic activities you will do in Uncle. By moving the mouse slowly, you can see the gray rectangle change its shape in 1 \( \lambda \) increments. With some practice, using the selector size box, you will be able to set the dimensions of the Selector quite easily. From time to time, however, you will probably find it useful to have other references for counting the grid units.

- **Choose the command** **Show Grid** **from the View menu.** Move the pointer in the layout area.

  After you chose the **Show Grid** command, the layout area has become filled with equally spaced dots. Note that the crosshair moves from one dot to another. These dots indicate the positions of the grid nodes. All corners of the layout features will coincide with the grid nodes.

- **Choose the command** **Show Rulers** **from the View menu.** Two rulers, a horizontal one and a vertical one, have appeared in the layout window. They indicate horizontal and vertical coordinates of the coordinate system.

  Remark: Just after opening a new layout window, the origin of the coordinate system coincides with the upper left corner of the window.

- **Position the pointer over one of the rulers.** Depress the mouse button and move the mouse while holding the button down. Release the mouse button.

  Note that when you depressed the mouse button and moved the mouse, a gray outline of the ruler followed the movement of the mouse. When you released the mouse button, the ruler assumed the position of the gray rectangle. In this way you can drag the rulers to any desired position in the layout window.

- **Position the pointer over the selector size box.** Depress the mouse button and move the mouse while holding the button down. Release the mouse button.

  In this way you can drag the selector size box to any desired position. Try dragging of the rulers and the selector size box to various positions and note how they overlap.

- **Choose the command** **Hide Rulers** **from the View menu.** The rulers disappear. In the same way you can hide the selector size box by choosing the command **Hide Size**.

  Remark: In this manual in most of the illustrations showing the layout window the rulers are hidden.

- **Hide the selector size box and type the \( \text{TAB} \) key.**

  A dialog box, similar to the one shown to the right, has appeared close to the upper right corner of the layout window. It shows you the position and dimensions of the Selector, and the coordinate the pointer was at when you typed \( \text{TAB} \). When the selector size box is hidden, you may want to use this dialog box for temporary display of the position of the pointer and the dimensions of the Selector. After 6 seconds the dialog disappears.

  *If the dialog box has disappeared, type \( \text{TAB} \) again. Press the Hold button in the dialog box (i.e., position the pointer over it and press the mouse button).*
The dialog will stay on the screen for as long as you keep the mouse button down, and then for 6 seconds more. You can click the **OK** button if you want to get rid of the dialog earlier. If you click the **Keep in window** button, the dialog will disappear and the standard selector size box will appear.

- Position the pointer over the layout area and click the mouse button without moving the mouse.
  The Selector has become a pulsating dot, or, if you are using a color Macintosh, disappeared. Whenever the Selector seems to have disappeared, there is a good chance that it was reduced to a point.
- Reposition the Selector so that it becomes a rectangle 6 λ wide and 6 λ high, placed somewhere near the upper left corner of the window.
- Position the pointer over the Paint Palette in the dot-filled square,  , three squares below the pencil symbol,  . Depress the mouse button and hold it down.
  The layout window should now look something like this:

  The square in which you have just pressed the mouse is one of the layer controls. Layers are used in Uncle to represent the layout features. The pattern in each layer control represents the layer associated with the control. The control in which you have just depressed the mouse button is associated with the diffusion layer. Uncle reminds you about the layer name by displaying it next to the clicked layer control for as long as you hold the mouse button down.
- Move the pointer out of and into the square in which you have depressed the button.
  Observe the appearance of the diffusion control. When the pointer is within the control, the control rectangle is fully filled with the diffusion pattern and appears like this:  . When the pointer moves out of the control, the pattern area shrinks to its normal state and looks like this:  . The highlighting you see when the pointer is within the control lets you know that a layout operation will be performed if the mouse button is released at this point.
- Move the pointer out of the diffusion control and release the button.
  Nothing should have happened in the layout window. Whenever you discover that you unintentionally pressed a layer control, you can always move the pointer away from the control and release the button without affecting the layout.
- Pull down the **DRC** menu and make sure that there is a check-mark, , next to the **Continuous Checking** item in the menu. If there is none, select this item and pull down the **DRC** menu again: the check-mark should be there. This check-mark means that Uncle will perform background design rule checks as you are drawing.
- Pull down the **DRC** menu again and make sure that the item just underneath **Scan Errors** reads **Hide Errors**. If the item in question reads **Show Errors**, select it and release the mouse button. Verify again: this time it should read **Hide Errors**. This means that any design rule violations will be specially marked in your layout.
- Click the pointer in the diffusion control directly below the pencil symbol,  .
  The area of the Selector has become filled with the diffusion pattern. The pencil symbol is the Paint Control. The layout window should now look like this:

  Remark: If you are using a color Macintosh in color mode, the area of the Selector has become filled with a solid green color.

  Observe that the number of bytes displayed in the menu bar has changed. The number of
bytes used by a cell is updated after every layout operation involving a change in layer shapes. You might have also noticed that the pointer has changed for a very brief moment into ⬤. This means that Uncle has verified the compliance of your layout with the design rules. If you did not notice the pointer change, watch it carefully for about two seconds after your next action.

• Click the diffusion control, ☐, placed underneath the eraser symbol, ☒.

The area of the Selector has become empty. The eraser symbol is the Erase Control. The pointer should have changed momentarily into ⬤, about one second after you released the mouse button.

You have just learned two basic operations that can be performed on layers: painting and erasing. The Selector area is painted with a layer when you click the layer control in the left column of the Paint Palette, under the pencil symbol. A layer is erased from the Selector area when you click a layer control in the right column of the Paint Palette, under the eraser symbol.

Remark: Note that the number of bytes used to represent the cell has not changed this time. This is because Uncle remembers all operations performed on the layout so that they can be undone at your will.

• Choose the Undo command from the Edit menu.

The diffusion rectangle appears again in the window. You have just undone the most recent operation, which was the erasure of diffusion.

• Choose the Undo command again.

The diffusion rectangle disappears again from the window. You have undone your first operation which was painting the diffusion.

• Press the mouse button while the pointer is in the header of the Edit menu.

Note that the Undo command is not active. You have backed up all the way to the beginning of your editing session.

• Choose the Redo command from the Edit menu.

The diffusion rectangle appears once more. You have redone your first operation.

• Position the pointer in the ⬤ layer control. Depress the mouse button, move the pointer out of the control and release the button. Repeat this for all controls in the Paint Palette directly below the eraser symbol.

Now you have learned the positions of all controls for palette layers, also called simple layers. The palette layers are those that you will use most frequently. In the n-scmos technology, they are N–well, diffusion, polysilicon, contact, metal1, metal2, via, and pad. While you were experimenting with the controls, nothing should have happened to the layout. If anything did happen, use Undo until only a 6x6 λ rectangle of diffusion is visible. If you overshoot and get to the state where Undo is not active, use Redo once.

• Click the left arrow, ⬤, in the horizontal scroll bar. Click the left arrow again and hold the mouse button down for a second or two, then release it.

After the first click, the layout will scroll a bit to the right. When you hold the mouse button down in the left–arrow of the scroll bar, the layout keeps moving in small increments to the right. The Selector moves with the layout.

Remark 1: You might have observed that the scrolling is done in 1 λ increments. Actually, the scrolling is done in increments of eight pixels. Incidentally, the default λ size after starting up Uncle is also eight pixels.

Remark 2: After you scroll your layout, the origin of the coordinate system may not coincide with the upper left corner of the layout window. Scrolling the layout does not move the layout itself. In other words, the coordinates of layout features do not depend on the positions of the scroll bars. To actually move your layout, use either Move command or Cut and Paste commands from the Edit menu; these commands are discussed in the Cell Edit Mode Reference.

As you can see, moving the window over the layout works as in most other Macintosh applications. By clicking the scroll arrows you can position the window precisely over the part of the layout you want to edit. For now, disregard the behavior of the scroll bar thumbs (⌘); it is explained in the View Management chapter.
• Position the Selector somewhat to the right of the diffusion rectangle. Click the control in the View/Mode Palette.

The window is scrolled so that the Selector is centered in the window. The control you have just clicked is the Center Control and can be used to find the Selector if it is lost.

• Hold down the OPTION key and click the control again.

This time the window is scrolled so that the diffusion rectangle is centered in the window. The OPTION key changes the action performed by Center Control from ‘center the Selector’ to ‘center the Cell’. Since, so far, the entire layout of the cell consists of the diffusion rectangle, this rectangle is centered in the window.

• Reposition the Selector so that it is a rectangle 2×10 \( \lambda \), placed symmetrically over the 6×6 diffusion rectangle in the layout area. Click the polysilicon control, just below the diffusion control in the left column of the Paint Palette.

When you clicked the control, the name ‘polysilicon’ appeared next to it and the Selector area became filled with the polysilicon layer. The layout on the screen should appear as shown to the right: it is a transistor with a n-type channel.

Remark: The white area in which you design your layout represents the semiconductor substrate. In n-SCMOS technology it is assumed that the semiconductor substrate is p-type. When you place a diffusion rectangle in the substrate area, it becomes n-type diffusion (N-diffusion). As a result, the transistor which you just have designed is a n-channel device.

• Position the pointer in the middle of the rectangle where the polysilicon and diffusion intersect, just as shown here. Click the mouse button and move the pointer away.

The Selector was reduced to a point. It should be fairly visible, though.

• Choose the Get Info item from the Edit menu.

A dialog box has appeared as shown to the right:

All layers that are present immediately below and to the right of the upper left corner of the Selector are listed in the dialog. If you placed the Selector precisely as requested, the only layer listed is ‘n– transistor’. Recall that there is no such layer among the simple layers. The n–channel transistor layer is a composite layer, also called a pop–up layer (the reason for this second name will soon become apparent). Composite layers usually result from interactions of simple layers; in this case, placing polysilicon over N–diffusion created a n–channel transistor.

• Position the Selector so that it is a 2×2 \( \lambda \) square, with its upper edge 1 \( \lambda \) below the polysilicon. Click the polysilicon control.

The lower portion of the layout should initially appear as in the left figure; after about a second delay it will have changed its appearance as shown in the right figure. Simultaneously, the DRC menu title should start blinking once per second.

Remark 1: If your layout maintains the initial appearance, make sure that the Continuous Checking item has a check–mark to the left, and that there is a Hide Errors item in the DRC menu (see instructions earlier in this section).

Remark 2: The instructions to position the new polysilicon rectangle close to the old one are meant only to show you the design rule checker at work. In order to obtain a correct design, the new polysilicon rectangle should be positioned farther away from the old polysilicon rectangle.

You have just seen Uncle’s background design rule checker in operation. Whenever Uncle is idle for one second and the Continuous Checking item is checked, Uncle will automatically perform a design rule check in all areas where the layout was edited most recently. If, in addition, the design rule checker is in the ‘visible errors’ mode, all areas
that are recognized as violating the design rules will be marked with a special pattern that spells 'DRC' diagonally.

- Select the **Hide Errors** item from the **DRC** menu.

Note that the layout has returned to its initial appearance, but the title of the **DRC** menu keeps blinking. The design rule checker is now in the 'invisible errors' mode. This lets you view the layout not obscured by the design rule violation markings.

- Select the **Scan Errors** item from the **DRC** menu. Do not click the mouse for several seconds.

The pointer has changed into and the area previously covered with the violation patterns has blinked several times. This is an alternative form of a visual feedback that lets you know the location of the design rule violations. After all violations are shown, a dialog is displayed, informing you that you have seen all errors in the cell. Click the OK button in this dialog.

- Select the **Find Errors** item from the **DRC** menu.

You will see a dialog, similar to the one shown here to the right. This dialog will last 6 seconds, unless you click the pointer in the **Hold the info window** button. Do not click other buttons yet. Read the diagnostics in the dialog; it indicates violation of the minimum spacing between two polysilicon areas. Click the OK button in the dialog that appears at the end.

- Select the **Scan Errors** item from the **DRC** menu again. While the violation area is blinking, click the pointer in the window area.

The dialog shown previously has appeared; however, it does not have the **Next violation** button. If you do not click any buttons, this dialog will last 6 seconds. After its disappearance, the Selector is set to enclose the area of the design rule violation described in the dialog; this is the same violation that was blinking while you clicked the cursor in the window area.

- Select the **Show Errors** item from the **DRC** menu again, and position the Selector over the area marked with the DRC pattern. Select the **Explain Error** item from the **DRC** menu.

The dialog shown previously has appeared again; however, the **Next violation** button is replaced by the **Another violation** button. If you do not click any buttons, this dialog will last 6 seconds. If there were several errors in the same area, you would see a series of dialogs explaining them.

- Select the **Undo** command from the **Edit** menu.

The polysilicon rectangle has disappeared. After approximately one second delay and a blink of the pointer, which changed into for a brief moment, the **DRC** menu title has stopped blinking. This signifies the correctness of your layout.

**Remark:** The non–blinking **DRC** menu title signifies a correct layout only if the **Continuous Checking** item is checked.

- Type the \[ \downarrow \] key.

Note that the Selector moved down without changing its dimensions.

- Hold down the \[ \text{SHIFT} \] key and type the \[ \downarrow \] key.

Note that the Selector has grown taller: its lower edge moved down 1 \( \lambda \).

- Hold down the \[ \text{SHIFT} \] and \[ \text{COMMAND} \] keys simultaneously and type the \[ \downarrow \] key.

Note that the Selector has grown shorter: its lower edge moved up 1 \( \lambda \).

You have just learned how to resize and move the Selector with the keyboard. The operation of other arrow keys, \[ \leftarrow \], \[ \rightarrow \], and \[ \uparrow \], is analogous. Practice positioning the
selector with the keyboard for a while: make it exactly overlap each of the five rectangles constituting your transistor. Now you can precisely position and reshape the Selector with the keyboard, should you prefer this method to positioning the Selector with the mouse.

- Position the Selector so that it is a 6x9 $\lambda$ rectangle with its lower edge 10 $\lambda$ above the upper edge of the N-diffusion. Position the mouse over the $\square$ control in the Paint Palette. Depress the mouse button and hold it down without moving the mouse.

  After about half a second after you depressed the mouse button, a pop-up menu has appeared as partially shown in the figure to the left. This menu contains names of all composite layers available in the n-scmos technology. This menu is the reason why the alternative name for these layers is ‘pop-up layers’.

  Paint this rectangle with P-diffusion. Use the $\text{SHIFT}$, $\downarrow$, and $\uparrow$ keys to extend the Selector 2 $\lambda$ down and 8 $\lambda$, just as shown to the right.

- Click the $\square$ control at the top of the Paint Palette.

  Part of the Selector area directly over the polysilicon gate overhang of the n-channel transistor has been painted with polysilicon. Your layout should now appear as shown to the right. The control you clicked is the Extend Up control. When you click this control, Uncle samples all layers that touch the upper edge of the selector and extends these layer downward. The other three controls, $\square$, $\swarrow$, and $\searrow$ at the top of the Paint Palette act in an analogous manner: they sample layers touching the upper, left, and right sides of the Selector respectively, and extend them upward, to the right, and to the left.

- Position the Selector so that it is a 4x4 $\lambda$ rectangle whose left part overlaps by 1 $\lambda$ the right N-diffusion area of the N-channel transistor. Paint this Selector with the N-diffusion and contact layers. The contact control in the Paint Palette is $\square$.

  The layout should look as in the figure to the lower right. Note that the 4x4 contact you have just made appears as if composed of two rectangles. This is due to the internal data structures of Uncle that enable its unlimited depth Undo and Redo. There is no need to worry about the appearance of the contact in the layout window: when you save the layout, Uncle will make a single contact out of the mess you see on the screen.

  You can now use the Get Info command to verify that the layer created inside the Selector is indeed ‘N contact’. As with the p-channel transistor and n-channel transistor, it is a composite layer.

  You should be aware at this point that the contact area you have just painted includes both the contact hole and the overlaps of diffusion and metal necessary to make a reliable contact. This is explained in more detail in the Quasi-symbolic representation of IC masks in Uncle chapter.

- Move the selector with the $\uparrow$ key until its lower edge is aligned with the lower edge of the P-diffusion. Position the mouse over the $\square$ control in the Paint Palette. Depress the mouse button and hold it down without moving the mouse.

- Choose the $\text{P contact}$ item from the menu and release the mouse button.

  The Selector becomes painted with the ‘P contact’ layer. The layout should appear as in the figure to the right. Again, please disregard the fact that the contact you have just made looks as if it was composed of two rectangles. Note the number of bytes that is occupied by the cell in the computer memory.

- Choose the Compact Data command from the File menu.

  The command you have just chosen removes all data that was concerned with the Undo capabilities of Uncle. If you look at the Edit menu now, you will see that the Undo item has become inactive. As a result of the data compaction, the contacts acquire a neat appearance. Note the decrease in number of bytes occupied by the cell in memory.
Position the selector so that it is 4 \( \lambda \) wide and touches both contacts in the layout. Pull down the **Artwork** menu and select the **Paint** item. Select the **metal** item from the menu that will have appeared.

The contacts have been joined with a metal wire, and the layout appears as shown to the right.

Selecting a layer name in the **Artwork/Paint** menu is another way to paint the layout. Similarly, the **Erase** item just underneath **Paint** in the **Artwork** menu provides a way to erase layers that is an alternative to clicking layer controls in the Paint Palette or selecting them in the Artwork Palette Pop–Up Menu. These hierarchical menus are useful whenever the Paint Palette is not being displayed, e.g. when the Subcell Palette is active (you will use the Subcell Palette quite soon).

At this point, the layout consists of two transistors that have a common signal applied to their gates (this signal is the input to the inverter). The drains of these two transistors are connected with a metal wire that will be the output of the inverter. To finish the layout of the inverter, you should connect the source of the p–channel transistor to a metal rail that will carry the positive voltage supply and the source of the n–channel transistor to the ground. Using the Selector and layer controls in the Paint Palette, you should be able to add the n-well and the necessary contacts without any problems. One of the possible layouts is shown above. Please add the missing elements to your layout.

Position the selector exactly over the polysilicon contact. Type letters ‘in’.

In most cases, typing anything on the keyboard without holding down one of the `COMMAND`, `OPTION`, or `CONTROL` keys is interpreted as a request to input a label. The dialog that has appeared in response is used to set label attributes. Select the **left** item from the **Position:** pop–up menu. This tells Uncle that the label should be displayed close to the left side of the Selector. Click the **Inside** button: this requests that the label be displayed inside the Selector. Finally, check the **unexpanded cells** attribute and uncheck the **expanded cells** attribute, so that the dialog looks as shown above, perhaps with the exception of the numbers specified under the **Label rectangle:** text. Usefulness of these attributes will soon become apparent. Finally, click the **OK** button. You have just labelled the input to the inverter.

**Remark:** You can also invoke the dialog shown above by choosing the **Add Label...** command from the **Artwork** menu.

Using the \( \Box \) key, move the selector so that it falls within the metal wire joining the two contacts on the right–hand side of the inverter. Create another label, ‘out’, with identical attributes as ‘in’, except that the **Position:** this time should be **right**.

Choose the **Save** command from the **File** menu.

The data describing the inverter cell you have just designed is written to the disk.

Choose the **New** command from the **File** menu. Type in the name of the new cell: ‘oscillator’. Click the **OK** button.

A new window is displayed, which you will use to construct a three–stage oscillator circuit.

Click the \( \Box \) icon at the top of the Paint Palette.
The palette has changed. What you see now is the Subcell Operations Palette. A subcell is a reference to some cell made in another cell. The effect of placing a subcell A in a cell B is to import the entire layout contained in the cell A into cell B. This layout can be moved, rotated, and mirrored as one entity. The Subcell Operation Palette is used to perform these and other operations on subcells. Whenever the Subcell Operation Palette is visible, Uncle is in one of its Subcell Operation Modes. Note that the control is highlighted on the Subcell Operation Palette and that the pointer assumes the regular crosshair shape, \( \square \), when moved over the layout area. Uncle is now in the Basic Subcell Edit Mode.

Remark: In Subcell Operation Modes you can paint and erase layers by selecting them from the Artwork menu only.

- **Choose the Add Subcell... command from the Edit menu.**

A dialog box is displayed that lets you select a cell from those present on the disk.

- **Select inverter and click the OK button.**

You will see a dialog shown to the right. This dialog allows you to name the instance of the subcell you want to insert and to determine its position and orientation. Write any name you want (it is OK to leave the default name which is the same as the cell name). Do not change the position and orientation of the cell. Click the OK button.

Uncle will place a subcell that references the ‘inverter’ inside the ‘oscillator’ cell. The screen should appear as shown to the right.

The subcell is initially displayed as a rectangle coinciding with the subcell’s bounding box, with some information displayed in the rectangle. Subcells displayed in this manner are called unexpanded. In the upper left corner of an unexpanded subcell there is a small symbol, \( \uparrow \), representing the orientation of the subcell.

The subcell image also contains the name of the referenced cell and the instance name of the subcell. Instance names displayed in quotation marks can be used to distinguish two subcells of the same cell that both reference the same cell. The default instance name of a newly inserted subcell is identical to the referenced cell name.

In addition to the orientation, cell name, and instance name, all those labels that have the Label shown in unexpanded cells attribute set are displayed. This feature can be used, e.g., to connect external signals to a subcell without the need to see the subcell’s contents.

- **Click the mouse while the pointer is in the layout area, but somewhere outside the subcell. Click the mouse again, this time while the pointer is positioned over the subcell. Be careful not to move the mouse while you click the button.**

Note that after the first click, the subcell outline became displayed in thin lines. After the second click, the subcell became displayed in thick lines. A subcell displayed in thick lines is selected. A cell becomes selected if it is clicked without dragging the mouse; any previously selected cell becomes deselected. If empty area is clicked, any currently selected cell becomes deselected.

- **Click the mouse while the pointer is in the layout area, immediately drag the mouse while holding the button down, then release the button.**

Note that you have repositioned the Selector. Dragging the mouse does not affect the status of the selected and deselected cells.
• Position the pointer over the subcell. Depress the mouse button and hold the mouse still until the pointer changes its shape into a hand, \(\rightarrow\). Without releasing the button drag the mouse, then release the button.

When you dragged the mouse, a gray rectangle shaped like the subcell moved together with the mouse, as shown in the figure to the right. After releasing the button, the subcell moved to the position last occupied by the gray rectangle. You have just learned how to reposition subcells. The mouse must be held still for the pointer to change into the hand. Even a small mouse movement that would not move the pointer to the adjacent grid node will be treated as an attempt to reposition the Selector rather than the subcell.

Practice moving the subcell until you feel comfortable with the technique described above.

• Deselect the subcell. Click the \(\square\) control in the Subcell Operations Palette.

This is the Right Rotation Control. Note that the pointer changes its shape to \(\rightarrow\) over the layout area and that the clicked control remains highlighted. This indicates that Uncle is now in the Right Rotation Mode.

• Position the pointer over the subcell and click the mouse button.

Clicking a subcell with the \(\rightarrow\) pointer rotates the subcell right by 90° while preserving the position of the upper left corner of the subcell image. The clicked subcell becomes selected. The screen should now appear as shown to the right:

If you click somewhere over the empty area, nothing happens, except that the currently selected cell becomes deselected and a beep sounds.

• Position the pointer over the \(\square\) control in the Subcell Operations Palette and double–click it.

The clicked control is the Left Rotation Control. As a result of the double–click, the selected subcell is rotated left and the window should appear now as it did before the right rotation was applied. Note that the double click did not change the mode; the Right Rotation Control is still highlighted and the pointer retains the \(\rightarrow\) shape over the layout area.

You have learned now two ways of applying transformations to subcells. One is to enter a transformation mode, then to click the cell you want to transform. The other way is to double–click a transformation control: the transformation is applied to the selected subcell and the mode does not change. All the transformation controls, which, in addition to the two controls you already know, include \(\square\), \(\square\), and \(\square\), act in the same manner.

Remark: another way of applying transformation to a selected subcell is to choose appropriate command from the Operations menu.

• Click the \(\square\) control.

You are now back in the Basic Subcell Edit Mode.

• Make sure that the inverter subcell is selected. Choose the Array... command from the Edit menu.
A dialog box has appeared as shown to the right. It can be used to make an array of subcells. An array of subcells is treated as one entity, and operations on any of the subcells in the array affect the entire array. The numbers in the text–edit boxes represent the current array parameters. In particular, the horizontal and vertical step values are set to make the subcells in the array abut.

- Type in the number of horizontal repetitions of the subcell in the array: for this exercise, 3. Click the \textbf{OK} button.

An array of subcells has appeared. Try moving, transforming, deselecting and selecting it. Leave the array in the orientation number 0.

- Hold down the \textbf{COMMAND} key on the keyboard.

Notice that the control on the View/Mode Palette changed its shape into \textbf{X}.

- Still holding the \textbf{COMMAND} key down, click the control.

The magnification of the picture in the window has changed: the array of subcells appears smaller, and if you move the pointer over the layout area, you will notice that the grid size has decreased. All dimensions measured in \(\lambda\) remain the same, though. You have just learned how to decrease the magnification used to display the layout. The same control, clicked without holding the \textbf{COMMAND} key down, increases the magnification. Scroll the window so that the entire array of subcells is visible, as shown here.

- Position the selector so that it overlaps the array of inverters as shown above and select the \textbf{Expand All} command from the \textbf{Operations} menu.

The entire array of subcells has changed its appearance as shown in the figure to the right. You can see all the internal details of each inverter. The subcells appear now in their expanded view. The \textbf{Expand All} command causes all subcells that intersect the selector (and all their subcells that intersect the selector) to appear in their expanded view. See the Cell Edit Mode Reference chapter for other methods of expanding cells and subcells.

- Hold down the \textbf{OPTION} key and pull down the \textbf{Operations} menu. Select the \textbf{Unexpand All} command.

The array of inverters assumed the unexpanded view. Holding down the \textbf{OPTION} key changes the \textbf{Expand All} command into \textbf{Unexpand All}; the effect of selecting the latter is to display the topmost subcell in the hierarchy of subcells intersecting the Selector.

Remark: The \textbf{OPTION} key must be held down before you click the mouse button. Depressing it after you have pulled down the menu will not have the desired effect.

- Click the icon at the top of the Subcell Operations Palette.

The palette has changed into Device Palette; please refer to the Cell Edit Mode Reference for information on this palette. For now, just ignore it.

- Click the icon at the top of the Device Palette.

The palette has changed into Paint Palette again.
• Paint a contact to poly and three polysilicon rectangles, creating a $2 \lambda$ wide feedback path from the output of the last inverter to the input of the first inverter, as shown in the figure to the right. The use of labels should be apparent: you do not need to see the interior features of the subcells in order to be able to position the signal connections correctly. This is especially useful when doing layouts of large circuits, when display of the interior features of subcells becomes time-consuming.

The polysilicon path completes the design of the three-stage oscillator.

• Choose the Save command from the File menu.

Uncle has written the oscillator cell to the disk.

• Choose the Save A Copy As... command from the File menu.

The standard Save As... dialog box with one additional pop-up menu named Format has appeared. You will learn later what formats are available and when it may be necessary to use them. For now, do not use this menu. Save the oscillator cell under a new name, e.g. new_oscillator.

• Choose the Open... command from the File menu.

Open the new_oscillator cell.

• Erase the polysilicon path and the contact. Paint three metal1 rectangles, creating a $3 \lambda$ wide feedback path from the output of the last inverter to the input of the first inverter, as shown in the figure to the right.

The metal path replaces the polysilicon path.

Remark: it is better to use metal than polysilicon for long interconnections.

• Choose the Save command from the File menu.

Uncle has written the new oscillator cell to the disk. At this moment you have three cells opened: the inverter cell and two oscillator cells. The front window displays the new_oscillator cell.

• Choose the Verify Cell command from the DRC menu.

A dialog tells you that there are no design rule violations in the cell. However, verification is limited only to the artwork that you have designed in this cell, i.e. to the metal path which connects the output of the last inverter with the input of the first one. The artwork inside the inverter cells is not checked.

• Choose the Save As Flat Cell... command from the File menu.

The standard New... dialog box has appeared. The suggested name of a new cell is new_oscillator_flat.

Click the New button and wait until Uncle creates a new cell in a new window. Note how Uncle builds the new cell importing the artwork from the subcells.

The new cell that has just been created contains full layout of the new oscillator and no subcells. Its contents is shown to the right.

• Choose the Verify Cell command from the DRC menu.

A dialog tells you that there are 4 design rule violations in the new_oscillator_flat cell!
• Choose the **Show Errors** command from the **DRC** menu, and position the Selector over one of the areas marked with the DRC pattern. Select the **Explain Error** command from the **DRC** menu.

A dialog tells you that the separation rule between N plus contact and P diffusion layers is violated. Note that the contact is situated in one subcell and the P diffusion is situated in another, adjacent subcell. The subcells as such are correct, but abutting them leads to DRC errors.

• Bring the inverter cell window to the front by either clicking inside it or choosing the **inverter** item from the **Cells** menu.

• Paint 1 \( \lambda \) wide rectangles of n-well and metal1 in the left part of the cell, as shown to the right. Move the “in” label rectangle to the left by 1 \( \lambda \).

  The width of the entire cell increases by 1 \( \lambda \) and the N plus contacts no longer touch the cell boundary.

• Bring the new oscillator cell window to the front by either clicking inside it or choosing the **new_oscillator** item from the **Cells** menu.

  The layout of the new oscillator cell should look as in the figure to the right. Since the inverter is now 1 \( \lambda \) wider, the inverter subcells overlap. There is also 1 \( \lambda \) wide overlap of the metal connection over the input to the first inverter.

  **Remark:** In large layouts it is not always easy to notice subcell overlaps. The command **Verify Cell Placement** in the **DRC** menu looks for possible subcell overlaps. If there are any, you can make them visible by choosing the **Show Cell Overlaps** command from the **DRC** menu. This command is active if the cell placement has been verified and overlaps were found. Try these commands to see how they work.

• Click the \( \square \) control in the Subcell Edit Palette and click inside the inverter array to select it. Once the array is selected, choose the **Array...** command from the **Edit** menu.

  A dialog that is used to create arrays has appeared again. Change the horizontal step from 17 \( \lambda \) to 18 \( \lambda \) and dismiss the dialog with the **OK** button. The inverter cells no longer overlap, but the right boundary of the array moved to the right. Note that the metal1 connection from the output of the last inverter to the input of the first one must be adjusted to the new shape of the array. The vertical metal1 line connected to the output should be moved to the right. There is also an unnecessary 1\( \lambda \) wide overlap of the metal1 over the input of the first inverter which should be removed.

• Deselect the array, switch to the Paint Mode Palette and position the Selector over the vertical segment of metal1 connected to the output of the last inverter, as shown to the right, and choose the **Move...** command from the **Operations** menu.

  A dialog box has appeared as shown to the right. It can be used to move the artwork inside the Selector. Increase the X coordinate of the destination by 2 \( \lambda \) and dismiss the dialog by clicking **OK**. The contents of the selector has moved to the right. Now the contact and the vertical metal1 line are positioned correctly, but there is a 2 \( \lambda \) wide gap in the horizontal metal1 connection.
• To complete the layout of the new version of the oscillator, move the vertical segment of the metal1 connection to the input of the first inverter to the left, and fill the gaps in the horizontal segment. Expand the subcells. The final layout should appear as shown to the right.

This is the end of your first session. You are now more or less familiar with many of the basic functions of Uncle. The rest of this manual will show how to use Uncle in the most efficient way and how to prepare your own technology description files for IC technologies other than those supplied with Uncle.
3. Basic Concepts of Uncle

This part describes the basic considerations that underlie the implementation of Uncle. If you have used the layout editor called Magic\(^1\), some of these concepts may be familiar to you.

3.1 Hierarchical editing of VLSI layouts

In integrated circuit layouts, numerous features are repeated in many places on a chip. Therefore, it is useful to define each repetitive layout configuration as a cell and put references to this cell, called cell instances or subcells, in each place the given configuration should appear. The layout of an IC can be described as a collection of cells and primitive objects, e.g., rectangles or polygons, which represent shapes on masks used to manufacture the IC. Cells with other cells' instances can be referenced in yet other cells, thus creating a hierarchy. At the top of this hierarchy is a single cell that represents the entire design via references to its subcells and to mask primitives.

By using the hierarchy, the sizes of masks' descriptions can be significantly reduced with respect to the descriptions in which each mask feature is listed explicitly. Hierarchical design also reduces the designer's effort and increases maintainability of IC designs. Uncle provides the capability of defining cells and of instantiating them hierarchically to any depth. All cells composing a single IC chip must be contained in the same folder.

For more flexibility, it should be possible to apply transformations to each cell instance, so that it is not necessary to describe separately two layout configurations that are, e.g., mirror images. In Uncle, all of the eight possible orientations of cell instances can be specified.

In Uncle, each cell must be edited in a separate window. At any time, only the topmost window, containing the active cell, is active. The cell in the active window can be edited; the instances of other cells that are visible in this window cannot be edited, unless separate windows containing them are opened and activated.

3.2 Quasi–symbolic representation of IC masks in Uncle

3.2.1 Uncle layers and technological masks

While using Uncle, you do not need to think about the layout in terms of technological masks used for IC manufacture. Since it is easier to think in terms of the IC elements such as diffusion paths, transistors, etc., in Uncle you will design ICs by using layers which correspond to IC areas with certain physical and electrical properties.

Example 1: in CMOS technology, it is easier to draw a shape and declare it to be diffusion type N than to draw the three masks\(^2\) necessary to manufacture such a shape: a mask of P-wells, a mask of locos\(^3\) (LOCal Oxidation of Silicon) areas, and a mask of N-select areas. The left side of the figure above shows the appearance of N–type diffusion in Uncle.


\(^{2}\) If the manufacturing process utilizes the channel-stopper implantations, more masks would have to be used to define an N-diffusion area properly.

\(^{3}\) Also known under other names: active area or thin oxide area.
window. The right side shows the masks necessary to make this diffusion. In Uncle, it is sufficient to draw only one shape, and the masks required to define it will be generated automatically by Uncle when a CIF or GDSII description is output.

Example 2: In order to make a contact between two conducting layers in an IC, it is usually necessary to provide a cut in the insulator separating these layers. This cut should be surrounded by the layers with a certain specified overlap. For the user, it may be easier to provide just the shape of the total area of the contact, containing the cut and all the required overlaps. Uncle will determine the position of the cut automatically.

For example, the left side of the figure to the right shows the appearance of a contact to diffusion in Uncle. The right side shows the masks necessary to make this contact.

The relations between Uncle layers and technological masks may be of several kinds:

- A mask used to manufacture the IC may be identical in shape to the corresponding layer in Uncle. One example is the overglass mask in the n-scmos technology supplied with Uncle.
- A mask may be a union of several layers. For example, in n-scmos the mask of metal2 is obtained as union of three layers: a layer of metal2, a layer of metal1/metal2 contacts, and a layer of overglass.
- A mask may be defined in a more complicated way, by using operations of union, intersection, difference, and shrinking or expanding several layers. For examples, see the chapter describing technology editing in Uncle.

The conversion from layers to masks is of no importance while you design the layouts. The conversion formulas are defined only once and stored in technology description files, from which they are read automatically and applied when necessary.

### 3.2.2 Substrate

The substrate of the integrated circuit is represented in Uncle by the empty drawing area which extends from -32760 \( \lambda \) to +32760 \( \lambda \) in both directions. Uncle will warn you if you attempt to perform any operation beyond these limits. It is not recommended to place any layout objects very close to the limits of the drawing area. Some violations of the design rules in areas close to these limits may remain undetected. Uncle will warn you if such situation may occur.

Sometimes it may be convenient to include in the technology description file a special layer named “substrate”. The purpose of this layer is to indicate the boundaries of the cell. Such a layer may simplify conversion of Uncle layers to technological masks. For example, in many IC technologies one of the masks is the field implant mask. This mask is used for implantation performed to the entire IC area with the exception of the locos areas. It is therefore natural to define this mask as the difference between the entire IC area and the locos areas. To avoid generation of the field implant mask extending from -32760 \( \lambda \) to +32760 \( \lambda \) in both directions and to limit it to the actual area occupied by the design, the “substrate” layer may be used. This appearance of this layer is usually defined in such a way that only the outline of it is visible, but not any pattern or color. Therefore, this layer does not interfere with the appearance of other layers.

The “substrate” layer can be painted and erased in the same way as any other layer. However, the behavior of this layer is different than the behavior of all other layers. By definition, this layer is always present everywhere in the rectangle enclosing the designed cell. If you add any new shape to the cell artwork in such a way that the external dimensions of the cell increase, the “substrate” layer is added automatically where needed. However, when the external dimensions of the cell are reduced, the “substrate” layer is not erased automatically. It can be erased in the normal way by enclosing the entire unnecessary portion by the Selector and choosing the “substrate” layer name from the

---

1) Depending on the technology, the overlaps shown in the figures on this page may vary.
submenu that is displayed under the eraser icon in the Paint Palette. The illustration below shows the behavior of the "substrate" layer.

a: substrate layer fills the cell rectangle automatically  
b: the lower portion of the metal path erased, the substrate layer remains  
c: erasing the substrate layer  
d: after erasing

3.3 Painting paradigm for layout artwork editing

You are encouraged to think of the layout artwork as a structureless object just like a painted area. The Uncle interface is designed to operate on this object by adding/removing painted areas to/from the existing ones.

Remark: Internally, Uncle represents each layer in the form of interlinked rectangles. The representation of the layout on the screen usually does not reveal the internal structure. In most cases, only the outlines of the layer are visible in the form of a rectilinear polygon. Sometimes, especially for the contacts, the internal structure may become visible; however, the CIF or GDSII output generated by Uncle is independent of the internal structures.

3.4 Modes of operation in Uncle

The operation of Uncle is modal: only a certain subset of all available operations can be performed at any given time. To perform other operations, you have to switch the mode by clicking a control or by selecting a menu command.

The two basic modes available in Uncle 1.8 are Technology Edit Mode and Cell Edit Mode. The Technology Edit Mode allows you to define the number of layers available in the technology, how they interact with each other, how they are displayed, and how they should be output in the available output formats. This mode is of interest only to advanced users. The Cell Edit Mode is used to do all manual editing of IC layouts. In the Cell Edit Mode, you can edit primitive objects as well as add subcells and modify their positions. Most users will use only this mode of Uncle for designing their integrated circuit layouts. You can switch between the basic modes by selecting appropriate commands from the Menu. By default, Uncle always starts up in Cell Edit Mode. To ascertain the current mode of Uncle, press the mouse in the symbol in the menu bar; a menu will appear in which the current mode is marked with a bullet, •.

In the Cell Edit Mode, there are three artwork interaction modes and three different artwork palettes: the Paint Palette, the Subcell Operations Palette, and the Device Palette, one of which is displayed at any time. Basically, the three palettes are used to perform three groups of operations: operations on primitive objects, operations on subcells, and operations on simple devices.

---

1) In the scmos technology the "substrate" layer is not defined. The picture illustrates another, more complex CMOS technology.
The type of palette and the current interaction mode is identified by the icon at the top of the palette. By clicking this icon, you can switch the modes and the palettes in a circular manner: Paint→Subcell→Device→Paint. The Device Palette does not appear if there are no devices defined in the current technology used by Uncle.

3.4.1 Help Mode

Each of the basic modes of Uncle can be toggled into Help Mode. You can enter Help Mode in three ways. One is to select the Help... command from the Apple Menu, and then click the OK, Continue help button. The second way to enter Help Mode is to type the ? key (the notation ☑ ‘character’ refers to holding down the COMMAND key marked ☑ ☑ or ☑ ☑ or both while typing the given character, in this case ‘?’). The third way (available only when Uncle runs under System 7 or later) is to select the Uncle Help... command form the System 7 Help menu, i.e. the menu that toggles Balloon Help on and off. Help Mode is signified by a change in the pointer, which becomes a heavy question mark, ☑, when the pointer is moved outside the layout area. In Help Mode, clicking an item on the screen, selecting a menu command, or typing a key will produce a dialog box with some descriptive text. An example help dialog, obtained after clicking a left scroll arrow in Help Cell Edit Mode, is shown above.

If the help text does not fit in its box, it can be scrolled up or down. If the action described in the help dialog is sensitive to any modifier keys, the applicable keys are shown underneath the help text. Clicking on one of these keys will show the corresponding text.

There are three buttons in the help dialog. If you click the default button (drawn in a thick frame), Help Mode will continue without performing any operations. Clicking the Cancel help mode button brings you back to the regular mode, also without performing any operations. Clicking the Do it! button will trigger the action described in the help dialog; the help mode will continue. This last button is inactive if the described action cannot be performed or if the help information refers to some topic of a general nature.

In Uncle 1.8, you can request help for inactive (dimmed) menu items but not for inactive dialog items. Most of the dialogs that are displayed by Uncle have some help information for every item they contain, except the text items, icons, and similar objects whose purpose is evident. Some dialogs are self-explanatory, there is no help for them. For analogous reasons, there is no help for alerts.

Note: you can enter help mode by typing ☑ ? at any time, including when you are responding to dialogs.

Balloon help is not available in Uncle 1.8. Most help texts are too long to fit in a balloon of reasonable size.
4. Cell Edit Mode Reference

The Cell Edit Mode is used to compose hierarchical layouts of integrated circuits in Uncle. This chapter describes the means provided by Uncle for editing the contents of cells in the hierarchical IC layout. It first tells how Uncle is started up in Cell Edit Mode, how to select a technology, and how the data files can be created, saved, and read in. Following the description of the input/output commands, the tools for entering and modifying the layout data are discussed. You already know some of this chapter’s contents from the First Session.

4.1 Starting up Uncle in Cell Edit Mode

Uncle starts up in Cell Edit Mode if it is opened alone or if it is invoked to open a cell data file.

Upon startup, Uncle looks up the type of the Macintosh it is being run on, and creates color and black–and–white screen buffers. These buffers take up about 400 kBytes on a Macintosh equipped with a small 13” color monitor and are much larger in Macintoshes equipped with larger color monitors. If your Macintosh does not have enough memory, you may want to disable the color screen buffer. You should use the Control Panel desk accessory to set the monitor characteristics to Black & White/Grays mode and set the number of grays to two. Furthermore, immediately after launching Uncle, you should hold down the mouse button until the Uncle startup dialog from page 2–1 appears. In this manner you will let Uncle know that you do not intend to use it in the color mode and the color buffer will not be allocated, even if you use the Control Panel to change the monitor settings.

To start up Uncle:
- Select the Uncle™ icon in the Finder and then choose the Open command from the File menu.

Uncle will initially display an information dialog. After you click the OK button, it will draw a menu bar and wait for your commands.

Alternative methods that can be used to start up Uncle:
- Type the ertzkey.
- Double–click the Uncle™ icon.

To open an Uncle cell data file from the Finder:
- Select in Finder one or more cell data files and open them using one of the three methods described above for starting up Uncle.

After closing the initial information dialog, all selected data files will be read in and windows with their layouts will be opened.

Possible messages:
Uncle can open simultaneously only cells done all in the same technology. If the selected cells utilize several technologies, you will be told which cells cannot be opened and why.

Possible problems:
- If by some chance Uncle starts up in a different mode, choose the Cell Edit command from the Menu to switch to the Cell Edit Mode.

4.1.1 Manipulating technologies in Cell Edit Mode

After starting up Uncle, you may want to declare the technology you want to use. Two of the technologies available have special meanings. At any given point during Uncle execution in Cell Edit Mode, the technology being used is called the current technology. The default technology is the one that is used after Uncle is started up alone.
To set the current technology without leaving the Cell Edit Mode:

- Pull down the **File** menu and move the pointer to highlight the **Current tech** command. A submenu with technology names will be shown to the side of the **File** menu. If there is an item in the submenu that is the name of the technology you want to use, choose it. Otherwise, choose the **New...** command in the submenu. In the latter case, you will be shown a standard file dialog, enabling you to select the technology you want to use from now on.

Possible messages:

Whenever the current technology is changed, all cell windows are closed. You will be asked if you really want to close the cell windows and given a chance to cancel the technology change. If the technology change is confirmed, you will be asked if you want to save any of the cells that were not saved after the most recent changes. At each point, you have the option to discard or save the most recent changes in the cell, or to cancel the technology change.

Alternative methods for setting the current technology.

- Enter the Technology Edit Mode and set the current technology as described in the Technology Edit Mode Reference.
- Choose the **Open...** command from the **File** menu and select a cell that utilizes the technology you want to use. Uncle will open a window for this cell and switch to its technology.

Additional possible messages:

If asked to open a cell data file, Uncle will look for the appropriate technology in its own folder and then in the folder containing the cell. If the technology is not found there, you will be shown a standard file dialog and asked to locate the proper technology, with an option to cancel the request to open the cell. The aforementioned messages related to technology changes may appear as well.

Technology files prepared using versions of Uncle older than 1.3 are in a format slightly different than the format used by Uncle 1.8. These technology files are readable by Uncle 1.8. However, whenever Uncle 1.8 encounters such a file, a dialog saying that the technology file is obsolete is displayed. You may want to convert such a file to the new format. If you save this file (this is described in the Technology Edit Mode Reference), the file will be converted to the new format automatically. After conversion it will be no longer readable by Uncle versions older than 1.3.

To set the default technology without leaving the Cell Edit Mode:

- Pull down the **File** menu and move the pointer to highlight the **Default tech** command. A submenu with technology names will be shown to the side of the **File** menu; use it as described for the current technology.

Possible messages:

If the new default technology is not the current one, you will be told so, as it is possible that you intended to set a new current technology. You will always be asked to confirm the default technology.

If there is no space on the disk to set the new default technology, the previous default technology will be restored and an information alert will be displayed.

Alternative methods for setting the default technology.

- Enter the Technology Edit Mode and set the default technology as described in the Technology Edit Mode Reference.

Remark: Initially, both technology–related submenus contain two or three items. The first item of both submenus is **New...**. The second item is the name of the technology that was the default at startup. The third item may appear if Uncle is started up by opening a cell data file; in this case, the technology utilized by the opened cell automatically becomes the current technology. The names of the current and default technologies are marked in their respective submenus with the bullet character, ‘•’. Selecting either of them will only produce a warning beep. The names of any opened technology files are appended to both submenus.

Each time a default technology is changed, Uncle modifies its preference file. If the disk containing Uncle is almost full, this operation may fail.
Remark: Sometimes you may want to replace the default technology file by a new version of this file with the same name. Uncle can do that for you automatically. Place the new file in the Uncle folder. Upon startup Uncle will notice that there is a technology file with the same name as the default technology file, but created later, and will display a dialog asking if you want to replace the old file by the new one. If you click **OK**, Uncle will discard the contents of the older file and will replace its contents by the contents of the new one.

4.2 Creating, opening and saving cells

If you are an experienced Macintosh user, you can skip most of chapter 4.2. Opening and saving are done in essentially the same manner as in most Macintosh applications. The only not-so-common features are the requirement of giving any new cell a name (most other applications open a window called ‘Untitled’ or some such) and an additional control in the **Save as...** command.

4.2.1 Creating new cells

To open an empty window in which a new cell can be designed:

- Choose the **New...** command from the **File** menu.

Alternative method for opening an empty window:

- Type the **%N** key.

After invoking **New**, a dialog box used to declare the name of the new cell is displayed. This is a standard dialog, used in many other Macintosh applications to save files. The cell name functions as the name of the file containing all the data about the cell. When creating new cells, remember that all subcells composing a single chip must be contained in the same folder. The name of the new cell must be unique: no other cell with the same name may be edited simultaneously, and no other file with the same name should exist in the folder in which the cell data is to be saved.

Possible messages:

If another cell with the requested name is already being edited, Uncle will refuse to create the new cell and display an appropriate message.

If the requested name of the cell appears as a file name in the current folder, a small dialog box will appear, asking you to confirm overwriting the old file. If the deletion of the existing file is confirmed, a new window will be opened; however, the old file will be erased only after the new cell is saved. Only cell data files may overwrite other cell data files.

4.2.2 Opening existing cells

To open a window in which a cell can be viewed and modified:

- Choose the **Open...** command from the **File** menu.

Alternative method for opening a cell window:

- Type the **%O** key.

Another alternative method available when Uncle is running under MacOS version 7 or later:

- Double click the cell icon.

The **Open** command displays a standard dialog box used to select the name of the cell from the scrollable list. Only files that contain cell descriptions in Uncle format can be opened; other files are not displayed in the list.

While the cell is being read in, the pointer disappears from the screen. The moving bar indicator shown here is displayed to show the percentage of cell data already read in.
4.2.3 Saving cells

To save a cell in Uncle format:

- Select the **Save** command from the **File** menu.

Alternative method for choosing **Save**.

- Type the `#S` key.

The **Save** command writes to the disk the cell contained in the active window. The cell data file is placed in the folder selected at the time the cell was created. While the cell is being written, the mouse becomes inactive, the pointer disappears from the screen, and a moving bar indicator is displayed.

Possible problems:

If there is no active window, or if the cell in the active window has not been changed since the cell was saved, the **Save** command is inactive and typing `#S` will only produce a warning beep.

Alternative method to save cells in Uncle format:

- Choose command **Save All** from the **File** menu. This command will save all cells that were changed since they were last saved.

To save a cell in a user-selected format:

- Choose command **Save As...** from the **File** menu, active whenever the active cell is not empty.

The **Save As...** command displays a dialog box used to declare the name under which the cell is to be saved. This dialog, shown here, is similar to the one used for declaring names of new cells. The initial contents of the text–edit box at the bottom of the dialog is the current name of the cell; this name can be changed by typing in a new name. Compared to the standard dialog box, the **Save As...** dialog contains one additional item at the bottom. This item is a pop-up menu that you can use to select the format in which to save the cell. If the mouse is pressed in the box containing the format name, a pop-up menu appears as shown. Now you can select the desired format by dragging the mouse to the appropriate menu item and releasing the button. The selected name will be shown in the format name box. Note that Uncle adds automatically standard extensions to the cell names, e.g. `new_oscillator` becomes `new_oscillator.cif` when you select the ‘CIF’ format. It is usually convenient to use these extensions in order to recognize easily the files in various formats. However, you may change the file name, including the extension, to any name you wish. Clicking the **Save** button will write out the description of the cell in the selected format. Cell files may appear on the Mac desktop with the following icons:

- these are cells saved in native Uncle formats; the icon with the layout indicates Uncle for MacOS (binary) format, the “empty’ icon indicates the Uncle for Windows (text) format.
- these are cells saved in GDSII format (these files are binary).
- these are cells saved in Magic, CIF, and Electromask formats (these files are text files).

Possible messages:

If the name under which the cell is to be saved is identical to one of the names of the files in the currently accessed folder, you will be asked to confirm overwriting the old file. Cells in ‘Magic’, ‘Electromask’, and ‘CIF’ formats may overwrite only text files. Cells in ‘Uncle’ format may overwrite only other files that contain cell descriptions in the ‘Uncle’ format.
Remark 1: A file produced by saving a cell in Magic format also contains information about all cells hierarchically contained in the saved one. The format of the file is known as the 'shar' archive. After uploading the file to a Unix machine, the file should be run through '/bin/sh' with the following command:

```
/bin/sh < filename,
```

where 'filename' is the name of the file saved by Uncle in Magic format.

Remark 2: Uncle can read only files in its own format (Uncle and Uncle for Windows) and in Magic format. It is recommended that you always save the file in Uncle format before saving it in any other format.

### 4.3 Windows used for editing cells

A typical cell edit window used in Uncle is shown in the adjacent figure. The amount of computer memory taken up by the cell representation and the name of the current technology are displayed to the right of the cell name.

There are two palettes in the window that contain controls for layout editing operations. The two other items visible in the window are the Pointer and the Selector. They are the main tools used in Uncle to edit IC artwork.

The View/Mode Palette is always located to the left of the horizontal scroll bar. It contains controls for changing the window position over the cell artwork, for changing the scale of magnification, and for establishing the exact interaction mode with the artwork.

The Artwork Palette can appear in one of three possible variants: Paint Palette containing controls for editing layers, Subcell Operations Palette containing controls for hierarchical layout editing, and Device Palette containing controls for parameterized layout feature input. The Artwork Palette can be moved within the window. Both palettes are described in more detail later.

The cell window may also contain other items: a Selector Size Box, two Rulers: a horizontal one and a vertical one, and a Node Info Box. These items are either visible or not, their visibility is controlled by appropriate menu commands. When visible, they can be dragged to any convenient position within the cell window. The figure to the right shows a part of the cell window with all these items visible.

The selector size box shows size and position of the Selector and coordinates of the pointer. Their values are updated continuously as you move the mouse and reshape the Selector. The visibility of the selector size box can be toggled on and off using the Show Size / Hide Size menu command in the View menu.

The rulers show the horizontal and vertical coordinates in the cell window coordinate system. Their visibility can be toggled on and off using the Show Rulers / Hide Rulers menu command in the View menu.

The coordinates in the rulers and in the selector size box can be displayed either in $\lambda$ units or in microns or mils, depending on the settings of the appropriate preferences.

The node info box can be used to list all labels that are positioned within an electrical node and to show the area of the node in either square $\lambda$ or square microns. Visibility of the node info box can be toggled on and off using the Show Node Info / Hide Node Info command in the submenu Select Node, menu View. The concepts of nodes and labels are discussed in detail later in this manual.
4.4 Pointer

The default pointer on the Macintosh is a left–upward arrow: ⬇️. In Uncle, the pointer usually remains in this shape when it is not placed over the layout area in the active window, except in Help Mode as described earlier. Over the layout area, the pointer can assume several different shapes, each of which signifies some particular mode of interaction. The pointer always moves on a λ–grid over the layout area.

The most frequently used pointer is cross–shaped, with a small circle in the middle: ⬇️. This crosshair shape is usually used to reposition the Selector.

4.5 Selector

The main tool for layout editing is the Selector, shown to the left. The Selector bounds the area that will be affected by operations such as painting or erasing layers, copying the layout into or from a buffer, selecting layout parts, and defining labels’ and subcells’ positions. You can change its dimensions and position by using either the mouse or the keyboard. On the screen, the Selector is constantly flickering; thus, it is visible in any layout configuration. If the Selector is shrunk to a point, it shows up as a single blinking pixel.

In most cases, in order to achieve a particular effect, you first place the Selector at a desired position and then click an appropriate control on one of the palettes, or choose a menu command. There are some modes of Uncle, in which an action occurs immediately after positioning the Selector with the mouse.

4.5.1 Selector positioning with the mouse

There are five possible modes for mouse–positioning; these modes are entered by clicking one of the five rightmost icons on the View/Mode Palette, shown below. To signify the current positioning mode, the corresponding control is highlighted.

The basic way of positioning the Selector with the mouse is the unconstrained positioning mode. It should be used when the desired shape of the Selector fits in the layout window.

To position the Selector in the unconstrained positioning mode:

- If the control in the View/Mode Palette is not highlighted, click it to enter the unconstrained positioning mode.
- Press the mouse button while the pointer is at one of the desired Selector corners.
- Drag the mouse until the pointer occupies the opposite corner and release the button.

The Selector disappears from the screen when you depress the mouse button, and the pointer splits into two parts: the small circle stays at the clicked point, and the remaining cross, ⬇️, moves with the mouse. A gray rectangular outline is displayed, changing as you move the mouse. When you release the mouse button, the Selector assumes the shape and position of the gray rectangle. An example appearance of the gray rectangle is shown above to the right.

The other four positioning modes fix a selected corner of the Selector: you can change the position of the corner opposite the fixed corner. For example, by clicking the control on the palette, you enter a positioning mode in which the bottom right corner of the Selector becomes fixed. Analogously, ⬇️, ⬇️, and ⬇️ controls are used to fix, respectively, the...
lower–left, upper–left and upper–right Selector corners. In the fixed–corner modes, a small circle is displayed in the fixed corner of the Selector, and the gray rectangle will be displayed extending from the fixed point to the current pointer position.

The fixed-corner positioning modes are useful for positioning the Selector as a very long rectangle.

To position the Selector as a very long or very tall rectangle:
- Place one corner of the Selector using the unconstrained positioning mode.
- Click the constrained mode control that will fix this corner.
- Scroll the window away to the vicinity of the desired opposite corner.
- Press the mouse button, place it in this other corner and release the button there.

In the fixed-corner positioning modes, the shape of the pointer changes depending on its position relative to the fixed corner. The changes are meant to visualize what will happen to the Selector if the mouse is clicked. In the quadrant to the left and above the fixed corner, the pointer appears as a top–left corner with two small arrows, \( \uparrow \), indicating that the position of the top left corner of the Selector can be set. In the quadrant to the right and below the fixed corner, the pointer appears as a bottom–right corner with two small arrows, \( \downarrow \), indicating that the position of the bottom right corner of the Selector can be set (note that the fixed corner will became the upper–left). Similarly, in the top–right and bottom–left quadrants, the pointer appears as \( \rightarrow \) and \( \leftarrow \), respectively.

### 4.5.2 Selector positioning with the keyboard

To move and reshape the Selector on the screen, you can use the four arrow keys on the Macintosh keyboard.

To move the Selector up, down, left or right by 1 \( \lambda \):
- Type the arrow pointing in the intended direction of the move.

To move the Selector continuously in 1 \( \lambda \) increments:
- Type the arrow pointing in the intended direction of the move and hold it down. The Selector will move in one \( \lambda \) increments until the key is released.

To move the Selector in 4 \( \lambda \) increments:
- Hold down the \( \text{OPTION} \) key while typing an arrow key.

To move the Selector in 10 \( \lambda \) increments:
- Hold down the \( \text{CONTROL} \) key while typing an arrow key. This is not possible on a Macintosh Plus, since its keyboard does not have this key.

You can use the arrow keys to move just one side of the Selector and thus change the Selector shape.

To move the top side of the Selector up:
- Hold down the \( \text{SHIFT} \) key while typing the \( \uparrow \) key.

To move the top side of the Selector down:
- Hold down the \( \text{SHIFT} \) and \( \text{COMMAND} \) keys while typing the \( \uparrow \) key.

Holding the typed key down will move the chosen side of the Selector in 1 \( \lambda \) increments until the key is released. The modifier keys have the same meaning as for moving the Selector:
- \( \text{OPTION} \) key: the Selector will be enlarged in 4 \( \lambda \) increments.
- \( \text{CONTROL} \) key: the Selector will be enlarged in 10 \( \lambda \) increments.
To move the bottom, left or right side of the Selector:

- Use the \( \downarrow \), \( \leftarrow \), or \( \rightarrow \) keys analogously as described for the \( \uparrow \) key.

If the Selector is reshaped or moved with the keyboard, holding several modifier keys down simultaneously will multiply their effects, e.g., holding down both the \texttt{OPTION} and \texttt{CONTROL} keys will move the Selector by 40 \( \Delta \) when an arrow key is typed.

### 4.5.3 Selector positioning with the \texttt{Set Selector...} command

This command in the \texttt{View} menu displays a dialog as shown to the right. It allows to determine precisely the size and position of the Selector by typing appropriate numbers in the text-edit boxes. After dismissing the dialog with the \texttt{OK} button the Selector assumes new size and position. Clicking \texttt{Cancel} dismisses the dialog without affecting the current size and position of the Selector.

### 4.5.4 Finding the Selector position and dimensions

To find the position of the pointer and the placement of the Selector:

- Type the \texttt{TAB} key.

A window containing the current position and dimensions of the Selector, as well as the position of the mouse pointer, will be shown for about 6 seconds. You can click the \texttt{Hold} button in this window to keep the display longer, an additional 6 seconds beyond the button release. There is also another button: Keep in window. Clicking this button has the same effect as choosing the \texttt{Show Size} command from the \texttt{View} menu - see below.

Alternative method to find the position of the pointer and the placement of the Selector:

- Choose the \texttt{Show Size} command from the \texttt{View} menu.

This command displays a smaller box within the cell window, with the same information: the current position and dimensions of the Selector, as well as the position of the mouse pointer. This box will remain visible until you hide it by choosing the \texttt{Hide Size} command from the \texttt{View} menu. You can drag this box to any desired position within the cell window. To drag it, press the mouse button while the pointer is over the box, drag it to the desired position and release the button.

### 4.6 Artwork Palette

The artwork palette is used to perform operations on the layout in the active window. As described earlier, there are three artwork interaction modes and three different artwork palettes: the Paint Palette, the Subcell Operations Palette, and the Device Palette, one of which is displayed at any time. Basically, the three palettes are used to perform three groups of operations: operations on primitive objects, operations on subcells, and operations on simple devices.

The type of palette and the current interaction mode is identified by the icon at the top of the palette. By clicking this icon, you can switch the modes and the palettes in a circular manner: Paint→Subcell→Device→Paint. The Device Palette does not appear if there are no devices defined in the current technology used by Uncle.

The Artwork Palette can be moved anywhere within the limits of the active window.
To move the Artwork Palette:

- Hold down the \(\text{OPTION}\) key.
- Press the mouse button while the pointer is over the palette.
- Drag the palette to the desired place and release the button.

A gray outline of the palette will appear when you move the mouse. When you release the mouse button, the palette will move to the position indicated by the gray rectangle. If you drag the pointer out of the window, the gray rectangle will disappear and releasing the mouse button at this point will have no effect on the palette position.

All operations that are controlled by the artwork palette are performed only if the mouse button is released in the same control in which the button was pressed down. If you unintentionally press the button in a control, you can drag the pointer out of the control and no action will occur. The pressed controls are highlighted to provide a visual confirmation of activation.

### 4.6.1 Paint Palette

The example Paint Palette is shown to the right. The appearance of the lower part of the palette depends on the technology currently used; the patterns displayed there are the patterns representing different layers in the given technology, arranged in two vertical columns for complementary operations: painting/erasing and setting visibility/invisibility. On color Macintoshes you will see colors assigned to layers instead of patterns. The appearances of the icon on the top of the palette, the four ‘extend’ controls, and the operation identifiers are technology–independent. The operation identifiers may appear as shown (for painting/erasing modes) or as \(\text{visibility modes}\).

Only those layers used in the given technology are displayed in the paint palette that are used most frequently, called palette layers or simple layers. The layers not displayed are called pop–up layers or composite layers and usually can be obtained as superpositions of simple layers. For example, in the nmos technology, there are thirteen possible layers, but only seven of them are displayed in the palette: diffusion, polysilicon, metal, contact, implantation, buried contact, and overglass. The six layers that are not displayed are contact to diffusion (obtained by painting diffusion and then contact), contact to polysilicon (polysilicon and contact), transistor (diffusion and polysilicon), depletion transistor (diffusion, polysilicon, and implantation), poly–diff buried (diffusion, polysilicon, and buried contact), and implanted diffusion (diffusion and implantation).

Whenever the mouse is pressed in a layer control, the control is highlighted by filling the entire area of the control with the layer pattern. At the same time, the name of the layer appears next to the control and stays on the screen as long as the mouse button is pressed down. An example of the appearance of the palette while the mouse is held down in one of the layer controls is shown here.

The results of clicking the layer and operation controls depend on the mode selected on the View/Mode Palette and are described in the three following sections. If one of the \(\text{Selector Paint Mode}\), \(\text{Immediate Paint Mode}\), or \(\text{Paint Visibility Mode}\) controls is highlighted on the View/Mode Palette, then the Selector Paint Mode is in effect. If the \(\text{Selector Paint Mode}\) control is highlighted, the Immediate Paint Mode is in effect. Finally, if the \(\text{Paint Visibility Mode}\) control is highlighted, the Paint Visibility Mode is in effect.

### 4.6.1.1 Operation of the Paint Palette in the Selector Paint Mode

In the Selector Paint Mode you can paint or erase the layers by first positioning the Selector in the desired place and then clicking a layer control.

To enter the Selector Paint Mode:

- Click one of the \(\text{Selector Paint Mode}\), \(\text{Immediate Paint Mode}\), \(\text{Paint Visibility Mode}\), or \(\text{Selector Paint Mode}\) controls on the View/Mode Palette.
In the Selector Paint Mode one of the Selector positioning controls is highlighted on the View/Mode Palette.

If you click a layer control in the left column, the area bounded by the Selector will be painted with the layer whose pattern is displayed in the control. If a layer in the right column is clicked, the corresponding layer will be erased from the Selector area. When painting or erasing, you should not press any modifier keys on the keyboard.

The Operation Identifiers above each column symbolize the meaning of each column: there is a pencil (Paint Control), over the left column, and an eraser (Erase Control), over the right column. These identifiers also act as controls. Their main purpose is to enable you to paint composite layers with one click of the mouse without having to remember how to obtain composite layers from simple layers. When the mouse button is pressed in the Paint Control and held down for about half a second, a pop–up menu appears that lists all composite layers available in the current technology. A layer name can be selected from this menu to paint the Selector area. Pressing the mouse in the eraser produces analogous results, except that the selected layer is erased from the Selector. If the mouse is dragged outside the pop–up menu and the button released while no menu selection is highlighted, no action will occur. An example appearance of a pop–up layer menu is shown in the adjacent figure.

The four arrow–like controls in the upper part of the palette just below the palette identifier icon are used for operations called ‘extend’. ‘Extend’ consists of sampling the layers under the appropriate side of the Selector and painting them across the Selector’s width or height. Clicking the ‘extend up’ control, samples all layers intersecting the bottom side of the Selector and extends them upwards, as shown in the adjacent figure. Similarly, the remaining three controls, , , and are used for ‘extend down’, ‘extend to the right’, and ‘extend to the left’, respectively. Operation ‘extend’ can be used to draw buses of interconnections and for similar purposes.

4.6.1.2 Operation of the Paint Palette in the Immediate Paint Mode

The Immediate Paint Mode is implemented in Uncle for those users who find the operation of painting rectangles in graphic editors such as MacPaint more natural than the operation described in the Selector Paint Mode chapter. The sequence of activities required to add or remove layers in the Immediate Paint Mode is inverted with respect to the Selector Paint Mode: you first click the layer you want to paint/erase with and then position the Selector over the desired area.

To enter the Immediate Paint Mode:

- Click the control on the View/Mode Palette.

In the Immediate Paint Mode, the control is highlighted on the View/Mode Palette as shown here: . The area of the Selector is painted or erased immediately after positioning the Selector with the mouse. The highlighting of the Paint Palette determines what will occur after positioning the Selector with the mouse. If no layers are highlighted on the Paint Palette, no action will occur when the Selector is positioned.

Clicking a layer control in the left column of the Paint Palette selects this layer for painting; clicking a layer in the right column selects it for erasing. The clicked layer control becomes highlighted to signify that this layer will be used from now on, and the operation identifier above the clicked layer also becomes highlighted, indicating the current operation in effect. The highlighting of any layer control can be toggled on and off by clicking the control while holding the key down; this enables you to paint or erase several layers simultaneously.
Clicking the paint control, 
, while the eraser control, 
, is highlighted switches the indicator highlighting, provided that some layer is already highlighted underneath the pencil. From then on, painting with the selected layers is in effect. Similarly, clicking 
 switches on erasure of the layers highlighted underneath the eraser.

In the Immediate Paint Mode, the Selector can be positioned with the keyboard or with the mouse. Positioning the Selector with the keyboard does not affect the layout.

Pressing the mouse button in a control indicator and holding it down displays a pop–up menu enabling you to select a composite layer that is to be used for painting or erasing, just as described in the previous chapter. If a composite layer has been selected in the pop–up menu, the controls of the layers comprising this layer will be highlighted.

Uncle remembers the layers selected for painting and erasing as long as it is in the Immediate Paint Mode.

You can toggle on and off the highlighting of a layer control by clicking the control while holding the \texttt{SHIFT} key down; the Selector area is neither painted nor erased in this case.

Generally, clicking an operation indicator paints or erases from the Selector all the simple layers that are highlighted underneath the clicked indicator. The manner in which the highlighting was obtained is important. If, for example, the controls for polysilicon and diffusion are highlighted as a consequence of selecting the transistor layer from the pop–up menu, the Selector is operated upon with the transistor layer. On the other hand, if the highlighting was obtained by \texttt{SHIFT}–clicking the polysilicon and diffusion controls, the Selector is operated upon with these two layers in sequence. The results of these two operations may be different: e.g., if transistor layer is erased from the Selector, the diffusion and polysilicon will be left wherever they did not form transistors, while erasing diffusion and polysilicon will affect not only the transistors, but also pure polysilicon and diffusion areas, as well as contacts.

4.6.1.3 Operation of the Paint Palette in the Paint Visibility Mode

You can decide at will which layers should be displayed in any layout window. This feature can be useful for looking at design rule violations between some specified layers, which is much easier if only the layers in question are displayed. Normally, all layers are visible. If a layer is made invisible, it will not be shown in the active window until it is turned visible again. Invisible layers cannot be modified. They will not be shown on the Paint Palette in either Selector Paint Mode or Immediate Paint Mode, and they will be inactive in all menus or lists containing layer names in Cell Edit Mode.

To enter the Paint Visibility Mode:

- Click the \texttt{Visibility} control on the View/Mode Palette.

In the Paint Visibility Mode, the Paint and Erase Controls on the Paint Palette are changed into open and closed eye controls as shown here. From here on in this chapter, all references to the \texttt{Visibility} control mean the control in the Paint Palette, not in the View/Mode Palette. The layer controls in the Paint Palette can be used to switch on or off visibility of layers. In the Paint Visibility Mode, the Selector disappears, and the pointer assumes an eye shape, 
, over the layout area. Clicks in the layout area cause only short warning beeps.

Clicking a layer shown under the \texttt{Visibility} control will make the clicked layer visible; therefore, the controls of invisible layers are positioned under this control.

Analogously, clicking a layer shown under the \texttt{Visibility} control will make the clicked layer invisible: the controls of visible layers are positioned under this control.

If no modifier keys are held down while clicking a layer control, making a layer visible or invisible is effective immediately after clicking the control, and the image in the window is refreshed. If you want to make several layers simultaneously visible or invisible without waiting for the refresh after clicking each layer, you may select the desired layers in the
Paint Palette by clicking them while holding the \texttt{SHIFT} key down. Clicking the \texttt{U} or \texttt{I} control will make all layers highlighted under the clicked control respectively visible or invisible, and the window will be refreshed only once. Clicking \texttt{U} or \texttt{I} while holding down the \texttt{SHIFT} key will affect all highlighted layers under both visibility controls.

Pressing the mouse button in a control indicator and holding it down displays a pop–up menu enabling you to select a composite layer that is to be made visible or invisible.

4.6.2 Subcell Operations Palette

The Subcell Operations Palette, shown here, is used for a variety of tasks concerned with editing subcell instances in the active window. The operations available on this palette include inserting subcells, applying transformations to subcells, making arrays of subcells, and changing the visibility of subcells. There is a special control for each of these tasks.

In the Subcell Operations Mode, the View/Mode Palette appears as \texttt{[ ]}. The \texttt{U} and \texttt{I} controls are not active in the Subcell Operations Mode.

All the transformation controls, lock, unlock, expand, and unexpand controls are used to switch on some particular mode of interaction with subcells. Each mode is signified by highlighting the appropriate control and by changing the pointer into a shape characteristic for that mode. If the \texttt{U} control is highlighted, the Basic Subcell Operations Mode, called Basic Mode for short, is in effect, and the pointer becomes a standard crosshair, \texttt{+}. The Basic Mode is used for positioning the cursor with the mouse, selecting subcells, and moving subcells.

Remark: There are operations on subcells which cannot be invoked from the palette. See chapter 4.12.5 (Operations menu) for their description.

To enter the Basic Mode:

- Click the \texttt{U} control.

To position the Selector in the Basic Mode:

- Click and drag the mouse as described in chapter 4.5. It is important that you start dragging the mouse immediately after depressing the button; see the Selecting a subcell section.

All Selector positioning modes defined in the View/Mode Palette in the bottom scroll bar are available in the Subcell Operations Mode.

4.6.2.1 Inserting and removing subcells

To insert a subcell into the active cell:

- Place the Selector so that its upper left corner coincides with the desired upper left corner of the subcell instance.

- Choose the \texttt{Add Subcell...} command from the Edit menu.

A dialog box for selecting the subcell to be inserted will appear. Remember that all the subcells must be stored in the same folder as the active cell.

After selecting the subcell another dialog box will appear. It will allow to name the instance of the subcell and to determine its position and orientation.

Alternative method that can be used instead of choosing the \texttt{Add Subcell...} command.

- Type the \texttt{SU} key.

Possible messages:

Uncle will not allow insertion of a subcell that contains the active cell directly (as its subcell) or indirectly (as a subcell of one of its subcells, etc.) if you select such a cell for
insertion into the active cell, an alert will be shown and the subcell selection dialog will reappear.

To remove a subcell:
- Select the desired subcell as described in chapter 4.6.2.3.
- Type the DELETE or BACKSPACE key.

Alternative method of removing a subcell:
- Select the desired subcell as described in chapter 4.6.2.3.
- Choose either the Cut Subcells or the Clear Subcells command from the Edit menu.

Remark: These commands work as in all other Macintosh applications, i.e. the Cut Subcells command places the subcell in the clipboard, and the Clear Subcells command removes it permanently.

4.6.2.2 Subcell appearance in the layout window

The appearance of a subcell varies depending on the subcell attributes. First of all, a subcell may be expanded or unexpanded. The internal details of expanded cells are visible, while the details of unexpanded subcells are not. Any newly inserted subcell is initially unexpanded. Example unexpanded and expanded subcells are shown below.

![Subcell Appearance Examples](image)

The “locked” and “selected” attributes are explained later in this chapter.

An unexpanded subcell is shown as a rectangle coinciding with the subcell’s bounding box, with some information displayed in the rectangle. The subcell name and the instance name are displayed approximately half-way between the top and bottom of the cell outline, close to its left side. Instance names, displayed in quotation marks underneath the subcell names, can be used to distinguish instances of the same cell that appears more than once as a subcell of another cell. In the upper left corner there is a small symbol representing the orientation of the subcell. This symbol consists of two axes and a number in the range 0 to 7. The longer axis shows the direction of the horizontal axis from the subcell’s own coordinate system, and the shorter axis indicates the direction of the subcell’s vertical axis. The number is an identifier of the particular orientation. Two possible orientations were shown earlier; the remaining six of the eight possible orientations are shown below.

![Possible Orientations](image)

Another subcell attribute is the selection flag. Of all subcells contained in the active cell, one or more subcells may be selected and all the others are deselected. A newly inserted subcell becomes automatically selected. A selected subcell is displayed with a heavy outline around it.

Yet another attribute of a subcell is the lock flag. A locked subcell cannot be moved or transformed. All newly inserted subcells are initially unlocked, i.e., they can be freely moved in the active cell, transformed, or arrayed. In locked, unexpanded subcells, a small padlock symbol is displayed to the right of the orientation symbol. The lock status has no effect on the appearance of expanded subcells.

Several subcells may be grouped. A group of subcells is treated as a single object in most editing operations such as movement, transformations etc. Cells that belong to a group are displayed with a group symbol near the upper left edge of the cell outline.
4.6.2.3 Selecting a subcell

As mentioned earlier, of all subcells contained in the active cell, one or more subcells may be selected at any time. Usually, a subcell is selected in order to perform an operation on it. Depending on whether it is possible to position the pointer so that it is within the bounding box of only the desired cell, use one of the following procedures:

To select a subcell that is not fully overlapped by other subcells:
- Enter the Basic Mode.
- Position the pointer so that it is within the subcell’s bounding box and not within other subcells.
- Click the mouse button. Make sure to release the button immediately after depressing it.

Any previously selected subcell will be deselected, and the clicked cell will be selected. A selected cell is displayed with a heavy outline. This outline is displayed whether or not the cell is expanded. If the selected cell belongs to a group, all cells in this group will become selected.

To select one of several overlapping subcells:
- Enter the Basic Mode.
- Position the pointer so that it is within the subcell’s bounding box.
- Do not move the mouse and keep clicking the button until the desired subcell becomes selected. The clicks should not be repeated too fast, or they will be interpreted as double clicks with the effect described in chapter 4.6.2.6.

Possible problem:
If the mouse is moved but the pointer remains over the selected subcell, nothing will happen.

Subcells visible in other expanded subcells can also be selected; this is done in the same manner as selecting overlapping subcells. Whenever a subcell inside another subcell is selected, some controls in the Subcell Operations Palette become inactive, so that you cannot apply transformations to it, and the Subcell Operation palette in such circumstances appears as shown here.

To select a subcell using the menu:
- Position the Selector in such a way that the subcell to be selected is entirely within it.
- Choose the Select Subcells command from the Edit menu.

Remark: In this way you can select a subcell also in the modes other than the Subcell Operations Mode.

To select a subcell without deselecting other subcells:
- Enter the Basic Mode.
- Position the pointer so that it is within the subcell’s bounding box and not within other subcells.
- Click the mouse button while holding down the SHIFIT key. Make sure to release the button immediately after depressing it.

The subcell will be selected. The other subcells selected previously will remain selected.

To select more than one subcell at a time:
- Position the Selector in such a way that all the subcells to be selected are entirely within it.
- Choose the Select Subcells command from the Edit menu.

Alternative method of simultaneous selection of more than one subcell:
- Position the Selector in such a way that all the subcells to be selected are at least partially overlapped by the Selector.
- Choose the Select More Subcells command from the Edit menu.
Remark: In this way you can select subcells also in the modes other than the Subcell Operations Mode.

To select all subcells:

- Choose the Select All Subcells command from the Edit menu.

Remark: In this way you can select subcells also in the modes other than the Subcell Operations Mode.

To select one or more subcells together with artwork:

- Select the subcells in any of the ways described above.
- Enter the Selector Paint Mode by clicking the icon at the top of the Artwork Palette.
- Position the Selector in such a way that the desired portion of the artwork is inside it.

Remark: Some operations such as copying to clipboard, cutting, and moving may be performed on a portion of cell artwork and the selected subcells simultaneously.

To select the entire contents of the cell:

- Choose the Select All command from the Edit menu.

Remark: This command can also be used in modes other than the Subcell Operations Mode.

All objects in the active cell, i.e. the artwork, subcells and labels, will be selected. This can be useful e.g. for copying the entire contents of a cell to the clipboard in order to paste it to another cell.

4.6.2.4 Applying transformations to subcells

Subcells visible in the active window can easily be moved and transformed. The transformations that can be applied to subcells with a single click are translations, left and right 90° rotations, a 180° rotation, and mirroring about the horizontal and vertical axis. Modal transformations, double-click transformations, and the general transformation are several different methods of transforming subcells. In addition, you can move subcells with the arrow keys.

All transformations can be applied to single subcells, many subcells selected simultaneously and grouped subcells. There is an important difference between transformations applied to several selected subcells which are not grouped and to a group of subcells. A transformation applied to several selected subcells which are not grouped is performed on each of the selected subcells independently, as if this subcell were selected alone. The same transformation applied to a group of subcells is performed on the entire group treated a single object.

4.6.2.4.1 Modal transformations

Modal transformations are applied by entering the mode appropriate for a given transformation and then clicking on the desired subcell or group. In each transformation mode, the pointer assumes the form indicative of the operation to be performed. Translations are performed in the Basic Mode.

To enter the left or right rotation mode:

- Click the \[\text{left rotation}\] or \[\text{right rotation}\] control, respectively.

To enter the 180° rotation mode:

- Click the \[\text{180° rotation}\] control.

To enter the horizontal or vertical mirror mode:

- Click the \[\text{horizontal mirror}\] or \[\text{vertical mirror}\] control, respectively.
To move a subcell or a group:
- Enter the Basic Mode.
- Position the pointer so that it is within the subcell’s bounding box and not within other subcells.
- Depress the mouse button and hold it down for about half a second, until the pointer changes into a hand, \( \text{Hand} \), and a gray rectangle outlining the cell’s bounding box (or the bounding box of the entire group) appears.
- Without releasing the button, drag the mouse until the gray rectangle assumes the desired position.
- Release the mouse button.

When the button is released, the cell (or group) will move into the position indicated by the gray rectangle and become selected. Any previously selected cells are deselected.

Possible problems:
The procedure described above may be difficult to apply if the cell you want to move is overlapped by others. If you cannot position the pointer in the area free of overlaps, first select the desired subcell as described earlier. Move the pointer from its current position, but make sure that it remains within the bounding box of the selected subcell. Now you can depress the mouse button and proceed in the manner described above.

Alternative method of moving a subcell or group:
- Select the subcell or group using any of the methods described above.
- Choose the **Move...** command from the **Edit** menu.

A dialog will appear which will allow to determine new position of the upper left corner of the bounding box of the selected subcell or group.

Remark: The dialog allows to change the orientation and instance name as well.

To transform a subcell or a group:
- Enter the appropriate transformation mode.
- Place the pointer over the subcell 1 (or one of the grouped subcells) in the area free of overlaps with other subcells.
- Click the mouse button once.

Possible messages:
If you click the mouse while the pointer is not over any subcell, or if the subcell it is over is locked, no transformation will be applied and a beep will sound to notify you of this.

Modal transformations are useful if the same transformation is to be applied to several cells. All rotations and mirrorings preserve the position of the upper left corner of the subcell’s bounding box or the group bounding box.

### 4.6.2.4.2 Double–click Transformations

Double–click transformations can be performed without leaving the current subcell interaction mode. You can apply any transformation without ever leaving the Basic Mode.

If there is no cell currently selected, the transformation will be applied to the layout enclosed by the Selector.

To apply a double–click transformation:
- Select the desired subcell.
- Double–click one of the  or \( \text{controls}, depending on which transformation you want to apply.

Alternative method:
- Select the desired transformation from the **Operations** menu.

---

1) More exactly, the hot spot of the cursor should be placed over the subcell. For the regular cross-shaped cursor the hot spot is placed in the middle of the cross. For the rotation cursors, the hot spot is the point representing the rotation axis, and for the mirror cursors the hot spot is the middle of the cursor.
4.6.2.4.3 Moving subcells by using arrow keys on the keyboard

In any of the Subcell Operations Modes, the selected subcell can be repositioned with the arrow keys on the keyboard.

To move a selected subcell or group:
- Depress the CAPS LOCK key.
- Use arrow keys as described for moving the Selector.

The selected subcell is moved as if its bounding box is the Selector. All the modifier keys, excepted, affect the movement in the same way as when they are used for moving the Selector. The position of the SHIFT key is irrelevant.

4.6.2.4.4 General subcell transformation

The general subcell transformation is the slowest and most general method for transforming a subcell. It causes a dialog to appear that can be used to set both the position and the orientation of the subcell, as well as its instance name. This dialog box is shown to the right.

To apply the general subcell transformation:
- Select the desired subcell.
- Double click the control.

The initial contents of the general transformation dialog depict the current subcell position, orientation, and instance name. The position and instance name can be changed by typing them in the appropriate text–edit boxes, and the orientation, by clicking a button under the desired orientation’s symbol. There are three other buttons: the OK button confirms the new settings, the Cancel button disposes the dialog without making changes, the Revert button restores the initial contents of the dialog.

4.6.2.5 Locking and unlocking subcells

Locking and unlocking subcells is done in a manner similar to applying transformations. The Lock and Unlock Modes can set or reset the ‘lock’ attribute in several subcells simultaneously. You can also set or reset this attribute by double–clicking the appropriate control in the Subcell Operations Palette.

To lock a subcell:
- Select the desired subcell and double–click the control.

Alternative method:
- Enter the Lock Mode by clicking the control: the pointer will change into .
- Position the pointer over the subcell, in an area not overlapped by other subcells.
- Click the mouse button once.

Recall that a locked subcell cannot be moved or transformed, nor may its array parameters be changed; in particular, a single subcell cannot be made into an array.

If any of the subcells that belong to a group is locked, the entire group is treated as locked, i.e. it cannot be moved or transformed.

To unlock a subcell:
- Select the desired subcell and double–click the control.

Alternative method:
- Enter the Unlock Mode by clicking the control: the pointer will change into .
- Position the pointer over the subcell, in the area not overlapped by other subcells.
- Click the mouse button once.

Remark: The hot spot of the and pointers is the middle of the keyhole.
Alternative way to set subcells’ ‘lock’ attribute:
- Select the desired subcell.
- Choose the **Lock** or **Unlock** command from the **Operations** menu.

**4.6.2.6 Expanding and unexpanding subcells**

Expanding and unexpanding can be done in a similar manner to locking and unlocking subcells by using the Subcell Operations Palette, or by using commands from the **Operations** menu.

To expand a subcell:
- Select the desired subcell and double-click the control.

Alternative method:
- Position the selector so that it forms a rectangle intersecting the cell you want to expand.
- Select the **Expand One Level** command from the **View** menu.

Another alternative method:
- Enter the Expand Mode by clicking the control.
- Position the pointer over the subcell, in the area not overlapped by other subcells.
- Click the mouse button once.

To unexpand a subcell:
- Select the desired subcell and double-click the control.

Alternative method:
- Position the Selector so that it forms a rectangle intersecting the cell you want to expand.
- Hold down the **OPTION** key.
- Select the **Unexpand One Level** command from the **View** menu.

Another alternative method:
- Enter the Unexpand Mode by clicking the control.
- Position the pointer over the subcell, in the area not overlapped by other subcells.
- Click the mouse button once.

Remark: The hot spots of the and pointers are the tips of the arrows.

One more alternative way to set subcells’ ‘expand’ attribute:
- Select the desired subcell.
- Choose the **Expand Selected** or **Unexpand Selected** commands from the **View** menu.

Yet another way to expand subcells:
- Enter the Basic Mode.
- Select the desired subcell.
- Double-click the selected subcell in an area free from overlaps with other subcells. If such an area is not available, move the pointer but make sure that it stays within the bounding box of the selected subcell and then double-click.

Remark 1: Moving the pointer is necessary, as, otherwise, the first click of the double-click would select the next eligible subcell, and the second click would expand the newly selected subcell.

Remark 2: The ultimate expansion of a subcell is to open a window in which the cell can be edited. If an expanded cell is double-clicked, it will be opened for editing in a separate window.

**4.6.2.7 Peeking at subcells**

Occasionally it may be found useful to look at the contents of a subcell without expanding it. Redrawing expanded cells is one of the factors that can slow down refreshing the layout.
window after a scroll or zoom; therefore, it is useful to have as few expanded subcells as possible.

To peek at subcells:
- Position the Selector over the area you want to look at.
- Click the \(\text{keyhole}\) control in the Subcell Operations Palette.

Alternative method to peek at subcells:
- Position the Selector over the area you want to look at.
- Choose the **Peek** command from the **View** menu.

Clicking the keyhole control or selecting the **Peek** command shows the entire contents of the area bounded by the Selector. All subcells intersecting the Selector are expanded temporarily, and so are their subcells. Until the next refresh of the expanded area, the layout remains visible. Note, however, that the expanded area will not be refreshed if it is scrolled out of the window and back in.

### 4.6.2.8 Operations on Arrays

All operations described so far are applicable to arrays. Moving or transforming the array takes the array’s bounding box and uses it as if it was a bounding box of a single cell. In particular, rotating an array rotates it as a whole. Expanding an array will expand all subcell images. In a locked array, the padlock symbol is displayed in every subcell image.

There are two additional operations that may be of value: transforming all array components and changing the array parameters.

To transform all array components:
- Hold down the **SHIFT** key while applying the transformation to the array.

To change the array parameters:
- Select the desired array of subcells.
- Double-click the \(\text{keyhole}\) control.

Transforming arrays preserves the abutment of the array elements. Holding the **SHIFT** key down while selecting the array orientation in the dialog shown after double-clicking the \(\text{keyhole}\) control will rotate only the array elements while preserving the abutment.

### 4.6.2.9 Grouping and Ungrouping Subcells

Subcells can be grouped in order to preserve their relative positions and orientations during transformations. A group of subcells is treated as a single rectangular object. The bounding box of a group is the smallest rectangle which encloses completely all the cells that belong to this group. Unexpanded subcells that belong to a group are displayed with a group icon near the upper left edge of the cell outline.

The maximum number of groups of subcells in an active cell is limited to 255. In Uncle groups do not nest, i.e. if a new group is made of two or more existing groups, the subcells in the existing groups are ungrouped and then a new group which includes all of them is created. In other words, there is no hierarchy of groups.

If one of the cells belonging to a group is selected, all the remaining cells in this group also become selected.

To make a group of subcells:
- Select all the subcells that are to be grouped.
- Click the group control \(\text{keyhole}\).

Alternative method of grouping:
- Select all the subcells that are to be grouped.
- Choose the **Group** command from the **Operations** menu.
To ungroup a group:
- Select any of the subcells that are to be ungrouped.
- Click the ungroup control ✖.

Alternative method of ungrouping:
- Select any of the subcells that are to be ungrouped.
- Choose the Ungroup command from the Operations menu.

4.6.2.10 Microscope mode

The microscope control 🕵️ is used to switch on and off a special “microscope” mode of operation. In this mode a portion of the cell layout is temporarily enlarged in order to facilitate editing operations, e.g. to connect metal paths to terminals of a subcell. When the microscope mode is terminated, the previous window scale is restored.

To enter the microscope mode:
- Click the microscope control 🕵️.

Alternative method:
- Choose the Microscope command from the View menu.

In the microscope mode the microscope control is highlighted and the Microscope command is checked.

To enlarge a portion of the layout in the microscope mode:
- Using the mouse position the Selector over the desired area. Immediately after the mouse button is released, the portion of the layout inside the Selector rectangle is enlarged and fills the cell window.

Possible problems:
To position the Selector over the area to be enlarged, mouse must be used. Other methods of Selector positioning change the Selector without affecting current window scale.

After enlarging all editing operations are possible and can be performed in the usual way.

To quit the microscope mode:
- Click the microscope control 🕵️.

Alternative method:
- Choose the Microscope command from the View menu.

The previous cell view (i.e. window scale and position of the cell in the window) will be restored.

4.6.3 Device Palette

The symbolic layout input capabilities of Uncle currently include simple devices. A simple device is any arrangement of layout features that can be described with at most two parameters, width and height. Device definitions are parts of each Uncle technology definition. For example, in n-scmos technology, two devices are available: n–channel transistors and p–channel transistors. In nmos technology there are three devices: enhancement–mode transistors, depletion–mode transistors, and depletion–mode transistors with buried gate–to–source contacts.
Simple devices are drawn in the Device Mode, which can be entered by clicking the Artwork Palette identifier icon until the Device Palette appears. An example Device Palette is shown here for nMOS technology.

The number and appearance of the icons displayed below the Palette Identifier depend on the technology. Each icon might contain an abbreviated name of the device it represents. The highlighted icon indicates the type of device selected for drawing.

To enter some particular device input mode:

- Click the icon representing the desired device type.

Drawing a device is based on the parameters of width and height of a rectangle called the device outline. Dimensions of all components of the device are calculated based on the device outline and then entered automatically into the layout. One of the corners of the device outline is the device origin: the opposite corner is the device destination.

To draw a simple device:

- Depress the mouse button at the desired device origin.
- Hold the mouse button down and drag the mouse until the device outline reaches the desired device destination.
- Release the button.

Immediately after the mouse button is depressed, a device outline appears in the form of a gray rectangle, one of whose corners is at the device origin. The pointer splits into a small circle attached to the device origin and a cross, just as in the Unconstrained Selector Positioning Mode. The dimensions of the device outline change while the mouse is dragged. Generally, the device destination tends to follow the cross pointer. However, the minimal and maximal dimensions of the device outline are part of each device definition. Thus, the dimensions of the outline are subject to constraints, and it is possible that the pointer may not coincide with any corner of the device outline.

The figure to the right shows the process of drawing a p–channel n-scalcmos transistor, called P–TRAN on the device palette. The device outline of the P–TRAN device is simply the area of the transistor channel. The channel length of most such transistors in n-scalcmos technology should be the minimal possible distance allowed by the design rules. Since the channel length is constant, one of the device outline dimensions is constrained to have its minimum and maximum dimensions both equal to the transistor channel length. You need only to input the transistor width by dragging the mouse. The device outline will appear as a gray rectangle with one constant and one variable dimension. After the mouse button is released, Uncle calculates the appropriate overlaps of diffusion and polysilicon over the channel area and draws the transistor as shown.

Simple devices usually have two possible orientations, e.g., the channel width of a transistor can be oriented horizontally or vertically. The orientation of a device transistor is inferred from the position of the pointer relative to the device origin. If a line that can be drawn between the device origin and the pointer is at a 45° or smaller angle to the vertical axis, the device will vertical; otherwise, it will be horizontal. As a result, the device outline may jump between horizontal and vertical orientation with a small change in the pointer position. This effect is observed only when the pointer position is close to a 45° line from the origin, as shown in the subsequent figures.

---

1 The device palette will not be shown if there are no devices defined in the current technology; in such a case, clicking the Palette Identifier icon will switch between the Paint Palette and the Subcell Operations Palette.
a) the origin–pointer line is more vertical than horizontal
b) the origin–pointer line is more horizontal than vertical
c) overlay of both situations

Some care should be exercised when drawing devices whose outline is square, since then the orientation of the device does not show as distinctly. Only the pointer position can be used as the indicator of the device orientation in these situations; see the figure to the right.

After the mouse has been depressed in the device input mode you can still decide not to draw any devices; to cancel the device input you have to move the pointer back over the device origin so that the device outline disappears. If the mouse button is released at this point, no device will be drawn.

4.7 Labels

Labels have various applications in VLSI layout editing. Most frequently, they are used to give names to electrical nodes so that they can be identified for simulations. Labels can also identify points (or areas) on the layout that should be connected; information about the positions of labels can then be used by programs for automatic routing. Finally, labels can serve as comments and auxiliary texts that improve layout readability.

4.7.1 Entering labels

In Uncle, labels are associated with rectangular areas, line segments or points, called label areas. All ASCII characters, except for control characters, can be used in labels. In particular, labels cannot contain newline characters, tabs and carriage returns.

To insert a label:
- Define the label area by placing the Selector in the desired position.
- Type the label text.
- Set the label attributes using the dialog box that will appear.

Alternative method:
- Define the label area by placing the Selector in the desired position.
- Choose the Add Label... command from the Artwork menu or type \L.
- Set the label attributes using the dialog box that will appear.

The label will be associated with the rectangle bounded by the Selector. After the first character is typed or the Add Label... command is invoked, a dialog box will be shown. This dialog box is used to determine the remainder of label's text and attributes. It is not necessary to wait until the dialog box appears to type consecutive characters; if you are a fast typist, you will find that several characters can be typed before the dialog is fully drawn. The label dialog is shown to the right.

Labels can have any combination of the three visibility attributes. Two of these, enclosed in the Label shown in box, control the way that the label will appear if the active cell is referenced as a subcell of another cell. You can request that labels be shown in either
expanded subcells or unexpanded subcells by checking the appropriate box. If both boxes are checked, the label will always show; if neither of the boxes is checked, the label will show only in the window used to edit the active cell.

The label rectangles can be made invisible by checking the only label text visible attribute; otherwise, the label rectangle will always be shown.

The label dialog contains five text–edit boxes. Immediately after the dialog is activated, the Label text box is active, with the insertion point placed at the end of the text typed so far. The other four boxes contain the coordinates of the Selector. By changing the values of the coordinates, you can define the label area independently of the Selector position. The values of the coordinates must belong to the range of dimensions supported by Uncle, i.e., they should be integers from −32760 to +32760. Values outside this range will be rejected; if you type too large or too small a number, the most recent valid values will reappear. Only digits and the minus sign are accepted in the coordinate boxes; attempts to type other characters will produce warning beeps. Moreover, the dimensions of the label box must be non-negative, i.e., the right coordinate must be equal to or larger than the right coordinate etc.

The text–edit boxes accept the standard mouse–driven operations: changing the insertion point, selecting, and replacing the selections with typed characters.

There are four more controls in the label dialog that can be used to determine label attributes. Three of them are used to define the position of the label with respect to the label area. The label can be put inside or outside the area by clicking one of the two buttons labelled inside and outside. If the label area is a segment or a point, the outside position is obligatory. The third control for defining the position of the label is the Position: pop–up menu, activated by clicking the mouse in the box to the right of the menu name. The figure to the right shows a sample appearance of this menu.

By selecting the appropriate item from the position menu, labels can be placed with respect to the label area in eight possible ways, as shown to the right for the case of labels outside the label area.

The fourth control for setting label attributes is the Attach: pop–up menu used to select the layer to which the label is to be attached. This control is activated by pressing the mouse in the box to the right of the menu name, as shown here.

Currently, only labels associated with points can be attached to layers. This enables you to label electrical nodes in the circuit; these labels will carry the node names to the node extractor programs that are able to read the output formats produced by Uncle. Labels associated with segments or rectangles cannot be attached to layers in Uncle 1.8.

The layer menu will contain only the names of the layers that can have labels attached to them; this property of layers is part of any Uncle technology definition. Only the layers present at the point associated with the label appear in the menu. The first item of the layer menu, none, can be selected to specify that the label should not be attached to any layer. Changing the label area by entering numbers in the coordinate boxes will produce appropriate changes in the layer menu. If the label area is not a point or if there are no layers at the associated point that can be labelled, the Attach: menu is inactive.

4.7.2 Selecting labels

Once a label is entered, it can be selected for editing operations. Labels entered in the layout can be moved, deleted or changed by mouse or keyboard operations.

Labels are selected by either enclosing them by the Selector rectangle or by placing the Selector (which can be either a rectangle or a single point) in the vicinity of the label.
4.7.3 Manipulating labels

4.7.3.1 Deleting labels

To delete a label:
- Place the Selector in the vicinity of the label text.
- Type the DELETE or BACKSPACE key.

Alternative method:
- Place the Selector in the vicinity of the label text.
- Choose the Delete Label command from the Artwork menu.

All labels whose text is within a half $\lambda$ of the Selector will be deleted. Therefore, it is safest to make the Selector a point, placed somewhere on the label text. Due to the $1/2 \lambda$ extension, any label can be deleted in any viewing magnification, even if the pointer cannot be placed on the label text.

If the Selector intersects the label area but is farther than $1/2 \lambda$ from the label text, the label will not be deleted. The areas associated with labels are disregarded in this and in all the following operations.

Labels can also be deleted as a result of the Cut or Clear operations invoked from the menu. All labels that are enclosed by the Selector rectangle are affected when these operations are performed.

4.7.3.2 Moving labels

Moving labels is similar to moving subcells.

To move a label:
- If necessary, enter the Paint Mode by clicking the Artwork Palette identifier.
- Depress the mouse button while the pointer is on the text label (within a $1/2 \lambda$ range).
- Hold the button down until the pointer changes into a hand.
- Without releasing the button, drag the mouse until the label assumes the desired position.
- Release the mouse button.

Together with the change of the pointer into a hand, the bounding box of the label text and the label area will both appear drawn in dotted lines. When the mouse is dragged, the dotted outlines will move together with the hand pointer. Moving labels, similar to moving subcells, does not affect the Selector position or size.

Possible problems:
- If there is more than one label in the vicinity of the pointer, there is no way to predict which label will be picked.

Remark: the length of the delay used for selecting a label is identical to the time delay used to distinguish double and single clicks and can be changed via the Control Panel.

4.7.3.3 Editing labels

By editing labels, you can change all label properties. The same dialog is used for entering new labels and changing old labels.

To edit a label:
- Place the Selector within the $1/2 \lambda$ distance from the label.
- Choose the Edit Label... command from the Artwork menu.

Alternative method:
- Double click the mouse button while the pointer is on the text label (within a $1/2 \lambda$ range).
Another alternative method:

- Place the Selector within the $1/2 \lambda$ distance from the label.
- Type the \texttt{ENTER} key.

The same dialog box as for entering new labels will appear. The layer and position controls will be set to reflect the existing label attributes, the label text will be copied into its text–edit box, and the coordinates of the associated area will be shown in their appropriate boxes. Now the label can be edited as if it was just entered.

Possible problems:

Sometimes it may happen that the layer associated with the label is erased from the label area. The name of this layer will appear dimmed in the \texttt{Attach:} pop–up menu control. If any other layer is selected in this menu, the dimmed layer will disappear from the menu.

To edit several labels:

- Position the Selector in such a way that all labels to be edited are completely enclosed by the Selector rectangle.
- Choose the \texttt{Edit Label...} command from the \texttt{Artwork} menu.

A series of dialog boxes, the same as for entering new labels, will appear for all selected labels, one at a time: after dismissing the dialog for the first label the dialog for the second one will appear etc. This is a handy shortcut if it is necessary to edit a large number of labels.

### 4.8 Types of objects and their selection revisited

As described above, there are three basic kinds of objects that can be created and manipulated in the cell windows: artwork, labels and subcells. Uncle follows the fundamental rule of all Macintosh applications: the user must select an object before performing an operation on it. There are several different ways to select objects in Uncle, and there is a variety of operations that can be performed on objects of a particular kind. Some of these operations are applicable to objects of one kind but not to other objects, e.g. painting and erasing is applicable to rectangular portions of the artwork but does not make sense for subcells and labels. Also, as described above, some of the operations can be performed in one mode but not in another. Therefore, it depends on the context (i.e. mode of operation of Uncle) whether a given object can be selected and whether a particular operation is legal for a given set of selected objects. Also, the way to select an object of a particular kind may sometimes depend on the context. Below the rules of selection are summarized.

#### 4.8.1 Selection of artwork

The basic mode in which the operations on the cell artwork are performed is the Selector Paint Mode, i.e. the mode in which the Paint Palette is displayed in the cell window. The general rule of artwork selection in this mode is as follows: everything inside the Selector rectangle is selected. In other words, the operations of painting, erasing, cutting, copying, deleting as well as transformations (rotation, flips etc.) are always applied to the entire Selector area. If the Selector is empty (i.e. it is a single point), nothing is selected.

Sometimes it may be convenient to select for cutting or copying a connected area of a layer. Such an area is called in Uncle a node. A node can be selected by choosing the \texttt{Select Node} command from the \texttt{Edit} menu. This command displays a submenu of layers on which a node can be selected (details are described later in this chapter). A selected node is displayed with a heavy black outline. Several nodes on the same layer can be selected simultaneously (this is described in detail later in this chapter). If a node (or set of nodes) is selected, it can be cut, copied or deleted using appropriate commands from the \texttt{Edit} menu. However, all painting and erasing operations are still applied to the Selector area. A node is a dynamic object. All painting and erasing operations that affect the area...
and the layer of a selected node will result in automatic update of its shape. By appropriate painting and erasing operations it is possible to split a node into two or more separate nodes or to connect several nodes and form a single one. An example of the operations of erasing and painting performed on a node selected on the polysilicon layer is shown above.

### 4.8.2 Selection of subcells

The basic mode for the selection of subcells and operations on them is the Subcell Operations Mode, i.e. the mode in which the Subcell Operations Palette is displayed in the cell window. Selection of subcells in this mode is described in detail in Section 4.6.2.3. Basically, a subcell can be selected in two ways: either by positioning the pointer over it and clicking the mouse or by enclosing it by the Selector rectangle and choosing the Select Subcells command from the Edit menu. To select several subcells, you can either keep the \text{SHIFT} key depressed while clicking on them, or use appropriate menu command from the Edit menu. There are three menu commands for the selection of subcells: Select Subcells, Select More Subcells and Select All Subcells. The first command selects only the subcells that are completely enclosed by the Selector rectangle. The second command selects also the subcells whose outlines intersect the Selector rectangle. The third command selects all subcells regardless of the size and position of the Selector.

Subcells can also be selected in the Selector Paint Mode. In this mode subcells can be selected only by choosing one of the menu commands described above, but not by clicking on them. In the Selector Paint Mode the selected subcells can be copied, cut or deleted together with a portion of the artwork or together with one or more nodes. This allows e.g. to copy a set of subcells together with all paths connecting them.

### 4.8.3 Selection of labels

Labels are selected in the same way as artwork, i.e. all labels that are enclosed by the Selector rectangle are selected. In addition, in the Selector Paint Mode single labels can be selected by placing the pointer over the label text or in its close vicinity. A single label can be selected for editing by double clicking on it. Details are described in Section 4.7.

### 4.8.4 Selection of the entire cell contents

The Select All command in the Edit menu selects everything: cell artwork, all labels and subcells. It works in all cell editing modes. Once selected, the entire contents of the cell can be copied, cut, deleted, moved or transformed.

### 4.9 View/Mode Palette

The View/Mode Palette, partially described in the chapter on Selector positioning and in the chapter on Artwork Palettes, contains three controls for changing the view shown in the layout window. These three controls are placed on the left side of the View/Mode Palette as shown here.

The Center Control, $\text{\text{\textimage}}$, centers the Selector or the cell in the layout window. The Zoom Control, $\text{\text{\text$\text{\textimage}$}}$, enlarges or decreases the scale of the drawing. The Zoom Selector Control, $\text{\text{\text$\text{\textimage}$}}$, is used to adjust the scale of the drawing so that the Selector or the cell fits in the window.

Remark: The operations described below can also be performed by choosing appropriate menu commands from the View menu.

To center the Selector in the window:
- Click the Center Control, $\text{\text{\textimage}}$. 

56
Remark: This operation does not change the window scale.

To center the cell in the window:

- Hold down the OPTION key and click the Center Control.  

The window is centered by being scrolled horizontally and vertically. After the scroll, the center of the cell’s bounding box is aligned with the center of the window to within eight pixels. The scale of the drawing remains unchanged.

To increase the magnification in the window:

- Click the Zoom Control,  

To decrease the window magnification:

- Hold down the COMMAND key and click the Zoom Control, which assumes this appearance:  

In either operation, the λ size seen on the screen changes by a factor of approximately 1.7. The center of the window remains in its previous position. As a result of increasing the magnification, less layout area is shown, but in greater detail. After clicking the control, more area is shown, but the details become less visible.

Possible problems:

The drawing scale may be enlarged to at most 63 pixels per 1 λ. Trying to enlarge the magnification further will produce no results.

To zoom the window so that a desired part of the layout is displayed:

- Position the Selector over the desired area.
- Click the Zoom Selector Control,  

The window is zoomed so that the Selector is centered in the window. The scale is adjusted so that the Selector fits within the window, leaving at most a 1 λ margin.

Possible problems:

Clicking the Zoom Selector Control will produce only a warning beep if the Selector is a point.

The limit on the drawing scale also applies for the zoom control. If the Selector dimensions are small λ multiples, the drawing scale after the zoom will be lower than required for the exact fit of the Selector into the window, and the Selector may be smaller than the window.

To zoom the window so that entire cell is visible in it:

- Hold down the OPTION key and click the Zoom Selector Control,  

The window is always zoomed so that the cell is centered in the window. The scale is adjusted so that the cell fills the window, leaving at most 1 λ margins.

The action of the  control can be modified by holding down the COMMAND key: the scale is changed so that the current contents of the window will fit in the area indicated by the Selector. While the COMMAND key is depressed, the control appearance also changes to  , to indicate the reversal of the Selector’s and window’s roles. The COMMAND key is ignored if the OPTION key is depressed.

### 4.10 View management in Uncle

The cell windows in Uncle behave in essentially the same manner as in most Macintosh applications. There are, however, some nonstandard features. This chapter describes the nonstandard behavior of scroll bars: the implementation of the dynamic limits of the viewing area and the use of modifier keys. It also tells you how to switch quickly between various views of the same cell without scrolling, changing window scale etc.
4.10.1 Scrolling

In most of the graphic editors for Macintosh, the limits of the drawing are fixed or can be declared with a special menu command or dialog box. The range of the thumb movement in the scroll bars is determined by the extreme positions of the window within these limits. This manner of view management would be inconvenient in Aunt, as the drawing limits extend from –32760 \( \lambda \) to +32760 \( \lambda \). Even for fairly large cells, a small movement of the thumb would scroll the window far away from the cell layout.

Therefore, dynamic view boundaries are implemented, so that the range of the scroll bars is related to the size of the cell’s bounding box. As a result, a seemingly strange behavior of thumbs may be observed: it is possible to scroll the window by pressing in the left scroll arrow even if the horizontal thumb is in its leftmost position.

Normally, the extreme positions of the thumb in each scroll bar correspond to the limits of the standard view area. The standard extreme positions are determined as follows:

If the thumb of the horizontal scroll bar is moved to its leftmost position, an empty area of width equal to 1/4 of the cell’s bounding box width is visible between the left boundary of the window and the left boundary of the cell’s bounding box. Analogous rules apply to the other standard extreme positions. The area viewed by moving the thumbs between the standard positions is called the standard view area.

By clicking the arrows or the gray regions of the scroll bars, it is possible to scroll the window to show more than the standard view area. If some boundary of the window extends outside the corresponding boundary of the standard view area, the thumb is placed in the appropriate extreme position. The scroll bar behaves then as if the standard view area was enlarged to include the entire window. This adjusted view area changes dynamically after each scroll. As a result, scrolling may result in the thumb remaining in the extreme position; this may appear awkward, particularly if you scroll by dragging the thumb.

Remark: there exists a limit as to how far the window can be scrolled or scaled. It is determined by the requirement that all grid points visible in the window have their coordinates larger than –32760 \( \lambda \) and smaller than +32760 \( \lambda \).

Other unusual behavior of the scroll bars is:

- Change in thumb positions after some layout operations or menu commands.
  Explanation: after each layout operation, the bounding box of the cell may be adjusted and the thumbs may be repositioned to reflect the changes in the standard view area. Since accounting for the decrease in the bounding box’s size is more time-consuming than accounting for the increase, only the latter is performed after layout operations. The bounding box is recalculated accurately after some commands that are themselves time-consuming; these include scaling the view, saving the cell, and compacting the cell data.
- The range of the scroll bars does not increase monotonically with the size of the cell.
  Explanation: The range of the scroll bars, expressed in \( \lambda \), is related to the ratio of the size of the view area and the window area. If this ratio is close to 1, the range is small, since the standard view area needs to be scrolled only by several \( \lambda \) between the extreme positions in the window. If the ratio is much larger or smaller than 1, the range of the scroll bars is large.

4.10.2 Usage of modifier keys for accelerated scrolling

Normally, a single click in a scroll bar arrow moves the layout by eight pixels. A click in the gray area of a scroll bar moves the window by a half of the window’s width horizontally or half of the window’s height vertically. Pressing modifier keys has the effect of multiplying the scroll amount by following amounts:

- **SHIFT** key: the scroll is twice the standard amount.
- **OPTION** key: the scroll is four times the standard amount.
- **COMMAND** key: the scroll is eight times the standard amount.
- **CONTROL** key: the scroll is 16 times the standard amount.
4.10.3 Fast switching between cell views

Uncle can remember up to 10 different cell views (i.e. window scales and cell positions in the window). Once a cell view is stored, it is possible to return to it immediately without scrolling, changing the window scale with the palette controls etc. Every open cell window has its own list of stored views.

To store the current cell view:

- Choose the Store View... command in the submenu Set View, menu View.

A dialog shown to the right will be displayed. You can name the view by typing in the text-edit box. You can also check the Store Selector checkbox. If you do, the current size and position of the Selector will be stored. Click OK to store the view, Cancel to dismiss the dialog without storing the view.

Once a view has been stored, its name appears in the submenu Set View.

To restore a stored cell view:

- Choose the name of the view from the submenu Set View, menu View.

The window scale, window dimensions and position of the cell in the window will be restored. If the Selector was stored as well, it will assume exactly the same size and position as when the view was stored.

Possible problems:

In some circumstances the restored view (cell position in the window and/or window scale) may differ slightly from the stored view.

4.10.4 Other nonstandard features

Normally, when a window on the Macintosh screen is resized by either dragging the size box or clicking the zoom box, the scale of the picture in the window is not changed. In Uncle you may resize the cell window and center the cell in it simultaneously. To do that, keep the OPTION key depressed while you resize the window by either dragging the size box or clicking the zoom box. After resizing the cell will be centered and its scale will be adjusted in such a way that the cell will fill the window leaving at most 1 l margins.

When you have several applications opened simultaneously and Uncle is not the active application, you may notice that Uncle does not redraw its inactive windows. This is not a bug. Redrawing a cell window with a complex layout in it may require a lot of time, especially on older and slower Macintosh models. Therefore, only the cell window that is in front and is active will be redrawn when needed.

4.11 Printing

Uncle can print cell layouts on all Apple printers and on other printers compatible with Apple Macintosh computers. Printing is possible in both color and black and white modes. To print a cell layout in color, you must have a color monitor and a color printer connected to your Macintosh. On black and white printers cell layouts are printed using either black and white patterns or grayscale equivalents to screen colors depending on the capabilities and settings of the printer. On color printers layouts are printed in either color or black and white mode depending on the display mode and printer settings.

When printing in color, you will usually notice that the printout colors do not match exactly the colors on the screen. Uncle sends to the printer a picture which uses exactly the same colors as you see on the screen. Unfortunately, monitors and printers have different color capabilities, and the range of colors that can be reproduced by printers is usually more limited than the range of colors that you see on the screen. The MacOS ColorSync system extension does its best in translating monitor colors into printer colors. However, you may need to experiment with the color settings in ColorSync in order to get good printouts. Some
color printers allow you to set additional color options. See the user’s manual that came with your printer for more information.

Remark: Apple Imagewriter II printer prints layouts always in black and white mode even if four color ribbon is installed and the screen is in color mode. The color printing capabilities of this printer are insufficient for printing Uncle layouts in color.

4.11.1 Setting printout scale

In addition to two standard menu commands, Page Setup... and Print..., there is an additional menu command Page Scale... which allows you to set the scale of the printed layout.

To set the printout scale:

• Choose the Page Setup... command from the File menu.

In the dialog that will be displayed you will find all standard buttons, boxes etc. and two additional items: a text line telling you what is the current printout scale, and a button labelled New scale.... Set all standard page setup options (page size etc.) and click this button. A dialog shown to the right will be displayed. You can set the printout scale by either typing in appropriate boxes or clicking the up and down arrows. The scale unit is pixels per lambda. One pixel corresponds to 1/72th of an inch on most printers. If for the chosen scale the size of the printout exceeds one page, Uncle will automatically divide the printout into several pages. The dialog will tell you how many pages will be needed and what percentage of their area will be used. Set the scale and click the OK button. If you want to use the same scale for all your printouts, you may make it the default scale by dismissing the dialog with the Make default button.

Alternate method to set the printout scale:

• Choose the Page Scale... command from the File menu.

The dialog shown above will be displayed. Remember to set the page size before setting the printout scale. Uncle uses the current page size in calculations of the number of pages needed and the percentage of their utilization.

4.12 Using menus in Cell Edit Mode

4.12.1 Apple menu

The Apple Menu contains four items related to Uncle, followed by whatever desk accessories are included in the System file on the startup disk. In addition to the customary About... item that occurs in almost every Macintosh application, there are three items used to set the main modes of Uncle: Help Mode, Technology Edit Mode and Cell Edit Mode.

About Uncle™...

This menu command displays the same dialog as can be seen upon invoking Uncle.

Help...

This menu command allows you to enter the Help Mode of Uncle. In the dialog that will appear, click the Continue Help Mode button to enter Help Mode or Cancel to return to the usual mode.
An alternative method for toggling the Help Mode on is typing the $\text{?}$ key while holding down the $\text{COMMAND}$ key. The Help Mode can also be toggled on by choosing the **Uncle Help...** command from the ? menu (the System 7 menu that is used to toggle on and off the balloon help). Once in Help Mode, in order to obtain help on any item (menu, control, or keyboard), click the pointer on the item or press the key. If a help dialog is dismissed with the **Do it!** button, all the normal actions associated with the chosen item will be performed as in the usual mode, and the Help Mode will continue. To use the normal action of auto-repeat keys in the Help Mode, keep the key pressed, and use the mouse to click on the **Do it!** button in the help dialog that will appear after initially pressing the key.

**Technology Edit**

This menu command establishes the Technology Edit Mode of Uncle. In this mode, you can edit definitions of technologies. Before you enter Technology Edit Mode, you are given a chance to save all work you did in Cell Edit Mode.

**Cell Edit**

This menu command establishes the Cell Edit Mode of Uncle. In Cell Edit Mode, you can edit layouts of cells as well as cell hierarchies. Before you enter Cell Edit Mode, you are given a chance to save all work you did in Technology Edit Mode.

The technology used in Cell Edit Mode is determined as follows:

- If Uncle starts up alone in Cell Edit Mode, the default technology is used. To find out how to change the default technology, see the **Default tech** item in the next section.

- If in Technology Edit Mode, a technology was opened for editing, and the **Cell Edit** item is chosen from the ? menu, this technology will be used in Cell Edit Mode, provided that it contains no errors; otherwise, the previous technology will be used.

To change the currently used technology, use the **Current tech** command in the **File** menu.

### 4.12.2 File menu

In the Cell Edit Mode, the **File** menu contains commands related to managing files with descriptions of IC cells.

**New...** *(keyboard equivalent ‘%N’)*

This command displays a dialog that enables you to set the name of a cell, and then opens a new window with an empty layout area. Initially, the origin of the coordinate system [0,0] coincides with the upper left corner of the window.

**Open...** *(keyboard equivalent ‘%O’)*

This command displays a dialog that enables you to select the IC cell to be opened, and then opens a window and displays the specified cell in it. Initially, the origin of the coordinate system [0,0] coincides with the upper left corner of the window.

**Close**

This command closes the active window, whether it is a layout window or a desk accessory. When a cell window is closed, the cell file is not closed. A closed layout window can be opened again by selecting the cell name from the **Cell** menu.

**Close all**

Closes all windows, including desk accessories. A closed layout window can be opened again by selecting the cell name from the **Cell** menu.
**Import...**

This command displays a submenu that enables you to import into Uncle layouts created either in Uncle for Windows or in a layout editor ‘Magic’ from the University of California at Berkeley. Uncle for Windows files should have names that end with the '.unc' string, and Magic files should have names that end with the '.mag' string. If the cell to be imported contains subcells, their files should be in the same folder. Selecting the ‘Import...’ command will display a standard dialog used to select an input file. You should select the cell that is at the root of hierarchy of the imported layouts and click the **Open** button; Uncle will automatically read this cell and all its subcells. In the case of Uncle for Windows format subcells can be either in the Uncle for MacOS or Uncle for Windows format. If a subcell exists in both formats and both files are in the same folder, the MacOS version will be read in.

**Compact Data**

This command compacts the data representing the cell in the active window. It cannot be undone, and it makes all previous operations on the compacted cell impossible to undo. The layout in the active window may appear more readable after data compacting, as the details of the internal data structures may disappear.

**Save** (keyboard equivalent ‘%S’)

This command writes out data describing the cell in the active window to the disk.

**Save A Copy As...**

This command saves the cell in the active window, possibly giving it a different name. Several save formats are available: Uncle, Uncle for Windows, CIF, Magic, Electromask, and GDSII (also known as Calma).

If the cell is given a new name, a new cell file is created. Note that this file is not opened automatically. If you wish to make a copy of the current cell and edit this copy, you must save the cell (in either Uncle or Uncle for Windows format) giving it a different name and then open it.

**Save All**

Saves all cells that were changed since they were last saved.

**Save In Another Tech...**

This command saves the cell in a new file, allowing to change the name of the cell technology. In addition, the layout can be rescaled by multiplying all dimensions and coordinates by a positive integer. As a result, the cell can be opened and edited in a technology different than the original one, possibly with a different lambda value. The new technology name and scaling factor can be entered in a dialog box shown to the right.

It makes sense to use this command if the name of the new cell technology represents an existing technology file, and the new technology has exactly the same set of layers defined in the same way as in the original technology, otherwise the new cell file will be useless.

The usual reason to save the cell in a technology other than the original one is to rescale an old design to a new, more advanced technology with the same set of layers but more aggressive design rules, for example to migrate a digital cell designed in a 1 µm CMOS technology to a new 0.5 µm CMOS technology.

**Save As Flat Cell...**

This command creates a new cell file and saves the current cell expanding all its subcells and importing their layouts to the new cell. As a result, the new cell is a “flat” one: it has no hierarchy of subcells. Labels are not transferred to the new cell.
Save DRC Report

This command creates a text file that contains textual description of all violations of the design rules in the active cell. The name of the report file is the same as the cell name, with the extension “DRC” appended to it. It can be opened using any Macintosh text editor.

To create a DRC report, the cell must be completely checked for design rule violations and saved. If there are areas in the cell which have not been checked, this command is inactive.

Page Setup...

This command displays a dialog that allows you to set the format in which the active cell should be printed. The appearance of this dialog depends on the selected printer. Uncle can print cell layouts on all standard Macintosh printers, including color printers.

Uncle modifies the standard page setup dialog by adding information on the current printing scale and an additional button labelled New scale... . Clicking this button has the same effect as choosing the Page Scale... command.

Page Scale...

This command displays a dialog shown to the right that lets you specify the printing scale. You can change the scale by either typing in appropriate text edit boxes or by clicking the up arrow or down arrow in order to increase or reduce the printout scale.

One pixel is usually equivalent to 1/72th of an inch. Small deviations may occur depending on the printer used.

If the dialog is dismissed by pressing the Make default button, the chosen scale will be stored in the preference file and reused for subsequent printouts.

Print... (keyboard equivalent ‘%P’)

This command displays a standard dialog used to specify the print parameters such as print quality, number of copies etc. The appearance of this dialog depends on the selected type of printer. After dismissing the dialog with the OK button Uncle prints the active cell according to the desired format.

If the layout is displayed on the screen in the black and white mode, Uncle prints it using black and white patterns. If the layout is displayed in colors and a suitable color printer is selected, Uncle prints the layout in colors. The exception is the Apple Imagewriter II dot-matrix printer. This printer is treated by Uncle as a black and white printer even if the four color ribbon is used. The color printing capabilities of Imagewriter II are not sufficient to print Uncle layouts in color.

If you design your layout using color screen but want to print it using a black and white printer, switch the screen to the black and white mode before printing. If you print your layout in colors, the result depends on the kind of printer used, the quality of paper and other printer-specific factors. Some experimenting may be required in order to get color printouts matching closely the colors on the screen. Consult the manual that came with your printer for details and hints.
Current tech

This command displays a submenu of technology names, one of which may be selected for use. Before switching to the new technology, you will be given a chance to save the work done on the subcells in the current technology.

Use the New... item in the submenu to use a technology that is not present in the list. You will be shown a dialog that will allow you to open the desired technology file.

Default tech

This command displays a submenu of technology names, one of which may be selected to become a default technology to be used whenever Uncle is started up alone.

Use the New... item in the submenu to set a default technology that is not present in the list.

Preferences

You can use this command to set your preferences about various aspects of Uncle. Selecting it in the menu will display a submenu of topics, and selecting a topic will produce a dialog that can be used to modify the default behavior of Uncle. This is discussed in Section 4.13.

Quit (keyboard equivalent ‘⌘Q’)

This command quits Uncle, with the option to save any changes that were made.

4.12.3 Edit menu

In the Cell Edit Mode, the Edit menu contains, in addition to the standard functions, two groups of commands:

• Commands for entering subcells in the currently edited cell, for duplicating, and for arraying the subcells.

• Commands for selecting subcells and electrical nodes.

Undo (keyboard equivalent ‘⌘Z’)

This command undoes the most recent operation in the active cell. If there are no operations to be undone, the command is inactive, and invoking it with ‘⌘Z’ will produce a warning beep. You can undo all operations you did since opening the cell window or since issuing the Compact Data command from the File menu.

Redo (keyboard equivalent ‘⌘R’)

This command redoes the most recently undone operation in the active cell. If there are no operations to be redone, the command is inactive, and invoking it with ‘⌘R’ will produce a warning beep. You can redo all operations that were undone since the last operation different from Undo and Redo.

Cut (keyboard equivalent ‘⌘X’)

This command moves to the Clipboard the currently selected objects in the active cell window. The selection may include the part of the layout that is bounded by the Selector and/or one or more subcells. All labels that are completely enclosed by the Selector rectangle are also selected. Alternatively, instead of the part of the layout bounded by the Selector one or more of nodes may be selected. The Clipboard contents may be pasted in the same or another cell window or in any Macintosh application that accepts picture data.

Remark: the name of this command changes automatically indicating the kinds of objects that are currently selected for cutting. For example, when you select a node (or
several nodes) and a subcell (or several subcells), the name of this command becomes **Cut Node & Subcells**.

If nothing is selected, the command is inactive, and invoking it with ‘✂’ will produce a warning beep.

**Copy**  
*(keyboard equivalent ‘⌘C’)*

This command copies to the Clipboard the currently selected objects in the active cell window. The selection may include the part of the layout that is bounded by the Selector and/or one or more subcells. All labels that are completely enclosed by the Selector rectangle are also selected. Alternatively, instead of the part of the layout bounded by the Selector one or more of nodes may be selected. The Clipboard contents may be pasted in the same or another cell window or in any Macintosh application that accepts picture data.

Remark: the name of this command changes automatically indicating the kinds of objects that are currently selected for copying. For example, when you select a node (or several nodes) and a subcell (or several subcells), the name of this command becomes **Copy Node & Subcells**.

If nothing is selected, the command is inactive, and invoking it with ‘✂’ will produce a warning beep.

**Paste**  
*(keyboard equivalent ‘⌘V’)*

This command pastes the layout from the Clipboard into the active cell. The upper left point of the Selector indicates where the upper left corner of the Clipboard’s content will be pasted.

If the Clipboard is empty, the command is inactive, and invoking it with ‘⌘V’ will produce a warning beep.

**Clear**

This command deletes the currently selected objects in the active cell window. The selection may include the part of the layout that is bounded by the Selector and/or one or more subcells. All labels that are completely enclosed by the Selector rectangle are also selected. Alternatively, instead of the part of the layout bounded by the Selector one or more of nodes may be selected.

Remark: the name of this command changes automatically indicating the kinds of objects that are currently selected. For example, when you select a node (or several nodes) and a subcell (or several subcells), the name of this command becomes **Clear Node & Subcells**.

**Add subcell...**  
*(keyboard equivalent ‘⌘U’)*

This command displays a dialog that enables you to choose a subcell to be added to the layout, and another dialog that enables to determine the position and orientation of the subcell. By default, the subcell is placed so that its upper left corner coincides with the upper left corner of the Selector.

**Duplicate**  
*(keyboard equivalent ‘⌘D’)*

This command duplicates the selected subcell. This command is inactive if no cell is currently selected, and invoking it with ‘⌘D’ will produce a warning beep.

This operation does not affect the Clipboard contents.

**Array...**  
*(keyboard equivalent ‘⌘Y’)*

This command displays a dialog which can be used to make an array out of the selected subcell or to modify an existing array.
**Select Node**

This command displays a submenu of commands related to nodes, i.e. connected areas on layers. The commands in this submenu allow to select and deselect nodes and perform some other operations.

If no node is selected, the submenu contains a list of layers present under the upper left corner of the Selector. Choosing one of them results in selecting a node on this layer. The node includes the point indicated by the upper left corner of the Selector. If another node is already selected, it will be deselected. To select more than one node (all nodes must be on the same layer), keep the Shift key depressed when selecting nodes.

If a node is already selected, the submenu contains two more commands: **Deselect Node** and **Show/Hide Node Info**.

The **Deselect Node** command deselects any node or nodes currently selected.

The **Show/Hide Node Info** command displays a small box (shown to the right) listing all labels contained in the selected node. The labels that are attached to the node layer are marked with the bullet (•). This feature helps to verify connectivity of the designed cell. The node info box also shows the area of the selected node. Its contents is updated if either the node or the labels in it are edited. It can be dragged with the mouse to any desired position in the window. To hide it, choose the **Show/Hide Node Info** command again.

**Select Subcells**

This command selects all subcells whose outlines are entirely enclosed by the Selector.

**Select More Subcells**

This command selects all subcells whose outlines are either entirely enclosed by the Selector or intersect it.

**Select All Subcells**

This command selects all subcells in the active cell.

**Select All** (keyboard equivalent ‘*A’)

This command selects the entire contents of the active cell, i.e. its artwork, all subcells and labels.

**Get Info...** (keyboard equivalent ‘*I’)

This command displays information which depends on the current mode, display(s) and/or selection(s). In Uncle 1.8, the only function of interest is that it can display the layers present in the lower right vicinity of the upper left corner of the Selector.

**4.12.4 View menu**

The View menu contains commands that allow you to affect the way the cells are displayed.

**Show Rulers/Hide Rulers**

This command toggles on and off the rulers in the active window. Rulers display the distance from the origin of the coordinate system. Once visible, rulers can be moved to any position within the cell window. To move a ruler, position the pointer over it and drag. The pointer and the outline of the ruler move as you drag, indicating the new location. Release the mouse button when the ruler reaches the desired position.
The default unit in the rulers is \( \lambda \). You can change units used in the rulers by choosing the \textbf{Cell View...} command from the submenu \textbf{Preferences}, menu \textbf{File}. See Section 4.13 for details.

\textbf{Show Grid/Hide Grid}

This command toggles on and off the grid in the active window. When the grid is switched on, a black dot is displayed at each grid point, provided that the grid is at least 3 pixels wide.

\textbf{Show Size/Hide Size}

This command toggles on and off the selector size box which displays the position of the pointer and the size and position of the Selector. Once visible, this box can be moved to any position within the cell window. To move it, position the pointer over it and drag. The pointer and the outline of the box move as you drag, indicating the new location. Release the mouse button when the box reaches the desired position.

The default unit is \( \lambda \). You can change units which are used in the selector size box by choosing the \textbf{Cell View...} command from the submenu \textbf{Preferences}, menu \textbf{File}. See Section 4.13 for details.

\textbf{Find Selector}

This command centers the window on the Selector. The scale remains unchanged.

\textbf{Find Selector} changes to \textbf{Find Cell} if the \textbf{OPTION} key is held down while depressing the mouse button in the menu bar. \textbf{Find Cell} centers the window on the cell instead of on the Selector.

Choosing the \textbf{Find Selector} command is equivalent to clicking the \( \mathbb{I} \) control in the View/Mode Palette.

\textbf{Zoom Selector->Window}

This command sets the view scale and coordinates so that the current contents of the window fit in the current Selector. This operation is not performed if the Selector is a point.

\textbf{Zoom Selector->Window} changes to \textbf{Zoom Window->Selector} if the \textbf{OPTION} key is held down while depressing the mouse button in the menu bar. \textbf{Zoom Window->Selector} sets the view so that the entire area previously visible in the window fits exactly in the area previously occupied by the selector.

\textbf{Zoom Selector->Window} and \textbf{Zoom Window->Selector} are respectively equivalent to clicking the \( \mathbb{I} \) and \( \mathbb{E} \) controls in the View/Mode Palette.

\textbf{Zoom In} \hspace{1cm} (keyboard equivalent ‘\text{Z} \text{Y}’)

This command increases the view magnification 1.5 times (shows less area). The center of the window stays where it was.

Choosing the \textbf{Zoom In} command is equivalent to clicking the \( \mathbb{I} \) control in the View/Mode Palette.

\textbf{Zoom Out} \hspace{1cm} (keyboard equivalent ‘\text{Z} \text{U}’)

This command decreases the magnification 1.5 times (shows more area). The center of the window stays where it was.

Choosing the \textbf{Zoom Out} command is equivalent to clicking the \( \mathbb{I} \) control in the View/Mode Palette.

\textbf{Fit In Window} \hspace{1cm} (keyboard equivalent ‘\text{Z} \text{F}’)

This command sets the view scale and coordinates so that the entire cell fits exactly in the window.
Choosing the **Zoom Selector** command is equivalent to clicking the ⌘ control in the View/Mode Palette while holding down the ⌘ key.

### Set View

This command displays a submenu that allows to store the attributes of the current cell view (i.e. the cell window scale and dimensions and the position of the cell in the window, and optionally the position of the Selector), and to return later to the stored view. The maximum number of stored views is 10. The first command in the submenu reads **Store View...**. It displays a dialog that allows to name the view and to decide whether the Selector is to be stored (see section 4.10.3 for details). The name of a stored view is appended to the submenu. To restore a view stored previously, choose appropriate view name from the submenu.

Every open cell window has its own list of stored views. When a window is brought to the front and made active, the contents of the **Set View** submenu is updated accordingly.

### Set Selector...

This command displays a dialog (shown in section 4.5.3) that allows to determine the position and size of the Selector by typing in the appropriate boxes.

### Expand

This command reads **Expand Selected** or **Unexpand Selected**, depending on the status of the selected subcell. It is active only in the presence of the Subcell Operations Palette if some subcell of the active cell is selected.

- If the selected subcell is displayed as an outline with a cell name, it is expanded and its contents are made visible. The subcells of the subcell are not expanded. An expanded subcell is displayed with all details of its internal layout. Its subcells can be selected and expanded as well.
- If the selected subcell is displayed in its expanded form, it is unexpanded, and from now on, it will be displayed as an outline with the subcell name inside. Contrary to the behavior described for expanding, the subcells of the subcell are affected by this command — they are also unexpanded. An unexpanded subcell is displayed as a rectangle with a cell name, an instance name in quotation marks, and an orientation icon. The entire hierarchy of its subcells is unexpanded as well.

If the selected cell is currently unexpanded, choosing the **Expand** command is fully equivalent to double–clicking the ⌘ control on the Subcell Operations Palette; otherwise, it is equivalent to double–clicking the ⌘ control.

### Expand One Level

This command is used to expand all subcells visible inside the Selector. Only one level of hierarchy is affected; the subcells of the newly expanded subcells can be expanded with the next invocation of this command. If the ⌘ key is held down while depressing the mouse button in the menu bar, this command changes to **Unexpand One Level** and has the exact opposite effect: all subcells intersecting the Selector that are expanded and contain no expanded subcells within the Selector will be unexpanded. Note: subcells that only touch the Selector are not affected.

### Expand All

This command expands all levels of hierarchy within the Selector: subcells visible inside the Selector and all the subcells of the newly expanded subcells, until no unexpanded subcells are present within the Selector. If the ⌘ key is held down while depressing the mouse button in the menu bar, this command changes to **Unexpand All** and unexpands all subcells intersecting the Selector, resulting in only the topmost level of the hierarchy being visible.
Peek
This command temporarily expands cells intersecting the Selector and all subcells hierarchically contained in them. The bounding boxes of subcells are not displayed. The temporarily expanded area remains visible until it is scrolled away or redisplayed. Whenever a temporarily expanded area is redrawn, only the permanently expanded cells and unexpanded cell outlines will be shown.

4.12.5 Operations menu

The Operations menu contains commands that allow you to manipulate subcells. Most of these commands are equivalents of controls in the Subcell Operations Palette. Some of the commands in the Operations menu can be applied to selected portions of the cell artwork as well.

Rotate Left

If there exists a selected subcell in the active cell, this command rotates the selected subcell counterclockwise. If more than one subcell is selected, every subcell is rotated independently. If the selected item is an array, the entire array is rotated, i.e., the numbers of elements in rows and columns are swapped. If the selected item is a group of subcells, the entire group is rotated as a single object. After the transformation, the upper left corner of the cell, group or array remains in the same position as before.

By holding the [SHIFT] key down while selecting the command, a modification of Rotate Left is obtained, in which only the elements of arrays are rotated, i.e., the numbers of rows and columns are not interchanged.

The rotation can also be applied to the layout enclosed by the Selector.

It is recommended to rotate subcells in the subcell operations mode only.

Choosing the Rotate Left command is equivalent to double-clicking the [control] on the Subcell Operations Palette.

Rotate Right

If there is a selected subcell in the active cell, this command rotates the selected subcell clockwise. If more than one subcell is selected, every subcell is rotated independently. If the selected item is an array, the entire array is rotated, i.e., the numbers of elements in rows and columns are swapped. If the selected item is a group of subcells, the entire group is rotated as a single object. After the transformation, the upper left corner of the cell, group or array remains in the same position as before.

By holding the [SHIFT] key down while selecting the command, a modification of Rotate Right is obtained, in which only the elements of arrays are rotated, i.e., the numbers of rows and columns are not interchanged.

The rotation can also be applied to the layout enclosed by the Selector.

It is recommended to rotate subcells in the subcell operations mode only.

Choosing the Rotate Right command is equivalent to double-clicking the [control] on the Subcell Operations Palette.

Rotate 180°

If there is a selected subcell in the active cell, this command rotates the selected subcell by 180°. If more than one subcell is selected, every subcell is rotated independently. If the selected item is an array, the entire array is rotated. If the selected item is a group of subcells, the entire group is rotated as a single object. After the transformation, the upper left corner of the cell, group or array remains in the same position as before.

The rotation can also be applied to the layout enclosed by the Selector.

It is recommended to rotate subcells in the subcell operations mode only.
Choosing the **Rotate 180°** command is equivalent to double-clicking the \(\square\) control on the Subcell Operations Palette.

**Flip Horizontally**

This command flips the selected subcell horizontally. If more than one subcell is selected, every subcell is flipped independently. If the selected item is an array, the entire array is flipped. If the selected item is a group of subcells, the entire group is rotated as a single object. After the transformation, the upper left corner of the cell, group or array remains in the same position as before.

The flip can also be applied to the layout enclosed by the Selector.

Choosing the **Flip Horizontally** command is equivalent to double-clicking the \(\square\) control on the Subcell Operations Palette.

**Flip Vertically**

This command flips the selected subcell vertically. If more than one subcell is selected, every subcell is flipped independently. If the selected item is an array, the entire array is flipped. If the selected item is a group of subcells, the entire group is rotated as a single object. After the transformation, the upper left corner of the cell, group or array remains in the same position as before.

The flip can also be applied to the layout enclosed by the Selector.

Choosing the **Flip Vertically** command is equivalent to double-clicking the \(\square\) control on the Subcell Operations Palette.

**Move...**

This command displays a dialog, shown in Section 4.6.2.4.4, General subcell transformation, that lets you set the position of the selected subcell and the cell instance name. The **Move...** command can also be applied to a portion of the artwork enclosed by the Selector.

**Align**

This command displays a submenu which allows to align tops, left sides, bottoms or right sides of selected objects (subcells, groups, arrays). If there are less than two objects selected, this command is inactive.

The picture below illustrates the **Align** command: three subcells before and after alignment.

**Make Row**

This command displays a submenu which allows to create a row of abutting subcells (groups, arrays) with tops, left sides, bottoms or right sides aligned. This command is especially useful for manual placement of standard cells in rows.

If there are less than two objects selected, this command is inactive.

The picture below illustrates the **Make Row** command: initial positions of three subcells and the same subcells arranged in a row with tops aligned.
Group
This command creates a group of subcells. To make a group, more than one subcell must be selected. A group is treated in the transformations and other operations as a single object. When one of the cells that belong to a group becomes selected, all other cells in this group also become selected. A group icon is displayed close to the orientation icon in all unexpanded subcells that belong to a group.

A larger group can be made out of some other selected groups (and possibly single selected subcells). However, in Uncle there is no hierarchy of groups, i.e. groups do not nest. When several groups are selected and the Group command is invoked, a single group consisting of all the subcells from all selected groups is created.

Choosing the Group command is equivalent to double-clicking the control on the Subcell Operations Palette.

Ungroup
This command ungroups a selected group.

Choosing the Ungroup command is equivalent to double-clicking the control on the Subcell Operations Palette.

Lock
This command locks the selected item and prevents any changes to it until it is unlocked.

A locked cell cannot be moved, rotated or flipped. If it is not expanded, a small padlock will be displayed close to the orientation icon in the upper left corner of the cell bounding box.

Choosing the Lock command is equivalent to double-clicking the control on the Subcell Operations Palette.

Unlock
This command unlocks the selected cell and makes further changes to the cell possible.

Choosing the Unlock command is equivalent to double-clicking the control on the Subcell Operations Palette.

4.12.6 Artwork menu
The Artwork menu contains commands used to edit the IC layers. It enables you to edit layers in all modes. Some of these commands are equivalents of controls in the Paint Palette. The purpose of duplicating the means for performing the painting operations is to enable you to do them without having to change the palette.

Paint
This command displays a submenu of available layers, one of which can be chosen for painting the Selector area at a time. Selecting a layer is equivalent to clicking the corresponding layer control in the left column of the Paint Palette.
Erase

This command displays a submenu of available layers, one of which can be chosen to be erased from the Selector area at a time. Selecting a layer is equivalent to clicking the corresponding layer control in the right column of the Paint Palette.

Repaint...

This command displays a dialog, shown to the right, that enables you simultaneously to paint and erase the Selector area with a composition of layers.

You can select the layers to be painted or erased by clicking their names in the appropriate lists. Clicking a selected layer deselects it. A selected layer in one of the lists becomes deselected when the same layer is selected in the other list.

Extend Down

This command is used to sample the layers under the top side of the Selector and to paint them along the entire Selector height.

A submenu of layers will be displayed, one of which can be chosen for extending. The first item in the submenu is All, meaning that all present layers will be extended.

Selecting All is equivalent to clicking the control in the Paint Palette.

Extend Right

This command is used to sample the layers under the left side of the Selector and to paint them across the entire Selector width.

A submenu of layers will be displayed, one of which can be chosen for extending. The first item in the submenu is All, meaning that all present layers will be extended.

Selecting All is equivalent to clicking the control in the Paint Palette.

Extend Up

This command is used to sample the layers under the bottom side of the Selector and to paint them along the entire Selector height.

A submenu of layers will be displayed, one of which can be chosen for extending. The first item in the submenu is All, meaning that all present layers will be extended.

Selecting All is equivalent to clicking the control in the Paint Palette.

Extend Left

This command is used to sample the layers under the right side of the Selector and to paint them across the entire Selector width.

A submenu of layers will be displayed, one of which can be chosen for extending. The first item in the submenu is All, meaning that all present layers will be extended.

Selecting All is equivalent to clicking the control in the Paint Palette.
**Extend...**

This command displays a dialog, shown to the right, that allows you to specify the layers to be sampled under the specified side of the Selector and to paint them across the entire Selector width or height. Any composition of layers can be selected.

![Extend Layers Dialog](image)

**Show**

This command displays a submenu of available layers, one of which can be made visible. Selecting a layer is fully equivalent to clicking the corresponding layer control on the Paint Palette in the Visibility Mode.

**Hide**

This command displays a submenu of available layers, one of which can be made invisible. Selecting a layer is fully equivalent to clicking the corresponding layer control on the Paint Palette in the Visibility Mode.

**Show/Hide...**

This command displays a dialog, shown to the right, that enables you to select the layers that should be visible. The dialog contains two lists: a list of currently invisible layers that can be made visible, and a list of currently visible layers that can be hidden. The layers are selected in each list by clicking their names. Clicking on a selected layer deselects it. All combinations of layers to be shown and hidden are permissible.

![Show/Hide Dialog](image)

**Show All Layers**

Choosing this command makes all layers visible.

**Show Labels/Hide Labels**

Choosing this command makes all labels either visible or invisible, respectively.

**Add Label...** *(keyboard equivalent ‘%L’)*

This command displays a dialog (shown in Section 4.7.1) that allows to determine attributes of a new label and add it to the cell layout.

**Delete Label**

This command deletes all selected labels. A label is selected if it is enclosed by the Selector or if it is in close vicinity of the Selector (within 1/2 \( \lambda \)).

**Edit Label...**

This command displays a dialog (shown in Section 4.7.1) that allows to edit attributes of a selected label. If more than one label is selected, the command applies to all selected labels which can be edited one after another.
4.12.7 DRC menu

The DRC menu contains commands used to control the design rule checker. The design rule checker can be run continuously or upon request (see the Continuous Checking item below). Whenever a cell contains design rule errors, the title of the DRC menu blinks once per second\(^1\).

**Verify Selector**

This command verifies the complicity of the region bounded by the Selector with the design rules specified for the current technology. Any existing information about errors in the Selector area is discarded, and the Selector area is rechecked. This command is inactive if the Selector is a point or a line.

**Verify Cell**

This command discards all previously existing information about design rule violations and performs a design rule check for the entire cell\(^2\).

**Verify Recent Changes**

This command verifies the correctness of any areas in the currently edited cell that are awaiting a design rule check and is active only if such areas exist. In the continuous DRC mode, Verify Recent Changes is usually inactive, as all changes are verified as soon as they are entered. If the \texttt{OPTION} key is depressed while selecting this command, only the recent changes within the Selector area are verified. This command, as well as Find Errors, Scan Errors, and Count Errors, will be disabled if you select them while depressing the \texttt{OPTION} key, and, at the same time, the Selector is a point or a line segment.

**Find Errors**

This command is active only if there are errors or unverified areas in the cell. You can use it to scan through the known errors in the layout. If any area in the cell requires a design rule check after all errors are scanned, you will be asked whether you want to verify recent changes. If the \texttt{OPTION} key is depressed while selecting Find Errors, only the errors within the Selector area are scanned.

Error information is displayed in a dialog box, such as those shown here and in the Scan Errors section. The dialog is displayed for several seconds, and then, if you did not click any buttons, information about the next available error is displayed. You can set the delay between consecutive dialogs with the DRC\_ \_ command (submenu Preferences, menu File).

During the Find Error operation, you have three choices for each dialog. Clicking the Show the violation button will center the error area on the screen, set the Selector to enclose the error, and blink the enclosed area several times. (It blinks one more time than the number of times any selected menu item blinks; this number can be controlled with the Control Panel desk accessory.) Clicking the Next violation button will display the information about the next error without waiting for the time-out. Clicking the Hold the info window button will restart the time-out counter after the mouse button is released and will keep the dialog on the screen longer.

---

\(^1\) Blinking of the DRC menu can be switched off, see Section 4.13

\(^2\) Verification of some design rules requires checking of the areas that extend beyond the actual layout area. Therefore it is not recommended to place any layout objects close to the boundaries of the drawing area. In such designs some errors may remain undetected. Uncle will warn you if there is a possibility that some areas of your design cannot be verified.
Scan Errors

This command is similar to Find Error, except that it does not display information windows unless requested. If the option key is depressed while selecting Scan Errors, only the errors within the Selector area are scanned.

In the Scan Errors mode, the cursor changes to ! and the Selector is moved from one violation to another. Each violation area blinks several times, and, after a short delay, the next violation is shown. You can control the delay time with the DRC... command (submenu Preferences, menu File) and the number of blinks with the Control Panel (as described in the Find Errors section).

The display of consecutive errors can be controlled with the mouse. If the mouse is clicked within the active window, an information dialog is displayed. Examples of information dialogs are shown to the right and below. They lack the Next violation button, and the scan cannot be resumed. If the mouse is clicked in the Menu Bar or in the Desktop, the next violation area is displayed without waiting for the time-out. Typing any key interrupts the scan and displays an information dialog. Other than controlling the scan, the clicks and keys typed do not have any other effect, e.g., clicking the mouse in a scroll bar while Scan Errors is active will not scroll the window.

Show Errors/Hide Errors

This command is used to toggle a mode in which all design rule errors are visible in the layout at all times in the form of areas filled with a pattern that spells 'DRC'. Whenever the Show Errors mode is activated, this command changes to Hide Errors. Sample appearance of a violation of the minimal spacing between two areas of diffusion is shown to the right, on top; the actual layout is shown underneath. This picture also illustrates how the error areas are calculated: they mark either the area from which some layer should be removed or the area in which some layer should be added in order to correct a violation. The former case usually occurs for violations of minimum spacing rules, while the latter usually happens for violations of minimum width rules.

In the example figure, removing the diffusion layer from the area of the violation would produce a correct layout. The figures below show additional examples of design rule violations and explain the particular shapes of the violation areas.
The first violation area marks the insufficient poly overhang of a transistor. To rectify the error, the violation area should be filled with the polysilicon layer. The second violation area shows an illegal adjacency of empty space to a transistor; putting diffusion in this area would rectify this particular error (and possibly would create another one – an insufficient diffusion overhang). Violation area #3 indicates insufficient diffusion width: it arises from checking the minimum width requirement along the lower side of the diffusion area. Violation #4 also shows insufficient diffusion width, but arises from a check made in the upper right corner and along the right side of the diffusion stripe.

All violations shown in the figure to the right arise from the insufficient size of the pictured contact to diffusion, which is $3 \times 3 \lambda$ instead of the required $4 \times 4$. They result from checking the $4 \lambda$ width requirement in the upper right and lower left corners; the violations uncovered by the checks done along the lower and right side of the contact show on the opposite side of the contact as #5 and #6: they coincide with those resulting from the corner checks.

Remark: after a change in the layout made in the Show Errors mode, the DRC violation areas will disappear in the changed area and within a certain halo around it; they will come back (if the respective violations still exist) after the incremental design rule check of the changed features has been completed.

**Count Errors**

This command displays an alert that gives the number of design rule violations in the cell. If the OPTION key is depressed while selecting Count Errors, only the errors within the Selector area are counted.

**Continuous Checking**

This command toggles the background design rule checker. With the background checker switched on, whenever you do not do anything for a certain time, Uncle will start verifying recent changes. The cursor will change to DRC for as long as the verification process goes on. Clicking the mouse button or typing any key interrupts the background check, and Uncle responds appropriately to your action. The checking is resumed after another period of inactivity. Uncle’s response while performing continuous design rule checking may be delayed; see the DRC… command (submenu Preferences, menu File) for more details. Active Continuous Checking mode is signified by displaying a check–mark next to the corresponding menu item.

**Verify Hierarchically**

This command is inactive in Uncle 1.8. To verify a hierarchical design, make a flat copy of it (see Save As Flat Cell... command, menu File) and verify this copy.

**Explain Error** (keyboard equivalent: ‘%E’)

This command displays a dialog that explains an error existing in the area below and to the right with respect to the upper left corner of the Selector. See the commands Find Errors and Scan Errors for examples of these dialogs. If there is no error under the upper left corner of the Selector, this command is inactive.

Remark: If there is more than one error to explain and you click the Another error button in the dialog, you will explanation of the next error. However, Uncle can
store information about no more than three different errors existing in any given area.

**Verify Cell Placement**

This command checks whether there are any subcell overlaps in the active cell. Subcell overlaps are allowed. However, overlapping subcells often lead to violations of design rules. Once the check is completed, an alert is displayed saying whether any overlaps exist and if so, how many.

If there are no subcells in the active cell, this command is inactive.

**Show Cell Overlaps/Hide Cell Overlaps**

This command is used to toggle a mode in which all subcell overlaps are visible in the layout at all times in the form of areas filled with a pattern that spells 'OVL'.

### 4.12.8 Cells menu

The **Cells** menu contains a list of all cells available for editing. Selecting a cell name from this menu opens a window containing this cell. If the window is already open, it is brought to the front and made active. The cell contained in the front window is called the active cell.

The first nine opened cells have keyboard equivalents. Typing **z #**, where '#' stands for a digit within the range from 1 to 9, will open the corresponding cell edit window or bring it to front.

### 4.13 Setting Uncle preferences

The **Preferences** command in the **File** menu displays a submenu which allows to select one of groups of Uncle preferences. Use these commands in order to customize some characteristics of operation of Uncle.

#### 4.13.1 Customizing cell views

The **Cell View...** command in the submenu **Preferences** displays a dialog shown to the right. It allows to change the size and style of the font used in labels and subcells, to change the units in the selector size box and in rulers, and to determine the appearance of a newly opened cell.

Label texts and subcell names are always displayed in the Geneva font. You may choose 9, 10 or 12 point size. You may also click the Bold checkbox. Other sizes and styles are not available.

The dimensions and distances displayed in the selector size box and in the rulers can be either in \( \lambda \) or in microns. Click the appropriate buttons to change the units. The default units are \( \lambda \). If you change the units to microns, you will notice an additional comment ‘Dimensions in microns’ in the selector size box. The rulers do not display any textual information, but their appearance changes with the change of the units as shown below.

<table>
<thead>
<tr>
<th>0</th>
<th>10</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler in ( \lambda )</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>0</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ruler in ( \mu \text{m} )</td>
<td></td>
</tr>
</tbody>
</table>

The appearance of a newly opened cell window is controlled by four checkboxes. Three of them are used to toggle visibility of the selector size box, rulers and grid. The fourth **last view** checkbox controls the overall cell view, i.e. size and position of the cell window and
scale and position of the cell in it. These attributes of the cell views are saved in the cell files. If the last view checkbox is checked, the last saved cell view is restored when the cell file is opened, otherwise the cells are opened in the standard view (see Section 4.3).

If you change some settings and dismiss the dialog with the OK button, all font and unit changes will affect the appearance of the opened cells immediately. Click the Make default button if you want to save the new settings in the preference file and use them as default settings.

4.13.2 Using Clipboard in Uncle

By using the Copy or Cut commands, you can put Uncle layouts into the Clipboard and then paste them into any Macintosh application that can display drawings. Drawings can be exported to other applications in either black and white or color mode. An example of a layout picture imported directly from Uncle is shown to the right. The fine detail of this figure, as well as the details of figures in Chapter 2, have been achieved by scaling the drawing to the 50% of its original size. Uncle lets you specify the scale of the exported picture, i.e., the number of dots (pixels) per λ used for representing the layout so that, after importing layout picture into a document, you can scale it down to a desirable size and obtain a fine appearance.

4.13.3 Option settings for Clipboard conversion

Your preferred option settings for layout storage in the Clipboard can be stored within Uncle by selecting the Clipboard... item in the submenu shown when you select the Preferences command in the File menu. Selecting this topic produces the dialog shown to the right. The functions of the controls contained in this dialog are first discussed briefly and then described in more detail.

The two radio buttons at the top of the dialog let you choose the form of the picture: it can be either object-oriented or bitmap-oriented.

There are two possibilities for selecting the scale of the drawing. You can either tell Uncle to use the window scale at the time of the Copy operation or a constant scale independent of the window scale, both of which are applied automatically.

Clipboard conversion may create low-memory situations. Uncle has two responses in such circumstances: either it may scale the picture down automatically, or it may ask you to set the scale.

The Always keep clipboard in memory checkbox tells Uncle to keep the information about the copied or cut layout in the RAM. If the box is unchecked, Uncle will keep this data on a disk.

The Color clipboard checkbox tells Uncle that you want to export the layout pictures in color. If this box is not checked, Uncle will convert the layouts to black and white pictures even if they are displayed on the screen in color.

Check the Do not export clipboard checkbox if you do not plan to paste Uncle layouts into any other application. This will save time and memory when you switch between Uncle
and other applications. Uncle converts the contents of the Clipboard from its internal layout format into a standard Macintosh picture every time you quit Uncle or switch to another application. Conversion of a large chunk of layout may take considerable amount of time.

The **Clipboard Preferences** dialog can be dismissed by clicking any of three buttons as follows. The **OK** button establishes settings for the current Uncle session. The **Make default** button stores the settings in the preference file so that they will be used the next time you run Uncle. The **Cancel** button reestablishes the settings to their previous values from before the dialog invocation.

All the settings discussed above affect only Clipboard operations when Uncle layouts are exported to other applications but do not affect the Cut/Copy/Paste operations within Uncle.

**Picture form**

There are two choices for the form of pictures produced by Uncle: they can be either bitmaps or drawings composed of objects. Depending on the application you intend to use for further processing of the picture of your layout, you can select one of the appropriate radio buttons at the top of the Clipboard Preferences dialog.

A bitmap is a picture in which each black or color dot (pixel) is considered to be a separate entity from all other pixels. One of the first Macintosh applications, MacPaint, could be used exclusively for bitmap editing. Other applications such as MacDraw or Claris Draw allow to edit drawings which are composed of objects such as geometrical shapes (rectangles, ovals, lines, curves), texts etc.

**A bitmap or a drawing?**

A bitmap is transferred via Clipboard to other applications “as is”. If you select the **use current window scale** option, you will get an exact copy of the screen picture. However, a large color bitmap may require more memory that is currently available. Moreover, bitmap scaling may introduce distortions to the original picture (see below).

A drawing requires usually much less memory. However, other applications may rearrange the drawing in such a way that the picture you get is not exactly the same as in the Uncle window. Worse yet, every object-oriented drawing editor seems to have its own way of interpreting the drawings copied from the Clipboard. As a result, the appearance of drawings copied from Uncle and pasted to other applications is somewhat unpredictable. It may also happen that a drawing looks good on the screen but not in print. Usually the differences are more noticeable in the case of color drawings. The reason is that Uncle has its own color blending algorithm which is not used in other applications.

The distinction between bitmaps and drawings applies to the cell artwork only. Subcells and labels are always transferred as objects.

Since both forms of Clipboard pictures have some advantages and some disadvantages, choose the form which gives better results from your viewpoint.

**Bitmap scaling**

As a rule, the appearance of a bitmap containing patterns suffers severely if you reduce it to anything but 25% or 50% of the original size. For example, the same bitmap picture that was shown at 50% reduction in the beginning of this chapter is shown below on the left, reduced to the 29% of the original. As you can see, the patterns of pixels appear significantly distorted.

---

1) There is one exception: subcells are always shown as unexpanded.
For comparison, the same picture, further reduced to 25%, can be seen in the middle to appear relatively free of distortion. Theoretically, there should be no distortion whatsoever. Whatever distortion is present can be attributed to rounding errors during picture processing. The final result depends also on the printer resolution and the printer software.

Hint: Sometimes you may be able to obtain a better picture appearance by first pasting a bitmap into an object-oriented drawing editor, scaling it there, and then pasting the result into a word processor. This is how the picture on the right was obtained. Just as the picture in the middle, which was scaled entirely within the word processor used to prepare this manual, it is also reduced to the 25% of its original size.

Important hint

Whenever you print a black and white layout picture on a laser printer, be sure to check the Precision Bitmap Alignment box in the Page Setup Options dialog. This dialog is invoked by clicking the Options button in the Page Setup dialog. Print your document using a 100% scale in the Page Setup dialog.

Choosing the layout scale

As mentioned earlier, there are three methods for selecting a picture scale.

- Selecting the current window scale will use the scale from the time of the Copy or Cut operation for creating layout pictures. You can use the or control, or View menu Zoom In or Zoom Out commands, to display the layout at a desired magnification. The picture created in the Clipboard will have the same dimensions as the layout on your Macintosh screen.

- Selecting the constant scale will produce identically proportioned pictures independent of the scale at the time of the Copy operation. For example, you can reduce the displayed layout so that it fits on the small screen of a Macintosh SE, select a desired portion of the layout, do a Copy command, and the resulting picture may appear at a larger scale in your document processor, filling an entire page. To change the scale, click the arrow controls in the Clipboard Preferences dialog. Each click increments or decrements the value of the scale. Only values from 99 λ per pixel to 99 pixels per λ are accepted.

Converting a very large chunk of layout into a picture may cause Uncle to run out of memory. The worst thing that can happen is that your picture will be scaled down or that the Clipboard will be truncated or not saved. Before each Clipboard conversion, Uncle estimates the maximal number of pixels per λ that will not cause it to run out of memory. For situations in which this value is lower than the scale you want, you can instruct Uncle by using the Clipboard Preferences dialog to either change the scale to the estimated value, or ask you for the decision.

In the latter case, Uncle will display the dialog shown to the right whenever it is in danger of running out of memory while converting the Clipboard. You will be able to set a desired scale (it will be used only for this particular picture) or to abort the picture altogether.

If you do want the picture done with a larger λ value and Uncle runs out of memory, you should save your work and quit Uncle, open only the cell that you will be copying from, and try to copy the layout into the Clipboard and convert it to a picture again.

Remark: Uncle may run out of memory even if this dialog has not been displayed. In such a case an alert will inform you about the problem and possible consequences.

4.13.4 Enabling operation in background

Uncle running under System 7 or later (or earlier system versions with MultiFinder switched on) can perform some time consuming operations in background. Such operations include e.g. design rule checking and conversion of hierarchical cells into “flat” ones (see Save As Flat Cell... command). For example, once a design rule check has started, you can switch to another application and Uncle will continue its job in background.
However, it is wise to disable operation in background if you run Uncle on an old and slow Macintosh and do not plan to use other applications simultaneously. Disabling background operation will speed up DRC and some other operations. To disable or enable background operation of Uncle, choose the Background... command from the submenu Preferences. A dialog shown above will appear. Click appropriate checkboxes in order to disable or enable background DRC or other background operations.

4.13.5 Setting the DRC options

With the DRC... command, you can set some characteristics of the design rule checker interface.

The DRC options are specified using the dialog shown to the right. Most of the options are self-explanatory, except, perhaps, for the Size of the DRC increment area. This value specifies the maximum width and height of the area that is being checked in the continuous checking mode. In order to provide a quick response to your actions, e.g., mouse clicks while the cursor spells DRC, this value should not be too large, since once a check has been started in a certain area, it has to be finished before the continuous checking mode is interrupted. On the other hand, making this value too small results in a quick response to interrupts but also in longer overall checking times due to the fragmentation of the area that needs verification.

Uncle will not accept time-out values smaller than 1 second, except for the Scan Errors time-out, which can be set to 0; the error blinking time provides about one second delay, anyway. The DRC increment area cannot be smaller than four times the largest spacing/width/overhang value declared in the design rules. If the OK button is clicked in an attempt to set invalid values, the dialog will reappear with values reset to the most recent valid ones.

With the checkboxes at the bottom of the dialog, you can set up the exact DRC mode of Uncle to be used upon the application startup; the modes corresponding to the checked boxes will be activated without the need to select them from the DRC menu.

Remark: In Uncle 1.8 hierarchical checking is not available. Therefore, the corresponding checkbox cannot be checked.

4.13.6 Customizing CIF format

CIF 2.0 (Caltech Intermediate Form) is one of the standard layout description languages. You can use it to transfer Uncle layouts to other CAD systems. Although Uncle produces CIF files which follow the CIF standard, other CAD systems may require some format adjustments in order to interpret Uncle CIF files correctly. For example, other systems may limit the length of cell names, may accept uppercase or lowercase characters in names only etc. The CIF format options dialog shown to the right allows to determine some details of the format of CIF files. Choose the CIF format... command to set these options.

The upper part of the dialog contains checkboxes which define the format of subcell names. If none of these boxes is checked, Uncle uses cell file names as the subcell names in CIF files. Most of the options are self-explanatory.

The Force unique names box should be checked if any of the other boxes affecting cell names is checked. For example, if the cell contains two subcells named “Subcell1” and
“Subcell2” and the name length is limited to 6 characters, both names will be truncated to “Subcel” and will become identical. If Uncle is instructed to enforce name uniqueness, it will change one of these names. If the Include original names as comments box is checked, original names will be included as comments in the CIF file.

The lower part of the dialog contains other options. Some CAD systems require that the top cell in the hierarchy is called at the end of the CIF file (the “C <cell number>” CIF command). Other systems do not accept this call. By default Uncle includes this CIF command. Check appropriate box if you do not need it. Another checkbox can be used to skip labels. Label formats may vary and can be determined in the technology description files. If the format defined in the technology file is not appropriate for your purpose, you may want to ignore labels instead of editing their format. Some CAD systems accept labels only if they are assigned to a special layer usually named TEXT or LABEL or something like these. If you check the Add TEXT layer for labels checkbox, an extra mask named TEXT will be introduced and all labels will be assigned to it. The name of the special layer is editable; you can change the word TEXT to LABEL or anything else. If you dismiss the dialog with the Make default button, this name will be stored in the preference file together with other settings.

The remaining two checkboxes instruct Uncle to use commas and slashes wherever appropriate. Normally Uncle uses only spaces, linefeeds and semicolons as separators in CIF files, but commas and slashes improve readability of CIF files. Some CAD systems may need these separators in order to read CIF files properly.
5. Technology Edit Mode Reference

The Technology Edit Mode is used to create and modify technology description files for use by Uncle. Only one technology can be edited at a time.

This chapter gives you information that is necessary for understanding the way Uncle utilizes technology description files. For clarity of presentation, most of the examples are based on a simple NMOS technology with seven technological masks:

- The locos mask, frequently called the mask of diffusion, or a mask of active areas. The name of this mask is an acronym for LOCal Oxidation of Silicon. This mask defines areas that will contain a thick layer of insulating silicon dioxide; the diffusion of dopants that will create sources and drains of transistors may occur only in those parts of the remaining areas that are not covered by gate oxide.
- The implantation mask, which defines areas where depletion–mode transistors will be fabricated. In the remaining areas, only enhancement–mode transistors can be made.
- The polysilicon mask, which defines areas where the polysilicon layer will be deposited.
- The buried contact mask, which defines diffusion–polysilicon contacts.
- The metal mask, which defines areas where a layer of metal will be deposited.
- The cut mask, which defines openings in the silicon dioxide through which metal–diffusion contacts and metal–polysilicon contacts will be made.
- The overglass mask, which defines openings in the layer of passivating silicon dioxide that is usually deposited over integrated circuits to protect them from external chemical influences; through these openings, connections are made that provide a power supply to the integrated circuit, supply the input signals, and convey output signals to the outside.

You can find detailed descriptions of NMOS technology in many VLSI textbooks.

Uncle is not oriented towards any particular technological process used for manufacturing integrated circuits; however, it does have some built–in information about planar technology. This information is of a general nature and is applicable to all planar technologies; you have certainly already found out that the entire user interface in Cell Edit Mode is designed for handling planar layouts. All information specific to technological processes is read by Uncle from technology description files.

At any time, there is one technology that is stored within the Uncle application. This is the default technology, which is used whenever Uncle is started up alone. You can tell Uncle to replace the default technology with one you prefer.

There is no unique representation of a given technological process in the form of Uncle technology.

In Uncle 1.8, the technology description is composed of five separate but interrelated parts: layers, planes, devices, masks and formats.

Layers

From your experience with the Cell Edit Mode of Uncle, you may have intuitive knowledge of layers. Layers are abstract, symbolic representations of certain areas of integrated circuits that differ in electrical properties. Layers are used for drawing layout features in the Cell Edit Mode of Uncle. They differ from the masks, which are used in the IC manufacturing process. For example, the layer of polysilicon defined in the nmos technologies supplied with Uncle corresponds only to the polysilicon interconnections, and the polysilicon gates of transistors do not belong to the polysilicon layer but to the transistor or depletion transistor layers. The mask of polysilicon is created by Uncle based on the information contained in the technology file. The polysilicon mask in nmos is simply the union of all shapes contained in the polysilicon, transistor, depletion transistor, poly_diff buried, and contact to poly layers.

Technologies defined for Uncle 1.8 may have up to 48 layers.

Planes

In the Cell Edit Mode, you never had to deal explicitly with any information regarding planes. If you intend to edit technologies, however, defining the planes will probably be your most time-consuming task. Planes are data structures that contain all information used by Uncle to determine how layers interact with each other. Planes can be visualized as being different levels of the IC structure.
Usually, a plane contains information about masks that directly interact with each other when overlapped. For example, in NMOS technology the mask of locos overlapping the mask of polysilicon may create transistors; therefore, the information about interactions among all layers related to these two masks is stored in a single plane. These layers are: diffusion, polysilicon, transistor, contact to diffusion, contact to polysilicon, and buried contact. As another example, the mask of metal does not directly interact with transistors and diffusion which compose the major part of the mask of locos. Therefore, the data about layers related to metal and diffusion masks are stored in separate planes. Since both metal and locos interact with contacts to diffusion, some interactions to which these contacts may be subject are stored in the same plane with diffusion and polysilicon, and others are stored in the plane with metal.

The size of the layout representation in computer memory is related not only to the number of layout features but also to the number of interactions defined in the Uncle planes. Whenever two interacting layers intersect, several new units of layout information may be created. The reason for this is that, in the internal representation in Uncle, shapes drawn on interacting layers belonging to the same plane may abut but never overlap each other. Thus, drawing a new shape may result in splitting the ones already existing. For example, recall the initial activities described in the First Session chapter. The first shape drawn, a \(6 \times 6\) rectangle on N–diffusion layer, was represented in Uncle as a single rectangle. After it was overlapped with a \(2 \times 10\) polysilicon rectangle to create a n–channel transistor, the internal representation of this transistor consisted of five rectangles: two polysilicon ones, two N–diffusion ones, and one n–channel transistor rectangle. The existing N–diffusion rectangle was split into three, one of which became a n–channel transistor. The newly drawn polysilicon rectangle was analogously split into three, one of which became a n–channel transistor exactly coinciding with the one resulting from the N–diffusion and needed not be entered into the layout representation.

It is important to remember that a plane can contain only one layer at any location. Interacting layers belonging to the same plane may abut but never overlap each other. As a result, it may sometimes be necessary to define additional composite layers in order to represent intersections of simple layers. For example, imagine a CMOS technology with two metal layers, metal 1 and metal 2. If both are assigned to the same plane, it will also be necessary to define a composite layer representing intersection of these metal layers, i.e. a layer that represents metal 2 overlapping metal 1.

It is entirely up to you to decide which interactions should be stored in the same plane and which ones can be stored in separate planes. Ultimately, all masks interact with each other indirectly, and it is possible to store all interactions in a single data structure. It is also possible to store each mask in a separate layer and disregard all interactions. In the first of these extreme cases, the table of interactions would grow to huge dimensions, and the layout representation would occupy a large amount of computer memory. In the second case, the memory would be minimally utilized, but any operations requiring information about layout interactions would be very time-consuming or impossible. Finding a good tradeoff between these two extremes is the task of the person who writes Uncle technology.

The maximum number of planes in Uncle 1.8 is 8.

**Devices**

As you may know from the Cell Edit Mode, a device is an arrangement of layout features that can be described with two parameters. The technology definition tells Uncle what shapes compose each device type, on which layers they are, and how to calculate these shapes based on the two parameters entered with the mouse.

The maximum number of devices in Uncle 1.8 is 8.

**Masks**

This part of technology definitions provides Uncle with information about how layers are grouped to create technological masks used for IC fabrication. All masks defined in this part are called Uncle masks.

The maximum number of masks in Uncle 1.8 is 48.

**Formats**

This part of the technology definitions contains information about the Uncle masks that should be output in each of the available formats (CIF, Magic, Electromask, GDSII), as well as the mask names used in the output files. Some of the mask formats may remain undefined.
Each part of the technology description is edited in a different type of window. The remainder of this chapter tells you how to enter the Technology Edit Mode of Uncle, how to open and save technology description files, and then describes these five types of windows. You will also find some additional information about the internal workings of Uncle that should be helpful in creating efficient technology descriptions.

Editing technology descriptions includes the specifications of design rules. Although, at the first reading, some issues related to design rules may not appear very clear, you will probably find that the actual behavior of Uncle closely follows the intuitive meaning of all design rules.

Remark: The internal format of technology files in Uncle 1.8 is enhanced in comparison to the format used by versions of Uncle older than 1.3, in order to facilitate definition of the state-of-the-art complex submicron technologies. As a result, technology files prepared by Uncle 1.8 will not be readable by Uncle versions older than 1.3. However, old technology files are still readable by Uncle 1.8. When Uncle 1.8 encounters a file in the old format, it converts the data to the new format automatically. If you save the converted technology file, it will no longer be readable by Uncle versions older than 1.3.

5.1 Starting up Uncle in Technology Edit Mode

Uncle starts up in Technology Edit Mode if it is invoked to open a technology data file.

To open an Uncle technology data file from the Finder:

- Select in Finder one or more technology data files and open them using one of the three methods described in chapter 4.1 for starting up Uncle.

After closing the initial information dialog, all selected technology files will be read in. Their names will be added to the Technology menu.

If you have started Uncle in Cell Edit Mode, choose the Technology Edit command from the Menu to switch to the Technology Edit Mode.

5.2 Creating, opening and saving technologies

Opening and saving adhere to the Macintosh standard. This chapter describes some additional messages that may appear on the screen while opening and saving technologies.

5.2.1 Creating new technologies

To create a new technology, choose the New... command from the File menu or type the key. A new technology window will be opened. See Section 5.3 to learn how to edit a new technology. It is also possible (and sometimes easier) to create a new technology by making a copy of existing technology file, opening and editing it.

5.2.2 Opening existing technologies

To open a technology:

- Choose the Open... command from the File menu or type the key.

The Open command displays a standard dialog box used to select the name of the technology from a scrollable list. Only files that contain technology descriptions in Uncle format can be opened; other files are not displayed in the list.

After reading a technology file, the name of the technology is appended to the Technology menu. A technology window for changing the general parameters of the read-in technology is opened only after you select the technology name from the Technology menu. The Layers, Planes, Devices, and Masks menus are filled with names of the corresponding entities defined in the opened technology. Only those menus that contain one or more names are enabled.
5.2.3 Saving technologies

To save the currently edited technology:
- Select the currently edited technology from the Tech menu.
- Click the Verify & accept button.
- Select the Save command from the File menu or type the $S key.

The Save command writes to the disk the currently edited technology, provided it is verified as correct. If the currently edited technology is the default technology, a dialog box will appear, asking where to save it.

Possible messages:

Before technology is saved, you must verify its correctness. If the technology is not fully defined or is defined incorrectly, an alert will appear containing a description of the problem. Possible problems:
- If there is no active window, or if the currently edited technology has not been changed since it was saved, the Save command is inactive and typing $S will produce only a warning beep. The command may not be active after you change the technology; you should always click the Verify & accept button before attempting to save the technology.

Remark: Files produced by Uncle in Technology Edit Mode appear with the icon shown to the right.

- In Technology Edit Mode, the consistency of the design rules is not fully verified before writing the technology file. The verification is limited to assuring that there are no nonsensical design rules that could cause a crash in Cell Edit Mode. Currently, it is possible to declare redundant or superfluous rules.

5.2.4 Manipulating technologies in Technology Edit Mode

To set the default technology in Technology Edit Mode:
- Pull down the File menu and move the pointer to highlight the Default tech command. A submenu with technology names will be shown to the side of the File menu. Choose the desired technology from this submenu.

Possible messages:

You will always be asked to confirm the default technology.
If there is no space on the disk to set the new default technology, the previous default technology will be restored and an information alert will be displayed.

Alternative methods for setting the default technology.
- Enter the Cell Edit Mode and set the default technology as described in the Cell Edit Mode Reference.

Possible problems:

If the currently edited technology is not present in the displayed submenu, verify its correctness as described in the Technology Dialog section. Only correct technologies can be made default, and Uncle checks the correctness of a technology only upon request, or when you close the currently edited technology.

Remark: Recall from the Cell Edit Mode Reference that each time a default technology is changed, Uncle modifies itself. Therefore, the disk with the Uncle application must not be write-protected.

5.3 Windows used for editing technologies

There is a special type of window in Uncle for editing different types of data stored in the technology description. All items in these windows are described in detail in this chapter.
You may have only one Technology Window open at any time. The number of Layer, Plane, Device, Mask, and Format Windows you can open depends on the data in the Technology Window. To open a window, you should choose its name from the appropriate menu.

### 5.3.1 Technology Window

The Technology Window is used to declare the number of planes, layers, masks, and devices available in the given technology and the size of the \( \lambda \) unit. An example Technology Window is shown to the right.

The numbers of planes, masks, and devices are entered in the appropriately labelled boxes. The number of layers is entered in two components, the numbers of palette (simple) layers and pop-up (composite) layers. The limits on these values are as follows:

- The total number of layers must be at least 1 and no more than 48.
- There must be at least 1 and no more than 8 planes.
- There must be no more than 8 devices and 48 masks.

If you enter a number that exceeds one of the listed limits, a beep will sound, and the value in the box will be reset to the most recent legal value.

#### Remark:
The order of layers in the **Layers** menu is not entirely arbitrary. Layers should appear in the order dictated by their interactions. If a layer \( C \) results from superposition of layers \( A \) and \( B \), these layers should appear in the **Layers** menu before layer \( C \).

Whenever you decrease the number of planes, pop-up layers, masks, or devices, the corresponding menu will be shortened to the appropriate number of items. If you decrease the number of simple layers, the vacated positions in the **Layers** menu will be filled with the names of composite layers, taken from the end of this menu. The names of the discarded items will be deleted from any lists present in any windows. Any open windows corresponding to the deleted items will be closed. If you unintentionally decrease any of these numbers, you can type in the previous value and all discarded items will reappear; the data related to these items will be unchanged.

#### Remark:
Before decreasing the number of layers in a Technology Window, make sure that the layers that will be discarded are not assigned to any planes (see section 5.3.2) and that there are no design rules that involve the layers to be discarded.

Whenever you increase the number of planes, composite layers, masks, or devices, the corresponding menus will be extended to the appropriate length. If you increase the number of simple layers, an appropriate number of composite layer names will be moved to the end of the **Layers** menu and the vacated places will be assigned to the new simple layers. Unless you have previously discarded some of these items, the new items will all be named ‘???’.

The value of \( \lambda \) entered in the text-edit box is used for the output of the circuit masks in 'CIF' format. Any positive value is legal. You can define the value of \( \lambda \) either in mils or in microns by clicking the appropriate control next to the box containing the value of \( \lambda \). Whenever you click one of these controls, the value displayed in the box is recalculated in new units. Only the first three digits after the decimal point are displayed.

#### Remark:
Internally, the \( \lambda \) value is always stored in centimicrons.

The **Verify & accept** button is used to confirm the entire technology definition. Uncle checks that the data you entered is consistent. If anything wrong is found with any layer, plane, mask, device, or format, an informative message will be displayed.

The **Change name** button will display a dialog for changing the technology name. It is not possible to change the name of the default technology with this button. This shall be rectified in future releases of Uncle.

To change the name of the default technology:

- Open the default technology for editing by choosing its name from the **Technology** menu.
5.3.2 Layer Window

The layers defined here are used for drawing in the Cell Edit Mode of Uncle. Layer windows are opened by choosing the appropriate layer name from the Layer menu. An example layer window is shown to the right.

The scrollable list of all planes defined in the technology is used to declare the planes containing the given layer, highlighted in the list. The highlighting is done by clicking the desired plane name. Clicking a plane name results in appropriate changes of all lists contained in Plane Windows, described later. Planes containing the given layer are numbered starting from zero; the sequence of numbers is the sequence in which the planes were selected in the list. The first plane chosen is called the home plane of the layer and has special significance, as described later in section 5.3.3. Whenever a layer is painted or erased, the possible interactions in various planes are scanned and executed from the highest numbered plane down to the home plane of this layer. The plane ordering may be different for different layers.

The right part of the window contains controls for describing the layer appearance on color and black-and-white Macintosches.

The On color Macintosches: pop-up menu contains four items that tell the general appearance of the layer. These items are:

Solid

The layer should be displayed as a uniformly colored area. Solid layers will appear transparent: whenever two solid layers overlap each other, the resulting color in the overlap area is the composite of the overlapping colors. For example, overlapping solid green diffusion with solid red polysilicon results in a brownish-green transistor.

Stipple

The layer should be displayed as a stipple pattern, possibly colored. Stipple patterns are transparent only in the white part of the pattern. The colored pixels of the pattern replace any solid and/or stipple colors that may have existed before drawing the pattern.

Solid+stipple

The layer should be displayed as a stipple pattern on a transparent solid background. The solid and stipple components behave as described above. This type of layer representation may be useful, e.g., to distinguish two layers that have similar properties. For example, diffusion P+ could be displayed in the same color as diffusion P, with the added stipple that is identical to the pattern used to represent the P–well.

Dithered

Reserved for future versions of Uncle.

Arbitrary numbers of solid (transparent) layers may be requested for a given technology. The actual number of layers that will be displayed in this manner will be determined by Uncle dynamically, based on the color mode of the Macintosh that is set via the Control Panel. The larger the number of colors available on the monitor, the larger the number of layers that can be displayed as solid: approximately half of the available colors are reserved for display of solid layers, and the other half are reserved for display of colored patterns. Solid colors are assigned to layers based on their sequence in the list of layers. Layers that you prefer to see in solid colors whenever possible should be placed early on this list.
If a layer is requested to be displayed solid, and, due to the monitor setting, there is no transparent color available for it, it will be displayed in the stipple pattern specified for black-and-white operation instead. The stipple will be displayed in color, if possible; this color is a composition of the stipple and solid colors.

The **Solid color** button is used to invoke a standard Color Picker dialog to declare the color that should be used to display the layer on color Macintoshes. This button is not active if the layer is to be displayed in **Stipple** mode only, or if the **color union** flag described later is set.

The **Stipple color** button is used to display a dialog to declare the color that should be used to display the stipple pattern representing the layer on color Macintoshes. This button is always active.

The square above the **Stipple color** button is used to edit the layer pattern. The square represents an 8x8 bits pattern. The editing is similar to the 'Fat Bits' mode of MacPaint. Clicking the mouse button while the pointer is over a white bit turns this bit black; dragging the mouse without releasing the button will turn black all bits over which the pointer passes. Clicking and/or dragging over black bits makes them white. This stipple pattern is used in the black-and-white mode of Uncle to display the layer, as well as for creating the layout pictures exported via the Clipboard and for printing layouts directly from Uncle.

The scrollable list of layers to the right of the pattern edit control is used to select layers called component layers whose appearance characteristics should be inherited by the given layer. The component layers are also used by Uncle to determine the default results of layer interactions, as described later in section 5.3.3.2.

The meaning of the four layer appearance flags listed above the list of layers and the pattern edit control is as follows:

- **framed** flag: if this flag is set, the shapes drawn on this layer will appear outlined; otherwise, the layer will be shown only as a stippled shape. Framed layers are displayed more slowly than those without the frame, but they look better. The **framed** flag is automatically set whenever one of the component layers has this flag set. This flag is ignored if you are using your Macintosh in a color mode.

  Remark: If you define the “substrate” layer which has a special meaning and special properties (see Section (3.2.2)), it should be defined in the following way: no pattern (i.e. no black pixels in the pattern edit control), solid color set to pure white, and the **framed** checkbox checked. Layers defined in such a way are displayed as white framed areas regardless of the display mode (black and white or color).

- **crossed** flag: this flag is set for those layers that should be displayed with an ‘×’ painted across their areas. Usually, such layers are contacts. The **crossed** flag is automatically set whenever one of the component layers has this flag set.

  Remark: Layers for which the **crossed** flag is set may be displayed in a manner revealing the internal data structure used in Uncle. If a uniform layer area appears with many crosses painted in it, you can use the **Compact data** command to make the layout look neater.

- **stipple union** flag and **color union** flag. The checkboxes used to set these two flags are active only if at least one layer is selected in the list of component layers. The stipple pattern and/or color used to display the given layer will be obtained as the union of patterns and/or colors used for the layers selected in this list, provided that the appropriate flag is set. For layers with the **stipple union** attribute, the control for setting the stipple pattern is inactive and is used only to display the resulting pattern. For layers with the **color union** attribute, the button for setting the layer color is inactive.

  Remark 1: When Uncle determines which layers should be displayed in solid colors for any particular monitor setting, solid colors are assigned first to those layers that do not have the ‘**color union**’ attribute set. For a 2-bit color mode, only one such layer will be assigned a solid color. For 4-bit and 8-bit color modes, up to 3 and 7 such layers may be assigned solid colors, respectively.

  Remark 2: Usually, it makes no sense to select some layers in the component list and not to set any of the ‘union’ attributes.
The checkboxes in the upper left part of the layer window control the behavior of the given layer whenever it interacts with other layers:

- **messenger layer** flag: this flag is set for those layers that can have several meanings depending on the context of other layers present in the painted/erased area. Typically, such layers are contacts. See also section 5.3.3.1 for more information about the meaning of the messenger layers.

- **do not export color** and **do not export pattern** flags: whenever one of this flags is set, the corresponding characteristic is not inherited by other layers containing the given layer as one of the components. Note that only inheritance of colors and stipples can be disabled, while the inheritance of the **crossed** and **framed** flags is always enforced. In the technologies supplied with Uncle, the **do not export pattern** flag is used to disable the inheritance of the solid black pattern of contacts, while enabling the inheritance of the **crossed** flag associated with contacts.

The remaining layer flag is the **accepts labels** flag: setting this flag indicates that the layer name can be displayed in the pop-up menu used to select layers to which a label should be attached (see Section 4.7). Uncle writes labels in Magic, CIF and GDSII formats so that they can be attached to the electrical nodes extracted from the circuit layout description.

The **Extractor...** button is reserved for the future versions of Uncle.

The **Verify & accept** button is used to confirm the layer definition. If anything is wrong, an informative message will be displayed.

The **Change name** button will display a dialog for changing the layer name. If the layer name is changed, it will be immediately updated in all lists and menus in which it occurs. The layer name must not contain any of the ',', '! (exclamation point), * (asterisk), + (plus), – (minus), or ^ (caret) characters. They will be removed from the name if you use them.

Checking the **Min width** or **Min spacing** checkbox indicates that the layer specified in the window title should be checked for compliance with the minimum width or minimum spacing rules, and displays a box in which an appropriate value in \( \lambda \) can be entered. Additionally, the **Min and max** checkbox indicates that the minimum width is also the maximum width. When this box is checked, the only valid shape on the layer is a square. Such rules often apply to contacts.

### 5.3.2.1 Design rules associated with a layer

The **DRC details** button displays an additional dialog for declaring certain relationships between the given layer and other layers.

A sample appearance of the **DRC Details** dialog is shown to the right. The scrollable list of equivalent layers is used to select the layer that should be treated as the given layer (in the example dialog, this is diffusion) for minimum width checks. All equivalent layers are allowed to abut and are treated identically while checking for the particular width and spacing rules.

**Layer equivalence**

The following example illustrates how equivalent layers are utilized.

Assume that diffusion requires minimum width of \( 2 \lambda \) and consider a \( 1 \lambda \)-wide notch of diffusion extending from a contact to diffusion area. If checked without considering its adjacency to the contact, this notch would be considered illegal (too narrow). However, the diffusion is implicitly present within the area containing a contact to diffusion, and the pictured diffusion notch is perfectly legal. In order to avoid false violation reports while checking such configurations, the ‘contact to diff’ layer should be treated as if it was composed of diffusion. Note, however, that when checking for the minimum width of a contact to diffusion, which should be at least \( 4 \lambda \), the diffusion layer is not equivalent to the contact. Thus, the equivalence relation specified in the dialog describing the diffusion works only while checking the diffusion.
Spacing/width inheritance

If any of the layers declared to be equivalent to the given one does not have its own width or spacing requirements, it will inherit the requirements of all layers to which it is equivalent.

Consider again the contact to diffusion. It is perfectly legal to abut two contacts to diffusion or to place them within 1 λ of each other, provided that the space between them is filled with diffusion and metal (upper figure). Therefore, there is no particular minimum spacing requirement between these contacts. However, these contacts implicitly contain metal and diffusion, both of which require minimum spacing larger than 1 λ. If the space between the contacts does not contain metal or diffusion (lower figure), then the spacing rules for either metal or diffusion will be violated. Thus, the contact to diffusion should be checked for spacing rules declared for both metal and diffusion: this is accomplished by declaring it equivalent to either of these layers (Note: not by declaring these layers to be equivalent to the contact to diffusion!) and then leaving the Min spacing control for the contact to diffusion unchecked. This will automatically imply that spacing is required between the contact to diffusion and metal, and between the contact to diffusion and diffusion (unless they abut).

Spacing between the given layer and other layers

If the given layer requires spacing to other layers, the Requires spacing to other layers control should be checked. This will display another list of layers; selecting a layer from this list displays a box in which the required spacing value can be entered. Only proper spacings greater than zero will be verified: the layers that require proper spacing from the given layer are marked on the list with a bullet character, ‘•’. If layer A requires some spacing to layer B, it is not necessary to declare that B requires a spacing to A; this would only double the number of checks without discovering any new violations.

You can use the DRC Details dialog to request that spacing between some equivalent layers be different from the one declared in the Layer Window or the one that is inherited.

Spacing/width inheritance revisited

A concise statement of the inheritance of design rules is as follows:

If layer A has no minimum width declared and if A or any layer equivalent to A is equivalent to layer B, which does have a minimum width declared, then A should be at least as wide as B.

If the minimum spacing between two layers A and B is not declared explicitly, then the largest spacing value between any pair of layers C and D is used, where A is equivalent to C and B is equivalent to D.

5.3.3 Plane Window

The information about layers that interact with each other is entered in Plane Windows. An example plane window is shown below. In addition to the Verify & accept and Change name buttons, each Plane Window contains three lists and several controls used to define interactions among all layers contained in the given plane.

---

1) A and B can be identical, in which case the minimum spacing declared in the Layer Window is used; otherwise, the minimum spacing declared in the DRC Details dialog for either A or B is used.
The **Verify & accept** button is used to confirm the plane definition. If anything is wrong, an informative message will be displayed. If the plane definition is found to be correct, the **Verify & accept** button becomes inactive.

The **Change name** button will display a dialog for changing the plane name. If the plane name is changed, it will be updated in all lists and menus in which it occurs.

The remaining items in a Plane Window are used to define interactions among layers present in the given plane. Before describing these items, the processes of painting and erasing are discussed.

5.3.3.1 Painting and erasing in Uncle

If you request that some area be painted with some layer, called the operator layer, Uncle first determines what layers exist in the painted area. The painting is then done separately for each uniformly painted area. Depending on the operator layer, Uncle proceeds in one of two possible ways, always scanning the planes containing the operator layer in the reverse order of the plane numbering in the operator layer window. The last scanned plane is the home plane of the operator layer.

- For operator layers with the messenger attribute, if the result of an interaction of the messenger layer with the preexisting layer in some plane is the same messenger layer, the preexisting layer is not changed, and Uncle proceeds with the next plane. The only exception to this rule is the home plane: if the result of the interaction is the same messenger layer, the painted area assumes the type of the messenger layer. In all other cases, i.e., when the result of the interaction is some other layer, Uncle interrupts the scanning of the planes, and, if the result is non-empty and different from the preexisting layer, Uncle paints the entire affected area with this resulting layer.

- For operator layers without the messenger attribute, Uncle does not stop scanning the planes; also, when the result of painting the preexisting layer is the same operator layer, the painted area becomes of the operator layer type. Otherwise, if the result is different from the preexisting layer, Uncle paints the entire affected area with this resulting layer. This repainting is done before proceeding with the next plane for the operator layer.

As an example, consider painting the contact layer in n-scmos technology. The contact layer occurs in all four planes, in the following sequence: 'metal2', 'metal1', 'poly+diff' and 'wells+diff' (home plane for the contact layer).

- In the 'metal2' plane, the result of painting 'contact' over 'metal2' is 'via', which then is repainted and propagates also to the 'metal1' plane. The result of painting 'contact' over empty space is 'contact'; this means that the space will remain empty, and the painting will propagate to the 'metal1' plane. Finally, if the 'contact' is painted over anything else ('via', 'overglass' or 'pad'), the result does not change the preexisting layer and the painting immediately stops.

- In the 'metal1' plane, painting stops if the 'contact' is painted over any of the contact-type layers and propagates to the 'poly+diff' plane through any areas containing 'metal1' or empty.

- In 'poly+diff' plane, painting 'contact' over any diffusion-type layer creates a contact to this diffusion, which then propagates back into the 'metal1' plane and also to the 'wells+diff' plane. Painting contacts over transistors is illegal, and the painting stops there immediately. Painting 'contact' over polysilicon results in a 'contact to poly' which propagates back to the 'metal1' plane, and painting it over empty areas propagates to the 'wells+diff' plane.

- Finally, in the 'wells+diff' plane, painting contact over empty or P–well areas results in a 'contact to P–plus', and painting it over N–well produces a 'contact to N–plus'. There is no interaction resulting in the 'contact' layer in its home plane; therefore, pure 'contact' will never be observed in the layout.

As another example, consider painting 'N–well' over 'N–diffusion'. 'N–well' occurs only in the 'well+diff' plane, and the result of this painting is 'P–diffusion'. This results propagates to the 'diff+poly' layer, where the preexisting 'N–diffusion' is changed to 'P–diffusion'. Since a
layer change has occurred, the entire affected area is repainted again with ‘P–diffusion’, which this time does not introduce any more changes.

For more examples, please refer to the appendices describing the technologies supplied with Uncle.

The process of erasing is somewhat different. Using the table of interactions, Uncle determines the result of subtracting the operator layer from the layers existing in all planes containing the operator layer. In addition, the implied subtractor layer is determined from the table of interactions. The result of an implied subtraction is usually a messenger layer, which is used to carry the effect of subtraction to those planes that do not contain the operator layer. The implied subtraction layer is erased from the entire affected area. The process is iterated until the implied subtraction results become ‘empty’.

As an example, consider subtracting ‘metal’ from the ‘contact to diff’ area in nmos technology. From the table of interactions, the result of this operation in the ‘metal’ plane is ‘empty’ area. The implied subtraction result is the ‘contact’ layer. This layer is subtracted again, this time in both ‘poly+diff’ and ‘metal’ layers, resulting respectively in ‘diffusion’ and ‘empty’. In both planes, the implied subtraction results are now ‘empty’, and the erasure process terminates.

After each painting/erasing, Uncle checks all affected areas to find whether any of the resulting layers have the ‘invalid’ flag set. For any area with this flag, a message is displayed that informs you that the requested interaction between the layers violates design rules, and the preexisting layout is restored in all ‘invalid’ areas.

As an example, consider painting ‘contact’ over ‘transistor’. From the table of interactions, in the ‘poly+diff’ plane, the result is still ‘transistor’, but with the ‘invalid’ flag set. In the ‘metal’ plane, the result is ‘empty’ with the ‘invalid’ flag. You will see only one error report, though, regarding adding ‘contact’ to ‘transistor’. This is because only one design violation report is issued for any area, with reports of interactions resulting in non–empty layers having precedence over interactions resulting in ‘empty’ layers.

Remark: Special purpose layer “substrate” should not interact with any other layer. Therefore it is recommended to assign it to a separate plane.

5.3.3.2 Items for entering interaction tables

The Reinitialize button is used to reset all layer interactions. Clicking this button displays the dialog shown here. You are given a chance to cancel this action, to erase all layer interactions, or to set default interactions. The default interactions are inferred by Uncle based on the list of component layers used to determine the layer appearance. Depending on the particular technology, the default interactions may or may not be close to the intended interactions. In the nmos and n-scmos technologies supplied with Uncle, the default settings were correct respectively in about 90% and 85% of cases. The basic algorithm for finding the default interactions is as follows:

- Uncle determines all direct and indirect inheritances of layer appearances and finds transitive closures of the inheritance relations in each plane. For example, if a ‘contact to P’ inherits the appearance of ‘P–diffusion’, ‘contact’, and ‘metal1’, and ‘P–diffusion’ inherits the appearance of ‘diffusion’ and ‘N–well’, then ‘contact to P’ inherits also the appearance of ‘diffusion’ and ‘N–well’. The ‘do not inherit’ layer flags are disregarded for this operation. Transitive closures are found separately for all planes and are used to determine default interactions in these planes.

- Adding two layers creates a layer that inherits all components of the two layers. If there exists another layer that contains exactly all these components, this layer will be the result of the interaction. A similar rule is valid for subtraction of layers: the result of erasing layer B from layer A contains all components of A that are not components of B. The result is a layer that either contains exactly the result, or differs from it by one layer with a messenger attribute; in the latter case, the messenger layer becomes the implied subtractor layer. If no resulting layer is found, the result is deemed invalid and no layer change occurs.

- For the special case where the existing layer is a messenger layer, the result of adding another layer to this messenger layer is the same as if the operand was added to empty space. Note: messenger layers should not inherit appearances of other layers if the default interactions are to be determined correctly.
Example 1: In the nmos technology, the ‘transistor’ layer inherits the appearance of ‘poly’ and ‘diffusion’. Therefore, adding ‘poly’ to ‘diffusion’ or vice versa results in ‘transistor’, while erasing ‘poly’ or ‘diffusion’ from ‘transistor’ results in ‘diffusion’ or ‘poly’, respectively.

Example 2: In the n-scmos technology, the ‘contact to P’ layer is composed of ‘N–well’, ‘diffusion’, and ‘contact’ layers in the ‘wells+diff’ plane, and of ‘contact’ and ‘metal1’ in the ‘metal1’ plane. Subtracting ‘metal1’ from ‘contact to P’ initially has effect only in the latter plane: the result is ‘contact’, which is a messenger layer. Therefore, the final result in the ‘metal1’ plane is ‘empty’, and the ‘contact’ layer becomes an implied subtractor. This affects the ‘wells+diff’ plane, where after subtracting ‘contact’ from ‘contact to P’ we are left with ‘N–well’ and ‘diffusion’. These layers comprise the ‘P–diffusion’ layer, which is the default result of subtracting ‘contact’ from ‘contact to P’ in the ‘wells+diff’ plane.

Please refer to the appendices with the technology descriptions for some additional insight into the default interactions.

The three lists displayed in a Plane Window are used to select the existing, operator, and result layers. The three controls between the left and center lists are used to select superposition, subtraction, and implied subtraction interactions. The checkbox in the lower right corner is used to set the ‘invalid’ flag where necessary.

To define an interaction between two layers:
• Click the name of the existing layer in the leftmost list.
• Click one of the ‘+’, ‘-’, or ‘->’ controls to select respectively superposition, subtraction, or implied subtraction.
• Click the name of the operator layer in the middle list.
• Click the name of the resulting layer in the rightmost list.
• If necessary, set or reset the ‘invalid’ flag by clicking the ‘invalid’ checkbox.

Alternative method for selecting an existing layer:
• type or keys until the desired layer becomes selected.

Remark: The list for selecting the interaction results is shown only if some layers are selected in both of the other lists.

The most efficient way for entering interactions is to select the operator layer with the mouse and then to use the arrow keys to scroll through the list of existing layers, while selecting the results with the mouse.

If you hold down the key while clicking the result layer, a dialog will appear, asking you to choose one of three possible actions. You may declare that this layer will become the result of all interactions involving the current operand layer, or that it will become the result of all undefined-as-yet interactions involving the operand, or, finally, you may cancel this action.

The Plane Window contains two buttons invoking additional dialogs for design rule editing. The Overhang Rules and Generic Rules buttons are active only if the respective numbers of rules are declared to be greater than zero.

The numbers of the overhang and generic rules can be increased at will. New rules are initialized as invalid: they have to be edited before the technology description can be saved.

The overhang rules are edited in the dialog shown to the right. You can use the two browse controls, and to cyclically display all rules. The browse controls are active whenever the given plane contains more than one overhang rule. A click on a browse control confirms the changes made to the current rule. The Cancel button affects only the current rule and will not undo the changes made while browsing.

Layer equivalence in overhang
The overhang rule is explained in the dialog box. Only layers selected in the ‘Type B’ list are allowed to abut layers selected in the ‘Type A’ list. Any layer declared equivalent to some selected layer of type B (in the layer DRC dialog) that is not selected itself must not abut any layer of type B; other than that, its presence within the checked area is treated as if it was selected.

Example:
It is legal to position a contact to diffusion 1 λ away from a transistor, as shown to the right, but is not allowed to make it adjacent to a transistor. Therefore, only diffusion is selected as a type B layer. The 1 λ-wide area of diffusion separating the transistor from a contact does not fulfil the 2 λ required overhang rule by itself, but a non-abutting contact positioned as in the figure attributes to the diffusion overhang.

There are two flavors of overhang rules:
- A regular rule is verified only in the direction perpendicular to the boundary between the layers. Only transistor-type shapes can be verified with regular overhang rules.
- A surround rule requires that one layer be surrounded with another on corners as well as along edges. Surround rules can verify contact-type shapes.

To create a surround rule, the Surround checkbox should be clicked. The explanatory drawing in the dialog box will change as shown in the figure to the right.

Whenever any layer L is selected in any overhang rule on list A, only layers specified on the corresponding list B (or lists, if L is selected in several rules) and layers equivalent to L are allowed to abut L. This condition is checked only in those planes that contain at least one layer selected in list B in any rule that contains L in list A. To specify layers that are allowed to abut L but do not require any specific overhang, make an overhang rule with overhang value zero, which effectively permits adjacency.

Remark: any pair of (type A)—(type B) layers should be specified at most once in all overhang rules in all planes; otherwise, the enforced value of the overhang will be unpredictable.

Any rules that do not fall into one of the discussed categories can be entered as a generic rule.

The generic rules are edited in the dialog shown to the right. The browse controls work in the same manner as described for overhang rules and are active whenever the given plane contains more than one generic rule.

Each generic rule specifies up to six interacting sets of layers. Three of these sets, denoted in the dialog above as A, B, and C, occur in the plane which contains the rule. Each time any layer from set A abuts any layer from set B, a DRC area is created that extends from the A/B boundary in the direction of layer B (in the dialog: downwards). The extent of this area in the direction perpendicular to the A/B interface is equal to the value specified in the du field. The extent of this area in the direction parallel to the A/B interface is equal to the length of this interface. In addition, if the A/B boundary ends in a corner that contains any layer from the set C on the A side, the DRC area is widened by the value specified in the dh field. The DRC area is then checked for the required presence or absence of the layers specified in the sets Required, Prohibited, and Prohibited unless abutting; layers in these sets may occur in any plane.
Any of the previously discussed rules could be specified as a generic rule. For example, diffusion width could be checked with a generic rule that contains all layers containing diffusion in sets $B$ and Required, and all layers not containing diffusion in set $A$. However, the generic rules take longer to verify than specialized rules.

5.3.4 Device Window

To draw a device in Cell Edit Mode, you have to supply the device outline and device orientation. Two opposite corners of the device are distinguished: one of them is the device origin, and the other is the device destination (see chapter 4.6.3 for the definitions of these terms). The Device Window is used to describe the components of a device in terms of the device origin, destination and orientation. An example Device Window is shown to the right.

The Verify & accept and Change name buttons operate in the standard manner. You can click the first to confirm the device definition and to display a message if anything is wrong. Clicking the other will display a dialog for changing the device name. If the device name is changed, the appropriate item in the Device menu will be updated.

Most of the controls in the Device Window are text–edit boxes used to enter the parameters of the device. The Number of component rectangles box is used to enter the number of the device components. The Min $\Delta x$, Max $\Delta x$, Min $\Delta y$, and Max $\Delta y$ boxes are used to set the limits of the device outline dimensions. For vertically oriented devices, the $x$ coordinate is horizontal and the $y$ coordinate is vertical; for horizontally oriented devices, the $x$ coordinate is vertical and the $y$ coordinate is horizontal.

The square control in the lower right corner of the Device Window is used to edit the icon representing the device in the Device Palette in Cell Edit Mode. The operation of this control is identical to the control for pattern editing in Layer Windows, except that the square is 32×32 bits.

The remaining controls, grouped together within a rectangle entitled Definition of rectangle at its top, are used to define the components of the device. The components are numbered from 0 to (the number of components)–1. You can browse among the component rectangles by clicking the $<$ and $>$ controls. The rectangle whose number is currently displayed can be edited as follows:

All dimensions of the component rectangles are obtained by adding values entered in the $\Delta xo$, $\Delta xd$, $\Delta yo$, and $\Delta yd$ boxes to the appropriate coordinates of the origin and destination. For vertically oriented devices, the device outline is enlarged horizontally by $\Delta xo$ on the side containing the device origin and by $\Delta xd$ on the side containing the device destination. The $\Delta yo$ and $\Delta yd$ values are used to enlarge the outline vertically. For horizontal devices, the roles of $y$ and $x$ are swapped. The resulting rectangle is painted with the layer selected in the list of layer names.

To help you in declaring the component rectangles, the following figure shows all possible configurations of device origin and destination, for some positive value of $\Delta xo$, with $\Delta xd$, $\Delta yo$, and $\Delta yd$ equal zero. The rectangle that will be painted with the selected layer is shown drawn in thick dashed lines. The device outline is shown in thin solid lines, with the origin marked $\circ$, and the destination marked $\bullet$. 
There are four flags that can be set for each component rectangle to make its position asymmetrical with respect to the device outline. For example, the \texttt{\textit{\textsc{ayd added to origin}}} flag is set for those rectangles whose dimensions are independent of the y-span of vertical devices or x-span of horizontal devices and which should be placed in the vicinity of the device origin. A good example of such a rectangle is the buried contact in the depletion transistor with a contact, defined in the \texttt{nmox} technology. The remaining flags have analogous meanings. The figure below shows the result of setting one of the flags in a vertical device for a rectangle that has all \texttt{\textit{\textsc{dxo}}}, \texttt{\textit{\textsc{dyo}}}, \texttt{\textit{\textsc{dxd}}}, and \texttt{\textit{\textsc{dyd}}} equal to 1.

5.3.5 Mask Window

Masks defined here are technological masks, as opposed to the layers used for drawing the layout in the Cell Edit Mode of Uncle. The masks are defined based on the following operations on layers: inversion, union, intersection, exclusive-or, shrinking, and expansion. The formulas for obtaining masks are edited in Mask Windows, an example of which is shown to the right. The results of the possible operations on layers are visualized in an example of two shapes on layers A and B in the figures below.
The items in the upper part of the Mask Window are used to enter the formula for the mask, which is displayed in a large, scrollable text box occupying the lower part of the window above three buttons. Buttons NOT, AND, OR, and XOR are used to enter the inversion, intersection, union and exclusive–or operators, displayed in the formula as ‘!’, ‘*’, ‘+’, and ‘^’ characters, respectively. Buttons labelled with parentheses are used to insert parentheses into the expression for the purposes of grouping. The Layer button is used to enter the name of a layer selected in the scrollable list in the upper right corner of the window. Finally, the Inset button is used to insert the shrink/expand operator into the expression; the amount of shrinking/expansion must be entered in the text–edit box to the left of this button. In the formula, the shrink/expand operator is displayed as: ‘INSET(amount, object)’ to signify shrinking the given ‘object’ if the ‘amount’ is positive, or expanding the given ‘object’ if the ‘amount’ is negative.

Remark: In Uncle 1.8, there is no precedence defined for the operators. The operations group from right to left. You should use parentheses to achieve other desired groupings.

The Verify & accept button is used to confirm the mask definition. If anything is wrong, an informative message will be displayed. If the mask definition is found to be correct, the formula for the mask is redisplayed, with the parentheses showing the inferred precedence of operations. If the SHIFT key is depressed while the button is clicked, the expression defining the mask will be displayed fully parenthesized, showing exactly how the mask will be evaluated.

The Change name button will display a dialog for changing the mask name. If the mask name is changed, it will be updated in all lists and menus in which it occurs.

The Reset button is used to remove the entire mask formula.

The box in which the formula is displayed is not a text–edit box. You cannot enter any data into it by typing. However, you can select parts of the formula by clicking the mouse button while the pointer is over the desired selection point. Clicking and dragging can be used to select larger parts of the formula. The selection is always expanded to enclose entire layer names. The operators, parentheses and layer names are entered in place of the current selection. To remove the selected part of the formula, you can type the DELETE or BACKSPACE key while holding down the [SHIFT] key. Note that all other typing will be interpreted as being directed to the text–edit box containing the shrink/expand amount; therefore, only digits, backspace, the decimal point and minus characters will be accepted. All other characters typed on the keyboard will result in warning beeps.

5.3.5.1 Tips on defining masks

Definitions of masks that are simple unions of layers, perhaps with straightforward application of the shrink/expand operator, present no conceptual problems. For example, the mask of contact cuts in nmos technology is obtained by shrinking all shapes on ‘contact to diff’ and ‘contact to poly’ and taking the union of these. The corresponding formula is:

\[
\text{INSET}(1,\text{contact to diff}) + \text{INSET}(1,\text{contact to poly})
\]

Some masks, however, may be more difficult to define. For example, defining the implantation mask in nmos technology may not be straightforward if the design rules implemented in this technology require that implantation extends by 1 $\lambda$ in the direction of the polysilicon extension over the transistor channel, and by 2 $\lambda$ over the drain and source diffusion areas. The corresponding formula is:
The following figures show an example of evaluating this expression for some depletion-mode transistor. The layers used in Uncle are drawn in the following patterns: 
- diffusion,
- polysilicon,
- depletion transistor.

The first figure, shown to the right, presents the appearance of the example transistor in Uncle window. The subsequent figures show only the outlines of Uncle layers, with the result of the current evaluation overlaid on them in thick lines.

Another example of a mask that is not straightforward to define is the mask of P-select areas (also called P-plus) in CMOS technology. The P-select mask is used to determine those areas that should be doped with a p-type dopant. In particular, P-channel transistors, P-type diffusion, and contacts to P-wells should be placed within the P-select areas. The P-select should extend somewhat to the sides of the diffusion and contacts, so that a possible mask misalignment does not change the doping type. However, in some CMOS technologies a simple expression extending the P-channels, P-diffusion, and P-well contacts is not sufficient since it is permissible to make almost abutting contacts to P-well and to N-diffusion. In such an arrangement, the P-select border should be positioned mid-way between the two contacts.

The following figures show how to define the part of P-select contributed by contacts to P-well. The proper expression, assuming a 2-\(\lambda\) required extension, is:

\[
\text{INSET}(-2,\text{contact to P-well}*(\text{NOT}\text{INSET}(-2,\text{contact to N})))
\]

The first figure, shown to the right, presents the appearance of the example configuration of the two contacts in Uncle window. The layers used in Uncle are drawn in the following patterns: 
- diff N,
- contact to P-well,
- contact to N.

The subsequent figures show only the outlines of Uncle layers, with the results of selected evaluations overlaid on them in thick lines.

In some cases definition of a mask may be simplified if the "substrate" layer is used. This layer is by definition always present in the entire cell area. For example, a field implant mask necessary in some MOS technologies is defined as an inversion of the locos mask (also called active area mask or thin oxide mask). However, a simple inversion applied to the locos mask will not work: the resulting mask will cover the entire drawing area, i.e. it will extend from -32760 \(\lambda\) to +32760 \(\lambda\) in both directions. Usually this is not what you need.

If the "substrate" layer is available, the field implant mask can be defined as the union of the substrate layer and the inversion of the locos mask.
5.3.6 Format Window

Format Windows are used to declare the masks which should be output in each available format. An example Format Window is shown to the right.

In the right half of this window, there is a list of all masks available in Uncle. Masks to be output are chosen from this list. The masks selected for the output are marked with a '•' character.

The scaling factor is used to convert the dimension units used by Uncle, which are centimicrons, to the units expected in a given format. The actual meaning depends on the format:

• In CIF format, all coordinates and dimensions are divided by the value of the scaling factor, which is then used in cell headers. The only effect of the scaling factor is that the resulting description takes less space on disk. To scale the layout, change the value of the \( \lambda \) unit in the Technology Window.

• In Magic format, all coordinates and dimensions are divided by the value of the scaling factor. Normally, the scaling factor should be identical to the value of the \( \lambda \) unit expressed in centimicrons.

• In Electromask and GDSII formats, the scaling factor is disregarded.

The Select for output button is active if some mask that is not selected for output in the given format is highlighted in the list. Clicking this button will add the desired mask to the set of masks to be output. The window appearance will change, as shown to the right.

The Remove from output button is active if, in the list of masks, some mask selected for output is highlighted. A text-edit box for supplying the mask name is also shown in this case. The name of the mask in the output format should be entered in this box.

The Verify & accept button is used to verify the correctness of the format definition. If anything is wrong, an informative message will be displayed.

In CIF and Magic formats, additional buttons are present in the Format Dialog.

The Import as... button, present only in the Magic Format Dialog, is used to invoke an additional dialog that enables you to declare how the given Magic layer should be imported into Uncle. Clicking this button will produce the dialog shown to the right.

By selecting a name of Uncle layer and clicking the OK to import button, you tell uncle to paint a rectangle in the selected Uncle layer whenever a rectangle on a given Magic layer is encountered. After clicking the OK to import button, the dialog changes its appearance as shown in the next paragraph.

The clicked button changes into Do not import, the selected Uncle layer is marked with a bullet character, '•', and a text item appears. This additional text item allows you to bloat or shrink the Magic rectangle before importing it into Uncle. This may be useful, e.g., if Uncle technology uses contact layers that do not include metal/diffusion/polysilicon overlaps as is usually the case in Magic. A contact to polysilicon in Magic could be painted in Uncle as polysilicon and metal layers without shrinking or bloating, and as contact to poly after being shrunk by \( 1 \lambda \).
The CIF Format Dialog contains a **CIF Labels** button. Clicking this button displays the dialog shown to the right that enables you to set the desired style for labels in the CIF file. There are many label implementations in various dialects of CIF; the one shown here is used probably most frequently. The label dialog allows you to select one of eight possible sequences of label coordinates: you can request that the label be output as a point or as a rectangle, that the label text either precede or follow the label coordinates, and that the sequence of coordinates be either standard (first horizontal, then vertical), or inverted (first vertical, then horizontal). The format text itself is shown in the style of the C programming language: ‘%d’ is substituted by an integer value, and ‘%s’ is substituted by a string value. All other characters are copied verbatim. The format text is shown for your information only, it cannot be edited and is adjusted automatically as you change the desired style for labels.

The GDSII (also known as Calma) Format Dialog contains two additional fields named “Calma layer number” and “Calma data type”. In the GDSII format masks are identified with numbers, not names as in CIF. The Calma layer number is the number assigned to the mask selected for output. Since the GDSII format is normally used to export Uncle designs to other CAD systems, the mask number should correspond to the number required by the target system. The Calma data type should be set to 0.

5.4 Using menus in Technology Edit Mode

5.4.1 Apple menu

Apple Menu is used in an identical manner as in the Cell Edit Mode.

5.4.2 File menu

Menu **File** in technology edit mode contains commands for the management of the technology description files.

**New...**

*(keyboard equivalent ‘⌘N’)*

This command creates a new technology description file.

**Open...**

*(keyboard equivalent ‘⌘O’)*

This command opens a file with a technology description and adds it to the list of available technologies that is stored in the **Tech** menu. The currently edited technology is not closed.

**Close**

This command closes the active window or a desk accessory. A closed window can be opened again by selecting its name from the appropriate menu.

**Close all**

This command closes all windows, including desk accessories. A closed window can be opened again by selecting its name from the appropriate menu.
Save (keyboard equivalent ‘%S’)

This command saves the currently edited technology in a technology file. Recall that the default technology is stored in the Preference file. Therefore, if the currently edited technology is the default technology, a dialog box will appear, asking where to save it. This command is inactive if the technology has not been verified as correct.

Save As...

This command saves the currently edited technology, possibly giving it a different name. The Save as... command is not active unless the technology is verified to be correct. Technologies can be saved in two formats: Uncle format (binary) and Uncle for Windows format (text). Note that Uncle 1.8 can read only files in its native Uncle format. Uncle for Windows format is intended for transferring technologies to the Windows version of Uncle.

Save In ASCII...

This command saves the currently edited technology in a human readable form, as a text file. This file cannot be used by Uncle as a technology description file, its only purpose is to facilitate analysis and verification of the definition of the technology.

Make Default

This command shows a submenu of the currently open technologies, one of which can be chosen to be the default technology. Only the technologies verified to be correct are displayed. The next time Uncle is started up alone, it will use the default technology.

Page Setup...

Reserved for future versions of Uncle.

Print... (keyboard equivalent ‘%P’)

Reserved for future versions of Uncle.

Preferences...

Reserved for future versions of Uncle.

Quit (keyboard equivalent ‘%Q’)

This command quits Uncle, with the option to save any changes that were made.

5.4.3 Edit menu

In the Technology Edit Mode the standard editing commands are provided here for use with desk accessories and are not active if the front window is not a desk accessory. The only command active in the Technology Edit Mode is ‘Debug Technology’.

Undo (keyboard equivalent ‘%Z’)

Reserved for desk accessories.

Cut (keyboard equivalent ‘%X’)

Reserved for desk accessories.

Copy (keyboard equivalent ‘%C’)

Reserved for desk accessories.
Paste

(Keyboard equivalent ‘%U’)

Reserved for desk accessories.

Clear

Reserved for desk accessories.

Info...

(Keyboard equivalent ‘%I’)

Reserved for future versions of Uncle.

Debug Technology

This command toggles the technology debug switch on or off. The technology debug is effective in the Cell Edit Mode. If the technology debug switch is ‘on’, then whenever some area is painted or erased, a sequence of alert boxes is displayed, telling about each interaction between the layers that occurred on all planes.

5.4.4 Tech menu

The Tech menu contains names of the available technologies.

You can open a technology for editing by choosing its name from this menu. If any other technology was currently opened, it will be closed, with an option to save any changes that were made to it.

5.4.5 Layer menu

This menu contains names of the layers defined in the currently edited technology for drawing in the Cell Edit Mode of Uncle. Layers for which the names have not been defined yet appear as three question marks: ???.

Choosing an item from the Layers menu opens a window with the definition of the layer. If the layer has been already opened, the window containing it is brought to the front.

5.4.6 Plane menu

This menu contains the names of planes defined in the currently edited technology.

Choosing an item from the Planes menu opens a window with the definition of the plane. If the plane has been already opened, the window containing it is brought to the front.

5.4.7 Mask menu

This menu contains names of the masks defined in the currently edited technology.

Selecting an item from the Masks menu opens a window with the definition of the mask. If the mask has been already opened, the window containing it is brought to the front.

5.4.8 Format menu

This menu contains names of the output formats available in Uncle.

Selecting an item from the Formats menu opens a window with the definition of the appropriate output format. If the format has been already opened, the window containing it is brought to the front.
5.4.9 Device menu

This menu contains names of the simple devices available in the currently edited technology.

Selecting an item from the Devices menu opens a window with the definition of the device. If the device has been already opened, the window containing it is brought to the front.
Appendix A: Known bugs and problems

Although Uncle has been tested quite extensively under a variety of circumstances that are likely (and some not so likely) to occur in the normal program usage, it is still possible that some uncovered bugs will surface and try to bring your Macintosh down. Approximately 5% of the Uncle code is devoted solely to safeguarding against dire results of possible programming errors. Unfortunately, Uncle malfunctions may result not only from programming errors, but from various inits and system extensions that violate the guidelines of Macintosh programming.

Uncle has been tested on a wide variety of Macintosh models including the old Macintosh Plus, Macintosh SE and SE/30, Macintosh Classic, all Mac II and Mac LC models, most Quadras and Centris, almost all PowerBook models, and almost all Power Macintosh models. However, it was not possible to test Uncle on all possible hardware configurations including third party add-ons like CPU accelerators, non-Apple video cards etc.

In most circumstances, if a program malfunction occurs, Uncle will first display some information and then die peacefully, without taking down any other programs you may have running simultaneously. Such occurrences are rather unlikely, so please do not be alarmed.

As of now, authors of Uncle are aware of the following problems in Uncle 1.8:

• It is possible to define layer interactions so that a painting or erasing operation will result in an infinite loop and possibly a system error ID=28 (heap/stack collision). Due to the nature of the layer interactions, detecting such situations is rather difficult. If the above system error occurs during the normal operation of Uncle, you are advised to turn on the technology debug switch (see the Edit menu in Technology Edit Mode) and repeat the operation that caused the crash; you are likely to spot the interaction loop very quickly. Technologies supplied with Uncle will not cause this error.

• It is possible to create an infinite loop in subcell calls (for example cell A containing cell B as a subcell which in turn contains A as its subcell). This will result in a crash in some operations (expanding subcells, cell flattening).

• Saving an EXTREMELY big cell layout (occupying many megabytes of RAM) in CIF format may result in a crash due to heap/stack collision. It is very easy to avoid this problem designing big ICs in hierarchical manner.

• Attempt to print color layouts in grayscale mode on HP laser printers may result in a system crash (outside Uncle). The apparent reason for the crash is that some older HP drivers make extremely big spool files which cannot be handled correctly by the MacOS software. This problem does NOT occur with Apple LaserWriter printers and printer software. To avoid this problem, it is sufficient to set the printing mode to “black & white”, not to “color/grayscale” in the printer options when printing on black and white laser printers. (Grayscale printouts from Uncle, although possible, are not very useful anyway...)

In some circumstances you may notice two cursors in an Uncle cell window: the standard Macintosh arrow cursor and the Uncle cursor. This is not a bug in Uncle. Uncle always hides the standard Mac cursor when the Uncle cursor (sticking to the grid points) is in use. Unfortunately, some applications running in background simultaneously with Uncle may want to display the standard cursor (one such application is Microsoft PowerPoint). Should this occur, it is usually sufficient to move the cursor out of the Uncle window and back, and the second cursor disappears.

When Uncle is open but another application, e.g. a text editor, is active, Uncle does not redraw its windows. This is not a bug. Redrawing a cell window that displays a complex layout may require some time. It could be annoying to wait until Uncle redisplays its windows when another application is in use.

What happens if a bug occurs:

Should the unexpected and undesirable happen, you may find yourself looking at an alert such as the one shown to the right. This particular alert occurs after running a certain application which seems to clear the first 4 bytes of Macintosh memory.
Remark: Normally, no program is supposed to write into low memory locations. If you ever see ‘null location gone bad’, you can safely conclude that it represents a bug in some other program or Desk Accessory (perhaps running in the background), and you can click the OK button to resume Uncle operation. Since many program bugs manifest themselves by changing the contents of low memory locations, Uncle holds a constant watch over the first 4 bytes of memory and alerts you to any unexpected values therein. Uncle itself will never change this memory location.

Upon an encounter with a programming error, you have two choices:

1. Click the Cancel button to exit Uncle immediately and peacefully. Nothing serious should happen, but any changes to the layout that were not saved will be lost.

2. Click the OK button to resume the normal operation of Uncle. However, if the error is serious, it is possible that Uncle will crash, either alone (you’ll be notified that the Uncle application has unexpectedly quit), or with the rest of the Macintosh programs (this will be quite obvious).

The typical bugs manifest themselves with the ‘programming error’ dialogs producing the following messages:

- ‘Null location gone bad’ – click OK as this is almost certainly not Uncle’s problem. Unless the program that clobbered the null location has also written garbage over the memory that belongs to Uncle, everything should be fine.
- ‘Bad pointer’ error – this is displayed just before overwriting memory in undesirable places. It is highly unlikely that you will see this error. However, this error should never be ignored: always click Cancel and quit.

What happens if Uncle runs out of memory

Uncle should be quite robust in low–memory situations. If the amount of free memory falls below 128 Kbytes, you will be warned and advised to save the files. The low–memory warning is repeated once a minute. There are two variants of this warning, shown below:

After saving any changes, the variant shown on the left can be usually ignored to the extent of your patience with the repeated alert, as Uncle keeps extra amount of memory for emergency use that should be sufficient to cover most of the one–time memory demand increments. The variant shown on the right is more serious: the emergency space is gone and Uncle is likely to die if you keep editing your layout. In either case, you should immediately save your changes; there is very little demand for new memory during the save operations and it is unlikely that a save operation will fail due to the lack of memory.

Note 1: Uncle will warn you with the alert shown to the right whenever the emergency space is being released. After this, the total available space may exceed 64 Kbytes and you may not see the aforementioned low–memory alerts for a couple of minutes.

Note 2: Sometimes it helps to invoke the ‘About Uncle...’ dialog or to enter the Help Mode of Uncle (after you have saved your layout), or to invoke the ‘Compact Data’ command. If Uncle is truly hard–pressed for memory, it employs additional techniques that may succeed in releasing several Kbytes of space; however, unlike releasing the emergency ration, these techniques are not guaranteed to succeed.

If you continue to edit your layout despite the low–memory warnings, Uncle will eventually display the alert shown to the right and then quit peacefully, although without saving the recent changes.
Occasionally, Uncle may run out of memory so thoroughly that it will not be able to display the above alert; this has not been yet observed in normal operation.

Hints

If Uncle keeps running out of memory, you should probably increase Uncle’s memory allocation. In Finder, select the Uncle application while it is not running, and select the **Get Info** command from the **Edit** menu. Increase the number you see in the box entitled *Application Memory Size* or *Preferred Size*, depending on the version of system software.
Appendix B: Uncle on a PC

Uncle for MacOS on a PC

Uncle 1.8 will run correctly on PC-compatible computers with Executor® 2 installed. Executor® 2 is a Macintosh emulator. It allows to run Macintosh software (versions for Motorola 680x0 processors) and to write, read and format Macintosh HD (1.4MB) floppy disks. Versions of Executor for MS-DOS, Windows (all current versions) and Linux exist. Executor emulates MacOS 6.0.x, not System 7, and the Macintosh Finder is replaced by a substitute called Browser. Nevertheless, once Executor is installed and running you can install and run Uncle in the same way as on a Macintosh. Uncle works under Executor in the same way as on a Macintosh. You can also read and write Uncle files using original Macintosh floppies. On a good Pentium-based computer Uncle with Executor is almost as fast as on a Power Mac and faster than on most Motorola 680x0 based Mac models.

Executor assigns a set of its own preferences to every installed Mac application. They can be changed by invoking the Preference Panel which is a sort of Control Panel in Executor. Consult the Executor manual for details. The default preferences are OK for Uncle. For optimum performance set the Screen Updates switch to Normal and do not check the Flush Cache Often box. Recommended system version is 6.0.7. If you set the system version to 7.0 and newer, Executor will pretend that it is emulating System 7, but this may confuse Uncle in some situations because most functions of System 7 are not available under Executor.

Do not run Uncle 1.5x or older under Executor. All Uncle versions older than 1.6 are not fully compatible with Executor.

Important: to run Uncle version 1.76 or later with Executor, install Executor version 2.1pr7 or later. Earlier versions of Executor may have problems with Uncle installers and are not fully compatible with Uncle 1.76 or later. If you cannot install Uncle under Executor using the Uncle installer, you may install Uncle by copying Uncle application file and accompanying files from a Macintosh-formatted floppy disk.

To transfer files between a Mac and a PC running Executor use Macintosh-formatted floppy disks and Uncle cell file format.

Executor® 2 is a product of ARDI, Suite 4-101, 1650 University Blvd., NE, Albuquerque, NM 87102, USA. Fax: (505) 766 5153. Phone (505) 766 9115. WWW: http://www.ardi.com.

Important remark: this information is provided for your convenience only, we neither advertise nor endorse Executor® 2. You may download a demo version of Executor from ARDI and test yourself whether it meets your needs or not. Although Uncle has been modified to run well under Executor and tested, we cannot guarantee that every function of Uncle in every circumstances will work as described in this manual. Also, we cannot guarantee that Uncle will run correctly under future versions of Executor (but we do hope it will).

Uncle for Windows

A native Windows version of Uncle (i.e. a version that runs in the Windows environment and does not require any MacOS emulator) is in development. It is not distributed yet. However, a special cell format (called Uncle for Windows format) has been developed and is implemented in Uncle 1.8. Also, a Uncle for Windows format for technology files has been developed and is available in Uncle 1.8. Once the Uncle version for Windows is released, these formats will be used for exchange of files between Uncle for MacOS and Uncle for Windows. Note that cell files saved in Uncle for Windows format can be imported to Uncle 1.8, but technology files saved in Uncle for Windows format cannot be read into Uncle 1.8. These files can be used only for transferring technologies to Uncle version for Windows.

To transfer files between Uncle for MacOS and Uncle for Windows, floppy disks formatted for DOS must be used. Macintosh disks are not readable on PCs.
Index

adjusted view area 58
Artwork Palette 35
Basic Subcell Edit Mode 21
Calma (see GDSII)

Cell
  active 27
  name 13
  new 13, 33, 61
  opening 31, 33, 48, 61, 77
  saving 20, 24, 34-35, 62

Cell Edit Mode 29, 31, 61-80, 83, 86
  switching to 31

Center Control 17, 56, 57
CIF 10, 29, 34, 62, 81, 84, 87, 101
Clipboard 64, 65, 80
color 10, 11, 88, 89
Compact Data 62, 64
  effect on layout 62
  effect on layout appearance 19
composite layer (see pop–up layer)
Control Panel 40, 74, 75
  monitor setting 11, 13, 31
Copy 78
current technology 32, 64
Cut 78
default technology 32, 64, 83, 86, 87, 102
design rule check 74
design rule checking
  background 17
  continuous 15, 76
  dialog 18
  DRC menu 15
  DRC menu blinking 17
  Find Errors 18
  Hide Errors 18
  Scan Errors 18
  visible 17
design rule errors
  hidden 15
  shown 15
  visible 75, 77
design rules
  Generic Rules 94
  Layer equivalence 90
  Overhang Rules 94
  Spacing 91
  Spacing/width inheritance 91
  surround rule 95
  verifying 74
Design rules associated with a layer 90
device 50, 83, 84
  drawing 51
  number of 87
device destination 51, 96
device orientation 96
device origin 51, 96
device outline 51, 96
Device Palette 23, 29, 35, 38, 50-52
Device Window 96-97
Electromask 34, 62, 84
Erase Control 16, 40
eraser control 41
erasing 36, 39, 72, 92
extend 19, 72, 73
Extend Right 72
field implant mask 28
Find Error 74, 75
Find Errors 74
Finder 9, 85, 107
Fit In Window 67
Flip Horizontally 70
Flip Vertically 70
format 83, 84
Format Window 100
GDSII 10, 34, 101
grid 14, 67
group of subcells 43
Help Mode 30, 61
hierarchy 27
Immediate Paint Mode 39, 40, 41
Import 62
  label 20, 21, 90, 101
  appearance in expanded subcells 53
  appearance in unexpanded subcells 53
  attached to layer 55
  Position 20
Label List 35, 66
Labels 52-55
  attached to layers 53
  deleting 54
  editing 54
  inserting 52
  moving 54
lambda 14, 87
Layer 15, 27, 28, 29, 53, 83
  erasing 40, 41
  extending 40
  invisible 39, 41, 42, 73
  number of 87
  Paint Visibility Mode 39
  painting 40, 41
  visible 39, 41, 42, 73
layer control 15, 16
layer controls 15
Layer Window 88, 91
Layout Window 13
Magic 34, 35, 62, 84
magnification 23, 57
mask 27, 28, 83, 84
  number of 87
Mask Window 98
messenger layer 90, 93, 94
microscope 50
microscope mode 50
node 55, 64, 65, 66
Node Info Box 35, 66
Paint Control 15, 40, 41
Paint Mode 13
Paint Palette 13, 23, 29, 35, 38, 39, 40, 41-42, 71, 72
Paint Visibility Mode 41-42
painting 19, 20, 36, 39, 71, 72, 92
Palette
  Paint (see Paint Palette)
  View/Mode (see View/Mode Palette)
palatte layers 16, 39
plane 83, 84
  number of 87
Plane Window 91-96
pointer
  crosshair 13, 36, 42
  hand 46
  padlock 47
  question mark 30
  transformation operator 45
  upward arrow 13, 36
pop–up layer 87
pop–up layers 17, 19, 39
preference file 11
preferences 77
preferences 77